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内容简介

本书由浅入深、循序渐进地介绍了最新的矢量绘图软件 FreeHand 9的各项

基本功能和绘图技巧。全书共分 11章，内容包括 FreeHand 9的工作环境介绍、

基本绘图工具的用法、对象的组织与变换、文字录入与文字特效、颜色管理、特

殊效果工具、打印输出和创建Web网页等。

本书内容充实，结构清晰，图例丰富，操作介绍简洁实用，书中精选的示例

具有很好的代表性，适合广大 FreeHand的初中级用户阅读，也可作为大中专院

校的培训教材。



前 言

FreeHand是一种广为流行的矢量绘图软件，广泛应用于平面设计、彩色出版

与多媒体制作等诸多领域，受到各界用户的喜爱。Macromedia公司最新推出的

FreeHand 9对原有版本做了较大程度的改进，优化了用户界面，新增了多种实用

的绘图工具和图像处理功能。为了适应用户对 Web网页图像和动画制作的迫

切要求，FreeHand 9还集成了动画播放器 Flash 4，用户可以直接把在 FreeHand 9

中制作的动画文件输出到 Flash 4中。

本书面向 FreeHand的初中级用户，由浅入深、循序渐进地介绍了 FreeHand 9

的各项实用功能和绘图技巧。在内容编写上充分考虑到初学者的实际阅读需

求和国内 FreeHand用户层的定位，通过实用的操作指导和有代表性的绘图实

例，可以让读者直观、迅速地了解 FreeHand 9的主要功能，并能通过上机实践巩

固书本知识，从而进一步掌握这一优秀的绘图软件。

参加本书编写、制图和录排的人员除封面署名者外，还有袁建华、袁鸣、王

玉娟、孔祥丰、邱丽、曹木军、徐卫萍、杜杰霞、王维、李万红、胡辰浩、陈锋、吴新

民、陈建标、马雅林等人。由于时间紧迫，加之我们水平有限，本书难免会有疏

漏和不足之处，欢迎广大读者和各界专家批评指正。

作 者

2000年 6月



书书书

第一章

安装与启动 FreeHand 9

FreeHand 9 是一个功能强大的矢量绘图软件，它简便易用，不仅

适用于一般的图形绘制，而且适用于专业的桌面排版和 Web 网页设

计。FreeHand 9 还集图形绘制和文字处理于一身，在 FreeHand 8 的

基础上新增了不少网络和智能化处理功能。

本章中的主要内容包括：

 FreeHand 9 简介；

 安装 FreeHand 9；

 启动和退出 FreeHand 9。

1. 1 FreeHand简介

自从 FreeHand于 1987 年问世以来，经过近 10 年的发展，该软

件已成为目前最优秀的平面绘图软件之一，特别是在 Macintosh平台

上尤为突出。与一般绘图或图形处理软件不同的是，FreeHand 还具

有强大的文本处理功能，绝不逊色于专业的字处理程序，这也是

FreeHand 受欢迎的原因之一。FreeHand 是一个功能强大的矢量绘

图软件，这一点在 FreeHand 9 中更加突出。

1. 1. 1 矢量绘图工具 FreeHand 9

FreeHand 9 是一个基于矢量的绘图软件，也可以称为面向对象

的绘图软件。在使用 FreeHand 9 绘制图形时是通过 FreeHand 9 中

所提供的基本绘图工具，绘制基本图形对象（如圆、矩形、直线、曲线

等）之后，再进行组合。用这种方法绘制的图形，用户可以随意地改

变它们的形状、大小、颜色等属性，而不会影响整体结构，如图 1-1 所

示。
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图 1-1 对矢量图形可以进行单对象操作

1. 1. 2 FreeHand 9 的构图原理

简单地说，FreeHand 9 中的矢量图形都是由一些基本的图形元素组合而成的。无论多

么复杂的图形对象，用户都可以使用 FreeHand 9 提供的最基本的绘图元素通过简单的叠加

来构成。例如，一个矩形可以通过 4 条相互垂直的直线叠加而成。这种类似于 1 + 1 = 2 的

构图方式虽然简单，并且所构成的图形也受到如图像精度、平滑度等方面的限制，但却是目

前各种绘图软件中通用的基本构图方法。

换另外一种角度来看，FreeHand 9 的构图原理可能更有助于用户的理解。我们知道，

现实世界中所有的复杂图形对象都是由一个个简单的线或面通过一定的方式组合而成的。

FreeHand 9 能够为用户提供的不是这些图形本身，也就是说它并不为用户提供一些现成的

图形图像，而是提供使用基本绘图工具来构图的方法。

1. 1. 3 FreeHand 9 的特点

由于绘图软件中的线条、形状和文件都是以数学公式的形式定义的，所以这些对象能自

动地以输出设备的最大精度输出，不论是激光打印机、激光照排仪，还是胶片输出机。绘图

程序将数学公式发给打印设备，打印设备按照数学公式将图像描绘到纸或胶片上。换言之，

打印设备把绘图软件的公式转为打印点阵，由于打印机能比屏幕提供更高的分辨率，例如激

光打印机的分辨率为 300 点 /英寸，因此打印出来的图形看上去更平滑、更清晰。

此外，FreeHand 9 的图形文件占用磁盘空间相对较小，其图形的大小取决于对象所包含

的数学公式的数量和复杂程度，图形文件的大小与打印图像的大小几乎无任何关系。
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1. 1. 4 FreeHand 9 的适用范围

FreeHand 9 最适合用来制作以下类型的作品：

 广告艺术和其他对比鲜明、外观质量要求高、真实感强的图形；
 建筑设计图、产品设计图或其他紧密线条的绘制；
 商业图形、图表和数据、演示工作方式的信息图；
 需要非常平滑边缘的标志和文字效果等；
 小册子、小传单和其他包含插图、标志和标准大小文字的单页文档。

1. 2 安装 FreeHand 9

安装 FreeHand 9 是一项非常简单的工作，用户只需按照安装向导程序的提示就能轻松

地将 FreeHand 9 安装到计算机上了。

1. 2. 1 硬件要求

FreeHand 9 的硬件配置要求如下：

 CPU：最低要求奔腾 166 以上

 内存：建议最低内存为 16MB，当然内存越大，运行速度越快；

 硬盘：完全安装 FreeHand 9 需要大约 70MB左右的硬盘空间。因为在进行一些图形

效果处理时，系统需要大量的硬盘空间作为缓冲区，所以至少应留下 100MB左右的硬盘空

间。

 显示器：要完全地显示 FreeHand 9 中图形图像的颜色，必须用 VGA显示卡，有 2MB

或以上的显示缓存。

 CD-ROM：倍速以上光驱。

1. 2. 2 安装 FreeHand 9

有了硬件的支持，我们就可以来安装 FreeHand 9 了，将 FreeHand 9 的安装盘放入光驱，

系统会自动地运行安装程序。FreeHand 9 的安装向导提供了较为详细的安装说明，用户只

需根据提示内容，依次单击 Next按钮就可以完成安装。安装 FreeHand 9 的具体步骤如下：

（1）在光驱中放入 FreeHand 9 的安装盘，系统会自动地构造驱动程序信息库，如图 1-2

所示。在这个过程中不需要用户进行任何操作，等待几秒钟系统会自动完成该过程。

（2）图 1-3 显示了安装过程的第二步在屏幕上所显示的对话框。该对话框提示用户

FreeHand 9 安装程序的操作方法，并说明有关 FreeHand 9 版权的问题，对于一般用户来说，
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可以直接单击 Next按钮，进入下一个过程；如果想退出安装，单击 Cancel按钮。

图 1-2 系统正在构造程序信息库

图 1-3 欢迎信息对话框

（3）接下来是 FreeHand 9 的安装协议对话框，它包括使用软件的一些常规问题，如公

司名称、公司标志，该软件的使用权限等（如图 1-4 所示）。仔细阅读该协议的内容，如果接

受该协议，单击 Yes按钮，进入下一个安装对话框；如果拒绝接受该协议，单击 No按钮，退出

安装；如果需要浏览前一个窗口的内容，单击 Back按钮。

（4）当用户接受了协议后，则进入 FreeHand 9 的注册对话框，该窗口如图 1-5 所示，要

求用户键入产品序列号、使用者名字、工作单位以及相关信息。依提示键入正确的选项后，
—4—
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便可继续安装。

图 1-4 安装协议对话框

图 1-5 FreeHand9 的注册对话框

（5）成功注册之后，我们就可以选择安装路径了，如图 1-6 所示，Destination Folder中的

路径为系统默认的安装路径，用户也可通过 Browse按钮选择安装路径。

图 1-6 安装路径对话框
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（6）选择了安装路径后，就可以进入图 1-7 所示的选择安装类型对话框。该对话框提

供了安装 FreeHand 9 的 3 种方式，它们依次是：

图 1-7 安装方式对话框

 Typical（典型安装）：这是最常用的安装方式，它包括 FreeHand 9 默认的字体、图形和

文本样式、颜色模型等能够支持一般用户绘图工作的选项，占用大约 40MB左右的硬盘空

间。

 Compact（最小安装）：最小化安装能够节省硬盘空间，但是安装的组件很有限，在以

后使用时需要不断地增加一些选项才能更好地进行绘图工作。该方式只向用户的计算机中

拷贝一些系统信息，只占用大约 20MB左右的硬盘空间。

 Custom（自定义安装）：这是针对熟练用户的一种安装方式。它能够让用户自由地选

择要安装的组件，所占用的硬盘空间依选择组件的不同而变化，FreeHand 9 的全部组件大约

占用 70MB左右的硬盘空间。

（7）选择了安装方式后，单击 Next按钮就可以进入图 1-8 所示的选择组件对话框。该

对话框的主要部分是可选组件（Components）列表框，列表中在所有已选组件前边的方框中

都有一个选中标记√，要取消安装该组件，在方框中单击就可以了。完成选择后，单击 Next

按钮，进入下一步安装。

（8）接下来安装向导会进入图 1-9 所示的 Select FreeHand Language Dictionary对话框。

FreeHand 9 支持多种语言，对于不同国家的语言所使用的拼写检查方法也不同。一般来说，

可以不作选择直接单击 Next按钮，进入下一个安装步骤。

（9）图 1-10 中的列表框提供了 FreeHand 9 默认的快捷文件夹在“开始”菜单中的放置

位置；上面的“Program folders”文本框则是让用户再一次确认所选组件的名称。这两个选项

改变与否对使用 FreeHand 9 的影响都不大，所以可以直接单击 Next按钮进入下一个安装步

骤。

（10）接下来开始复制系统文件。在复制系统文件的同时，用户可以仔细地浏览屏幕上

滚动的文字，了解 FreeHand 9 的功能，一直到下边的进度指示器数值达到 100，表明复制完

成，就可以进入下一个窗口了。
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图 1-8 可选组件对话框

图 1-9 选择语言对话框

图 1-10 设置快捷方式对话框
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（11）当系统文件复制到用户的计算机之后，就会出现完成安装对话框。单击其中的

Finish按钮，就可以完成 FreeHand 9 的安装。

通过以上的步骤，我们已经成功地安装了 FreeHand 9，在图 1-11 所示的窗口中，可以看

到 FreeHand 9 的所有组件的名称和图标形状以及所在的位置。

图 1-11 FreeHand 9 各组件所在的位置和图标形状

1. 3 启动和退出 FreeHand 9

在完成了 FreeHand 9 的安装后，就可以像使用其他 Windows 应用程序一样启动 Free-

Hand 9 了，通常用户都是通过“开始”菜单来启动 FreeHand 9，即执行“开始”→“程序”→
“Macromedia FreeHand 9”→“FreeHand 9”就可以了，启动路径如图 1-12 所示。

进入 FreeHand 9 后，我们首先看到的是 Welcome to FreeHand 9 对话框，如图 1-13 所

示。该对话框为用户提供了不同进入 FreeHand 9 的选择，有以下几个按钮：

 New：新建空白模板；

 Previous File：打开最近一次编辑的文件继续进行编辑；

 Open：打开已有文档并同时进入 FreeHand 9 工作窗口；

 Template：从 FreeHand 9 为用户提供的专业模板中选择一种；

 FreeHand Help：查看 FreeHand 9 的帮助文件。

对于新用户来说，可以通过 New按钮进入 FreeHand 9 的工作窗口，如图 1-14 所示。现

在，用户就可展示个人的艺术才华，创作自己的作品了。
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图 1-12 FreeHand 9 的启动路径

图 1-13 Welcome to FreeHand 9 的窗口

退出 FreeHand 9 时可以通过以下几种方法：

 选择 File菜单的 Exit命令；

 单击工作窗口右上角的关闭按钮；
 单击工作窗口左上角的图标，从弹出的窗口控制菜单中选择 Close命令。

无论选择了哪一种方法退出，系统都会弹出如图 1-15 所示的提示对话框，提示用户当

前文件尚未存盘。用户可以从以下 3 个按钮中选择一个：

 Yes：不保存文件，退出 FreeHand 9；

 Review：打开保存文件对话框，从中可选择是否保存当前文件，然后退出；
—9—
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 Cancle：取消退出操作，返回工作窗口。

图 1-14 FreeHand 9 的工作窗口

图 1-15 退出 FreeHand 9 的提示窗口
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第二章

FreeHand 9简介

在学习使用 FreeHand 9 开始绘图之前，用户首先应对它的各种

工具栏和菜单栏有一个大致的了解，只有打下坚实的基本功，才能更

好地发挥 FreeHand的绘图功能。FreeHand 9 对工作界面进一步做

了优化，用户可以方便地通过掌握菜单栏、工具栏和浮动面板等多种

方法完成同一项任务。

本章的主要内容包括：

 初识 FreeHand 9 的工作界面；

 FreeHand 9 的菜单栏；

 FreeHnad 9 的工具栏；

 FreeHand 9 的浮动面板；

 设置 FreeHand 9 的工作环境。

2. 1 初识 FreeHand 9 的工作界面

对于使用过 FreeHand系列的老用户而言，工作界面的介绍可以

说是多余的，因为 FreeHand 9 的外形特征和 FreeHand 8 几乎没有区

别。但对于新用户，还是应该一步步地来学习。

用户当第一次成功地启动了 FreeHand 9，并在欢迎屏幕中选择

了一种开始新绘图的方法之后，就可以进入到图 2-1 所示的 Free-

Hand 9 的工作界面窗口了。用户可以看到，系统默认方式下，并不

是把包含的所有浮动面板和工具栏都显示在屏幕上，而只显示最常

用的几个。如果用户需要的话，可以进行不同的设置以创建自定义

风格的窗口方式，具体方法将在以后的内容中谈到。

FreeHand 9 的工作窗口组件及其主要功能如下：

（1）窗口控制按钮：单击可以打开窗口控制菜单，该菜单主要包

含了一些常用的窗口控制选项，如最小化、最大化、恢复、关闭等。
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（2）窗口标题：显示当前使用的应用程序的名称。

图 2-1 FreeHand 9 的工作窗口

（3）菜单栏：FreeHand 9 的菜单栏包括 8 个最常用的菜单，各菜单都有自己的下一级子

菜单，有的菜单甚至包括三级、四级子菜单。每一条菜单命令都对应地执行 FreeHand 9 的

一项功能。

（4）绘图窗口：用户的工作主要在该窗口中进行，该窗口的大小可以由用户自行设定。

如果进行打印操作，该窗口以外的绘图将不被打印。

（5）绘图窗口控制按钮：主要用来控制 FreeHand 9 桌面或者绘图窗口的外观形状。这

些以按钮形式显示的控制项比以菜单形式显示的控制项更为直接、方便。

（6）浮动面板：这些组件是 FreeHand 9 中最为有用的部分。FreeHand 9 为用户提供了

9 个浮动面板，这些面板相对于绘图窗口和其他面板是独立的，用户可以通过单击该面板右

上角的最小化按钮将它们折叠起来，从而节省有限的显示空间。

（7）滚动条和浏览按钮：如果用户的绘图很大，这几个按钮是相当有用的。单击翻页按

钮，可以进行向上 、向下 、向左 、向右翻页；而拖动滚动条则可以实现快速地翻页浏览。

（8）度量单位下拉列表框：主要用于设置用户绘图工作时的度量单位。

（9）显示模式下拉列表框：主要用于设置不同的视图质量。较高的视图质量能够很好

地显示图形的颜色和细部，但是系统处理速度和屏幕刷新速度会很慢。

（10）页码标记和翻页图标：这两个翻页按钮主要是为用户在不同的图形页面之间进行

切换提供方便。只有用户的文档包含了多个图形页时，这两个按钮才会处于可用状态。用

户既可以使用向前、向后翻页按钮，也可以在中间的数字框中直接键入需要的页码。

（11）视图尺寸下拉列表框：FreeHand 9 为用户提供了 14 种不同的视图尺寸。用户可

以使用最大 64 倍的放大图像，也可以使用最小仅为原图像 1 /16 的缩小图像，或者选择使用

绘图页面大小来浏览图像等不同的视图方式。
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（12）工具箱：工具箱集成了 FreeHand 9 中的 17 个最常用的工具按钮，是 FreeHand 9

中能够使用的最基本的绘图工具或者编辑工具，也是直接在绘图页面中创建图形或者文本

对象并进行基本编辑操作的基本工具。

（13）绘图窗口标题栏：该标题栏主要用于显示当前工作窗口的名称，并且可以通过单

击左边的图标打开绘图窗口控制菜单。

（14）主工具栏：主要包括文件或者绘图常用操作的工具按钮。例如用于文档操作的保

存、打开、新建按钮；用于对象控制的导入、导出、锁定、解除锁定按钮；用于基本编辑的排列、

组合、群组、旋转等按钮；用于数据交换的复制、粘贴、剪切、恢复等按钮。

（15）文本工具栏：主要用于设置文本的一些属性如字体、字号等；用户也可以使用该工

具栏上的一些按钮完成一些文字特殊效果的处理。

（16）Envelope工具栏：主要用于设置图形和文本封套的各种属性，在菜单栏中也包含

了各种按钮所能实现的功能。

2. 2 FreeHand 9 的菜单栏

作为Windows用户，我们对菜单栏的应用是再熟悉不过了，它几乎是所有Windows应用

程序都具备的功能。FreeHand 9 也同样具有功能强大的菜单栏，它主要包括 8 个执行不同

功能的菜单：File（文件）菜单、Edit（编辑）菜单、View（视图）菜单、Modify（修改）菜单、

Text（文本）菜单、Xtras菜单、Window（窗口）菜单和 Help（帮助）菜单，如图 2-2 所示。Free-

Hand 9 中的菜单栏常驻屏幕上。

图 2-2 FreeHand 9 的菜单栏

FreeHand 9 菜单栏中的各个菜单简介如下：

 File菜单：主要用来实现文档的控制和基本操作。FreeHand 9 的 File 菜单中提供了

一些与其他应用程序所共有的基本功能。用户也可以使用该菜单的导入命令向 FreeHand 9

导入其他应用程序所创建的图形图像，或者进行打印输出、参数设置等。

 Edit菜单：利用该菜单能够进行一些基本的编辑操作，如恢复、重做、剪切、复制、粘

贴等。该菜单还提供了一些特殊的命令，例如能够对选定对象进行完全再制的 Clone（克

隆）命令，该命令产生的副本能够随时和原来的对象保持一种动态链接的关系。

 View菜单：该菜单的主要功能是为用户进行一些屏幕操作提供常用选项，如显示模

式设置，缩放操作，显示或隐藏选定的对象，显示或者隐藏工具栏、面板、标尺、文本标尺等。

用户也可以使用该菜单中的一些命令来启用 FreeHand 9 的网络线、辅助线，或者进一步设

置图形对象与网络线、辅助线的位置关系等。

 Modify菜单：利用 FreeHand 9 的 Modify菜单可以很方便地打开相应的面板，例如可
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以选择 Object命令打开 Object面板。该菜单的另外一项功能是一些基本的对象操作命令，

例如，使用 Join命令可以将多个对象合并；Group命令能够执行多个对象的群组功能等。

 Text菜单：该菜单主要用来执行一些有关文本的操作。例如，更改文本的字体、字号

等属性，为文本添加黑体、斜体等效果。该菜单中还包括了一些适用于文本的特殊效果，如

将文本捆绑到路径上，对文本添加阴影效果、添加划线效果等。

 Xtras菜单：该菜单集成了 FreeHand 9 中几乎所有的特效工具。这个特殊菜单中的

各项命令都能够进行颜色的管理和控制，也能够生成特殊的复杂路径，同时，如果要对选定

的图形对象应用各种特殊效果，也必须使用该菜单中的相关命令。

 Window菜单：FreeHand 9 中的Window菜单和其他应用程序稍有不同，利用它除了

能够进行一些窗口属性的设置外，还能够设置工具栏、面板在屏幕上的显示与隐藏。如果用

户关闭了某一个工具栏或者面板，可以通过该菜单中的相关命令将它们再次显示出来。

 Help菜单：主要为用户提供不同形式的帮助信息。

2. 3 FreeHnad 9 的工具栏

工具栏和菜单栏一样，是众多Windows应用程序所共有的一种组件，它可以比较快捷地

使用户实现一些常用功能。FreeHand 9 的工具栏主要包括 5 类：主工具栏、Text工具栏、En-

velope工具栏、Status工具栏和信息工具栏。

2. 3. 1 FreeHnad 9 的主工具栏

和其他的应用程序一样，FreeHand 9 的主工具栏提供了各种基于文档操作的常用工具，

它大致可以分为 3 类：常用的文档处理操作、文档编辑操作和面板启动操作。图 2-3 显示了

FreeHand 9 主工具栏的形状。下面依次列出了系统默认状态下主工具栏中所有按钮的名称

及其执行的主要功能。

图 2-3 FreeHnad 9 的主工具栏

第一类，常用的文档处理操作工具：

 新建（1）：使用系统默认的模板新建一个空白绘图文档；

 打开（2）：打开一个已经存盘的 FreeHand 9 文件；

 保存（3）：保存经过编辑或者创建的图形文件，默认状态下，fh9 为扩展名；

 导入（4）：向 FreeHand 9 中导入一幅在其他应用程序中创建的图形图像；

 打印（5）：打印绘图页面范围内的图形。
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第二类，文档编辑操作工具：

 图形（6）：单击可以打开 FreeHand 9 提供的图片文件；

 对齐（7）：单击可以打开 Align面板，对选定的多个对象应用不同的对齐方式；

 锁定（8）：将选定的对象锁定，锁定后的对象不能再进行编辑、删除、位移、缩放等操

作；

 解除锁定（9）：将执行完锁定命令的对象解除锁定状态。

第三类：面板启动操作：

 对象检查器（10）：单击可以打开 Object 面板；

 变换（11）：单击可以打开 Transform 面板，功能介绍在以后的面板中谈及；

 颜色列表（12）：单击打开 Colors面板；

 颜色混合（13）：单击打开 Mixer面板；

 图层（14）：单击打开 Layers面板；

 符号（15）：单击打开 Symbol面板；

 帮助索引（16）：单击打开帮助主题，用于查询帮助。

2. 3. 2 FreeHand 9 的 Text 工具栏

在系统的默认状态下，在启动后的 FreeHand 9 工作界面上能够显示的工作窗口中只有

3 个工具栏———Text工具栏、Envelope工具栏和上一节已经介绍过的主工具栏。图 2-4 显示

了 Text工具栏的全貌。该工具栏为用户进行文本的处理提供了一些常用的工具，如字体设

置、字号大小等。用户也可以使用该工具栏中的一些工具按钮实现文本的基本格式编排，如

选择不同的对齐方式、使文本嵌合于选定的路径对象等。

图 2-4 FreeHand 9 中的 Text工具栏

通常，Text工具栏可以分为字符编辑操作和段落编辑操作两类。为方便用户在绘图工

作中使用该工具栏，下面列出了各工具按钮的名称以及相应的功能。

第一类，字符编辑操作工具：

 字体名称（1）：为将要录入的文本或者用户选定的文本设置一种字体；

 字体大小（2）：为将要录入的文本或者用户选定的文本设置字体大小；

 首行间距编辑（3）：调整段落文本的首行位置；

 间距（4）：指定文本中的行间距；

 黑体（5）：将要录入的文本或者用户选定的文本全部设置为黑体字效果；

 斜体（6）：将要录入的文本或者用户选定的文本全部设置为斜体字效果；
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第二类，段落编辑操作工具：

 左对齐（7）：将选定的文本对象左对齐；

 居中（8）：将选定的文本对象居中对齐；

 右对齐（9）：将选定的文本对象右对齐；

 两端对齐（10）：将选定的文本对象强制两端对齐；

 落入路径内（11）：将选定的文本对象嵌入到封闭的路径对象内；

 捆绑到路径（12）：将选定的文本对象直接嵌合于选定的路径对象上；

 从路径分离（13）：从嵌合了文本的路径对象中分离文本对象；

 转换为路径（14）：将文本直接转换为路径对象；

 文本编辑器（15）：打开文本编辑器进行文本录入；

 拼写对话框（16）：打开拼写对话框；

 查找与替换（17）：打开查找与替换对话框；

 图文混排（18）：打开图文混排对话框；

 增加文字的间距（19）：增加选定文字的间距；

 减少文字的间距（20）：减少选定文字的间距；

 文字的基线上浮（21）：使选定文字的基线上浮；

 文字的基线下降（22）：使选定文字的基线下降。

2. 3. 3 FreeHand 的 Envelope工具栏

Envelope工具栏（如图 2-5 所示）也是在系统的默认状态下显示于工作窗口中的 3 个工

具栏之一。它主要是为图形提供一些封套，封套的形状也会影响其中的图形，所以选择一个

合适的封套对图形有着直接的影响。图形的封套操作包括对现行封套的存储和删除，封套

和图形的合并和分离，以及将封套转化为路径等。

图 2-5 FreeHand 9 中的 Envelope工具栏

为方便用户使用该工具栏，下面将逐一介绍各工具按钮的功能：

 创建封套（1）：为选定的图形新建一个封套。封套的样式由后面的现行封套决定；

 封套列表（2）：表示了现在可以提供的封套样式，在它的下拉式菜单里有一些系统自

带的封套；

 保存封套（3）：将选定的封套保存在封套列表中，以后可以随时调用；

 删除现行封套（4）：将保存在封套列表中的封套删除，系统自带的封套不能删除；

 复制封套（5）：将现行封套复制到Windows的剪贴板上；

 粘贴封套（6）：将复制在剪贴板上的封套粘贴在选定的图形周围；
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 分离封套（7）：将图形的封套删除，但在图形上保留封套的属性；

 移走封套（8）：将图形的封套移走，封套的属性不保留在图形上；

 显示封套网络图（9）：在图形上显示封套的网格图。

2. 3. 4 FreeHand 9 的 Status工具栏

FreeHand 9 中的 Status工具栏主要是用来实现视图的管理与控制的，用户可以很方便

地使用该工具栏中的一些选项来更改显示比例、视图模式等设置。如果用户创建的是包含

有许多页面的文档，还可以使用该工具栏中的翻页按钮进行前后翻页等。图 2-6 显示了

FreeHand 9 中 Status工具栏的全貌。

图 2-6 Status 工具栏

Status工具栏中的各个组成部分和功能叙述如下：

 视图比例（1）：在该框中显示的是当前状态下的显示比例。在默认状态下，该绘图的

显示比例为 33%。无论要打开的绘图原来有多大，FreeHand 都会自动调整显示比例，以使

全部图像都能够恰好放置在绘图页面中。

 向前翻页按钮（2）：该按钮在处理多页文档时非常有用，单击一次可以翻到当前页的

前边一页；如果文档只包含一页，则该按钮无效。

 向后翻页按钮（3）：和向前翻页按钮的作用相类似，只不过是翻到当前页的后边一

页。

 页码列表框（4）：显示当前文档包含的所有页码列表，单击就可以直接将屏幕切换到

需要的页码。

 显示模式列表框（5）：FreeHand 9 所提供的 4 种视图模式列表，它们分别是 Preview、

Fast Preview、Keyline和 Fast Keyline。

 度量单位列表框（6）：用以指定在 FreeHand 9 绘图或者处理文本时各种数值的度量

单位，系统默认的度量单位为 Points（点）。采用不同的度量单位不会改变实现绘图的大小，

但显示的绘图尺寸是不相同的。

 进度指示器（7）：用以显示一些特殊效果的处理状态。

 图形信息栏（8）：与 Info工具栏中显示信息的方式不同，它只能够在绘图过程中显示

图形的宽和高，一旦完成绘图，该信息也会消失。
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2. 3. 5 FreeHand 9 的信息栏

在 FreeHand 9 中，信息栏也被当作工具栏来处理。它的结构非常简单，使用也很方便，

使用过其他绘图软件的用户对它一定不会陌生，它是精确绘图时不可缺少的工具。信息栏

的全貌如图 2-7 所示。

图 2-7 FreeHand 9 的信息栏

FreeHand 9 的信息栏能够提供的信息依图中的编号顺序简介如下：

 对象的锁定状态（1）：显示选定对象的锁定状态；

 选定对象的名称（2）：显示选定对象或者正在使用的工具的名称；

 鼠标指针的位置（3）：显示鼠标指针的纵坐标和横坐标值，随着鼠标光标的移动该数

值一直在变化着；

 对象位置信息（4）：显示正在绘制的或者选定的对象的位置和角度。

2. 4 FreeHand 9 的浮动面板

浮动面板可以说是 FreeHand 9 中最常用的工具了，掌握它的使用方法对学习用 Free-

Hand绘图是至关重要的。FreeHand 9 的浮动面板可以分为 3 大类：Inspectors 面板、Panels

面板和 Xtras面板。浮动面板在操作和功能控制上，相对于 FreeHand 的窗口和菜单来说都

是独立的，它们都有自己完整的控制显示窗口和控制按钮。利用浮动面板的这一特性，在进

行绘图工作时，用户可以一次打开某一面板多次，以重复使用。

2. 4. 1 Inspectors面板组

FreeHand 9 中的 Inspectors面板是最为常用且功能最为强大的面板组，它主要包括 5 个

方面的对象属性设置，分别是 Object（对象检查器）面板、Stroke（笔划检查器）面板、Fill（填

充检查器）面板、Text（文本检查器）面板、Document（文档检查器）面板。Inspectors面板组中

所包含的浮动面板简介如下：

 Object面板：该面板是一个动态显示的面板。它随着用户所选择对象的属性的不

同，显示的内容也不同。Object面板如图 2-8 所示。

 Stroke面板：该面板主要用于设置 FreeHand 9 绘图的轮廓线属性。使用该面板还可

以进一步地更改轮廓线的样式、起始位置和终止位置的箭头形状等。Stroke面板如图 2-9 所
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示。

 Fill面板：该面板的主要功能是为选定的对象应用填充属性。FreeHand 9 为用户提

供了 9 种可用的填充方式，可以为选定的对象应用均匀填充（标准填充）、渐变填充、底纹填

充、图样填充、自定义填充、PostScript 填充等。用户选择不同的填充方式后，该面板会做相

应的变化以提供更为精确的控件。Fill面板如图 2-10 所示。

图 2-8 Object面板图 2-9 Stroke面板 图 2-10 Fill面板

 Text面板：使用该面板可以改变选定文本对象的一些基本属性，或者对文本应用一

些基本格式。用户可以改变文本的字体、字号，也可以对选定的文本应用黑体、斜体等效果，

或者使用该面板提供的对齐按钮对文本应用左对齐、右对齐、居中等编排格式。该面板还为

用户对选定文本应用某些特殊效果提供了效果下拉列表框。Text面板如图 2-11 所示。

图 2-11 Text面板

 Document面板：该面板主要用于设置多页显示方式、查看指定的区域、设置页面大

小、设置页面放置方式以及设置打印机的分辨率等。Document面板如图 2-12 所示。
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图 2-12 Document面板

2. 4. 2 Panels 面板组

FreeHand 9 所提供的 Panels面板也是用户将经常接触到的一类面板，它的使用方法与

形式和 Inspectors面板一样。该组面板包含了 8 个浮动面板，主要用于对选定对象进行操作

或者设置基本属性，包括颜色类型、颜色模型的设定，生成新的可用于选定对象的颜色，进行

对象的排列与组合等操作。

Panels面板组所包含的浮动面板及其主要功能简介如下：

 Layers（图层）面板：Layers面板包括了所有可用于图层操作的选项，用户在图层列表

中可更改某一图层中的图形对象的颜色、显示或隐藏等属性，也可以为某一图形对象设定保

护属性。系统默认状态下是非锁定的，单击列表框中的锁状标志可以将该对象锁定，以免误

操作。使用 Layers 面板还可以进一步设定选定图层中图形对象的前景色、背景色、轮廓线

颜色等。Layers如图 2-13 所示。

图 2-13 Layers面板

 Styles（样式）面板：FreeHand 9 不但为用户提供了许多可供使用的样式，同时也提供

了用户自定义样式的功能。用户可以在绘图页面中创建一幅绘图，为它填充颜色并应用特

殊效果，然后就可以使用 Styles面板中的选项将其定义为新的样式了。在以后的绘图工作

中，用户可以随时将该样式中所包含的填充、特殊效果等属性应用于选定的新绘图，从而大
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大提高了绘图的效率。Styles面板如图 2-14 所示。

图 2-14 Styles面板

 Colors（颜色列表）面板：它的主要功能是显示当前文档或者选定对象的填充颜色和轮

廓颜色。FreeHand 9 在这个面板中为用户提供了选择不同颜色模式的功能，用户可以将不同

的颜色模式中的色样添加到该列表中，并应用于选定的图形对象。Colors面板如图 2-15所示。

图 2-15 Colors面板

 Mixer（配色）面板：这个面板主要为用户创建不同的颜色提供了方便。在该面板上，

用户可以使用 4 种颜色模式之一来定义颜色，这 4 种颜色模式是：CMYK（青、品红、黄、黑）、

RGB（红、绿、蓝）、HLS（色调、亮度、饱和度），以及用于从当前系统中选择颜色的 System Col-

or Picker（系统取色器）。用户可以通过拖动面板中提供的各种原色百分比滑块来调和生成

新的颜色色样，并且可以拖动该色样将新的颜色加入到颜色列表中去。Mixer面板如图 2-16

所示。

图 2-16 Mixer面板

 Tints（色调）面板：该面板是 Mixer面板的一个辅助面板。它提供了一些创建商标名

称所用墨水的色调以及一些其他的专用颜色。该面板中可以使用的颜色主要来自于 Mixer
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面板中用户选定的颜色，同样在该面板中，用户也可以将生成的颜色加入到颜色列表中去。

Tints面板如图 2-17 所示。

图 2-17 Tints面板

 Halftones（半色调）面板：半色调是将连续色调用尺寸和角度不同的点来表示的方

法。FreeHand 9 中的 Halftones面板中的设置参数能够决定选定对象的半色调网屏设置，网

屏上的每个点都称作网点。当选择系统的默认设置时，是使用当前 PPD文件所选定的网点

形状。用户还可以选择使用圆点、线型点和椭圆点作为网点。Halftones 面板如图 2-18 所

示。

图 2-18 Halftones面板

 Align（对齐）面板：该面板的主要功能是对齐和分布对象，FreeHand 9 为对象的对齐

和分布提供了多种可选择方式。用户可以使用水平对齐对象下拉列表框中的选项，以不同

的方式将选定的多个对象沿水平方向对齐；也可以使用垂直对齐对象下拉列表框中所提供

的选项，以不同的基点将选定的多个对象沿垂直方向对齐。Align面板如图 2-19 所示。

 Transform（变换）面板：Transform 面板的主要功能是进行对象形状的处理变换。

Transform面板为用户进行对象的操作提供了 5 个功能按钮，它们分别对应于工具箱中的相

应的变换工具。这 5 个功能按钮从左到右依次为 Move（位移）、Rotate（旋转）、Scale（缩

放）、Skew（倾斜）、Reflect（镜像），单击不同的按钮可以打开相应的面板窗口。Transform面

板如图 2-20 所示。

2. 4. 3 Xtras 面板组

在 FreeHand 9 中，最精华的特殊效果部分都集中在 Xtras面板组中，这里集成了几乎所

—22—

FreeHand 9 应用指南



图 2-19 Align面板

图 2-20 Transform面板

有的 Xtras工具，它们是 FreeHand 9 中功能强大的外挂滤镜。合理地运用 Xtras 工具，可以

使用户迅速成为图像设计的高手。

Xtras面板组包括了以下几个浮动面板：

 Operations（操作）面板：这是 FreeHand 9 中功能最强大的面板，它集成了 Xtras中大

部分操作的工具。如果某个按钮图标上有一个角形的小符号，表示双击该按钮可以打开相

应的精确设置对话框，用户可以在该对话框中设置一些参数。Operation 面板如图 2-21 所

示。

图 2-21 Operations面板

 Set Note（添加标注）面板：这个面板比较简单，功能也较为单一。当用户在进行打印

或者文件存盘时，可以使用该面板来为选定的文件或者对象添加一些标注或说明性文字，例
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如添加某一绘图的名称，对该绘图的填充或者形状等属性加以说明等。Set Note 面板如图

2-22 所示。

图 2-22 Set Note面板

 Xtra Tools面板：该面板主要用来进行图像的特殊效果处理和一些特殊形状的绘制，

在很大程度上弥补了 FreeHand 9 工具箱、菜单栏的不足之处，并且为用户进行三维旋转、镜

像操作和生成混和效果、鱼眼透镜效果等操作提供了方便。Xtra Tools面板如图 2-23 所示。

图 2-23 Xtra Tools面板

2. 5 设置 FreeHand 9 的工作环境

在 FreeHand 9 中，Preferences命令的主要功能就是改变系统的一些默认设置，它可以使

用户更加自由地更改工作环境，便于用户的习惯操作。该命令把系统中的所有设置选项都

集成到了 Preferences对话框的不同选项卡中，用户只要在该对话框中进行一些相应设置，在

下一次启动系统时就会自动加载这些设置值而不需要重新设置。这些设置选项卡包括

General（常规）选项卡、Object（对象）选项卡、Text（文本）选项卡、Document（文档）选项卡、

Import /Export（导入 /导出）选项卡、Spelling（拼写）选项卡、Colors（颜色）选项卡、Panels（面

板）选项卡和 Redraw（重画）选项卡。

2. 5. 1 General选项卡

General（常规）选项卡如图 2-24 所示，它的主要功能是用来设置在 FreeHand 9 中进行

绘图或者编辑工作时的一些常规选项。用户在图文编辑过程中，一般感觉不到修改它的必

要，但对于一些专业的图像设计人员来说，就显得比较实用了。

其中 Undo�s（撤消的次数）参数用于设置 FreeHand的 Undo命令能够执行的次数。系统

默认状态下，可以连续撤消的次数为 10 次。用户需要注意的是，对于导出文件、打开或者关

闭面板等一些文件的基本操作命令，撤消操作是不起作用的。
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图 2-24 General选项卡

Pick distance（选中距离）参数用于根据用户指定的数值的范围来决定能够选取的区域。

系统默认状态下，在对象以外的 3 个像素点区域单击即可选中对象。

Snap distance（捕获距离）参数主要用来控制拖动对象移动或者靠向一个静止点、网络

线或者辅助线的距离，该距离在默认状态下是以像素点的个数来计算的。设定的数值越大

越便于用户的操作，但同时会降低绘图的精度。

另外，通过 General选项卡用户还能够进行编辑的平滑、控制柄的大小、窗口的滚动、智

能化光标以及鼠标功能键的选择设置。

2. 5. 2 Object 选项卡

Object（对象）选项卡如图 2-25 所示，主要用来设定对象的基本操作方式，例如绘制对

象和编辑对象等。由于在 FreeHand 9 中进行的处理工作大部分都与图形有着紧密的关系，

而且绘图软件所能提供给用户直接绘制的基本图形对象也是有限的，所以用户常常需要用

到编辑工具和绘图工具，而 Object选项卡正是为用户提供了这些图形绘制和编辑的基本设

置。

启用 Changing object changes defaults（改变对象时改变默认参数）复选框后，如果用户对

一个文本对象的属性或者格式进行了编辑或者改动，该变化就会同样应用于用户所创建的

下一个文本对象；禁用该复选框，则无论如何改变文本或者图形的属性，都不会影响到下一

次的绘制工作。

启用 Groups transform unit by default（群组对象作为一个整体以默认设置变换）复选框

后，系统将把多个对象当作一个单独的对象来对待。当禁用该复选框时，FreeHand 将所有

对象单独地逐个进行变换。

—52—

第二章 FreeHand 9 简介



图 2-25 Object选项卡

另外，通过 Object选项卡用户还能够进行节点连接、路径操作、图形复制、对象填充、警

告提示、线条宽度和图形样式的设置。

2. 5. 3 Text 选项卡

FreeHand 9 除了具有卓越的图像处理功能以外，还具有强大的文本处理功能。用户能

够录入文本并且对它应用一些文本的特殊格式或者效果，而这些显示到屏幕上的文本格式

或者效果的设置，大都是来自于 Text（文本）选项卡中，如图 2-26 所示。

启用 Always use Text Editor（总是使用文本编辑器）复选框后，用户在创建、编辑文本对

象时，系统都会自动弹出文本编辑器进行文本的输入。禁用该复选框时，用户输入和编辑的

文本都将直接在绘图页面上进行。

启用 Track tab movement with vertical line（用竖线跟踪制表位的移动）复选框后，用户拖

动一个制表位就会显示从该制表位发出的一条竖线，从而使用户能够更清楚地看到制表位

与文本或者图形对象的对齐位置。

另外，通过 Text选项卡用户还能够进行文本框控制柄、文本框扩展、字体预览、智能引

导以及建立和拖动段落样式的设置。

2. 5. 4 Document 选项卡

Document（文档）选项卡如图 2-27 所示，该选项卡主要用于设定一些有关文档操作的基

本属性。用户可以通过它来设定文档的视图显示方式、文档窗口的大小和位置、新建文档时

依赖的模板以及文档的其他属性。
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图 2-26 Text选项卡

图 2-27 Document选项卡

启用 Restore view when opening document（打开文件时恢复视图）复选框时，系统会在下

次打开绘图时以原绘图所设定的比例来显示。如果禁用该复选框，下次打开的文件将充满

绘图窗口，并且每次打开时的显示比例都会不同。

启用 Remember window size and location（窗口尺寸和位置记忆）复选框时，FreeHand 9 在

保存用户的文档时会同时保存窗口尺寸与窗口位置的坐标信息，下次打开时能够将屏幕恢

复原状；如果禁用该选项，下次打开该文档时用户仍然需要再次进行设定。

另外，通过 Text选项卡用户还能够进行新建模板、活动页面以及未保存文档检查提示

等设置。
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2. 5. 5 Impor t 选项卡

Import（导入）选项卡用于提供一些导入文件时的设置选项，如图 2-28 所示。在系统默

认状态下，FreeHand 9 的直接存盘文件是以. fh9 为扩展名的。其他格式的图形图像文件在

FreeHand中也可以使用，只是不能够使用 Open命令来直接打开它，而只能通过 Import命令

以动态链接的方式来使用。

图 2-28 Import 选项卡

Convert editable EPS when Imported（导入时直接转换为可编辑的 EPS文件格式）复选框

主要用来设置向 FreeHand 9 中导入 EPS格式文件时的不同选择。启用后，用户可以在导入

前对该文件进行一些基本编辑工作，如导入前裁剪、选择导入时图形的分辨率等。

通过 Import选项卡用户还能够进行导入时的图像嵌入以及剪贴板导入格式的设置。

2. 5. 6 Expor t 选项卡

和 Import选项卡相对照，Export（导出）选项卡的主要功能是提供一些导出文件的设置

选项。FreeHand 9 在系统默认时直接以扩展名. fh9 存储文件。如果需要其他的图形图像文

件，在 FreeHand中也可以使用 Export命令，将以. fh9 为扩展名的文档保存为其他应用程序

所支持的文件格式。Export选项卡如图 2-29 所示。

启用 Save file thumbnails（保存草图文件）复选框可以使用户在 FreeHand 9 中所创建的

图形文件以草图的形式保存起来。这种草图文件可以同时被其他的应用程序所使用，从而

为 FreeHand 9 和其他应用程序之间实现数据交换提供了另外一种简单的方法。

通过 Export选项卡用户还能够进行 EPS格式导出、位图格式导出以及剪贴板导出格式

的设置。
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图 2-29 Export 选项卡

2. 5. 7 Spelling选项卡

语法的拼写错误在进行文字录入和处理时是常常会出现的。为方便用户进行查错处

理，FreeHand 9 提供了功能强大的拼写检查功能。在使用它时，系统可以代替用户进行查

错，并将有疑问的地方提醒用户。Spelling（拼写）选项卡如图 2-30 所示，用来对系统的拼写

检查方式进行设置，能够进行大小写拼写错误和向系统字典添加新词的设置。

图 2-30 Spelling选项卡
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2. 5. 8 Colors选项卡

丰富的颜色管理也是 FreeHand 9 中一个非常有特色之处。在 FreeHand 9 中，用户不仅

能够为选定的对象应用不同类型的填充，为对象的轮廓线选定颜色，还能够进一步改变辅助

线和网络线的颜色。Color（颜色）选项卡如图 2-31 所示，用来设置系统的颜色管理方式。

图 2-31 Color选项卡

Guide color（辅助线颜色）按钮用于设置辅助线的颜色。当用户单击该按钮时，可以打

开 Guide Color对话框，用户可以从该对话框中的矢量颜色色谱框中为辅助线选择一种颜

色。

Grid color（网络线颜色）按钮用于设置网络线的颜色。单击该按钮可以打开 Grid color

对话框，用户可以从该对话框中为网络线挑选一种颜色。

通过 Color选项卡用户还能够进行颜色列表显示、重命名颜色、Mixer /Tints 面板以及颜

色管理系统的设置。

2. 5. 9 Panels选项卡

浮动面板的使用，对于初次接触 FreeHand 9 的新用户来说，或许是最让人眼花缭乱的

了。虽然用户可以用选择隐藏面板的方法来解决这个问题，但这样一来却出现了一些新问

题，即需要使用的面板也消失了，所以用户在对它的设置中一定要很小心，否则失去一个面

板功能是相当可惜的。Panels（面板）选项卡如图 2-32 所示，它是专门用来设置浮动面板的

使用方式的。

启用 Remember Location of zipped panels（记忆折叠面板的位置）复选框能够使 FreeHand
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图 2-32 Panels 选项卡

9 记住当面板打开和折叠时的位置。这样，无论用户什么时候需要使用该面板，按一下该面

板对应的快捷键，面板就打开在上次使用的地方。

通过 Panels选项卡用户还能够进行工具提示显示和对象提示显示设置。

2. 5. 10 Redraw选项卡

Redraw（重画）选项卡如图 2-33 所示。它主要是用来设置系统重画时的一些参数的。

也就是说，在每次绘图之前，系统将以什么样的形式出现，包括图形的预设大小、预设分辨

率、预设预览效果等。

启用 Better（but slower）display（高质量显示）复选框后，渐变填充在 24 位显示器上由

256 层组成，在 8 位显示器上由 33 个抖动块组成。禁用该复选框时，无论用户使用的是多

么高质量的显示器，渐变填充都只能够包含 9 层。

启用 Display text effects（显示文本的特殊效果）复选框后，FreeHand 将会显示各种预定

的文本效果；禁用该复选框时，无论用户对文本应用了哪一种特殊效果，在屏幕上显示的最

终结果都和没有使用该效果一样。

通过 Redraw选项卡用户还能够进行滚动刷新、高分辨率显示图像、显示重印对象、分配

内存、显示临界尺寸以及预览拖动设置。
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图 2-33 Redraw选项卡
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第三章

绘制基本图形

在 FreeHand 9 中对基本图形的绘制是非常重要的工作。因为

通过基本绘图工具，会得到所希望的图形元素，所以，熟练地掌握基

本绘图工具，是学习 FreeHand 9 的前提和基础。对基本绘图工具的

学习将为以后的学习打下坚实的基础。下面我们将逐一介绍这些工

具。

本章的主要内容包括：

 绘制直线和曲线；
 绘制长方形和正方形；
 绘制椭圆和圆形；
 绘制多边形和星形；
 绘制螺旋线和圆弧。

3. 1 使用 Line工具

直线是几何构图中除了点之外最为简单的元素。它能够通过两

个点来确定（即两点确定一条直线）。FreeHand 9 中 Line 工具就是

利用该原理来实现直线绘制的。使用 Line 工具可以绘制任意方向

的直线，单击定位的起点作为直线的一个端点，移动后放下鼠标左键

的位置作为直线的另一个端点，两个端点之间就可以绘制出一条直

线。若结合键盘上的一些快捷键，可以绘制出具有特殊角度的直线。

3. 1. 1 绘制任意一条直线

Line工具可以绘制一条与水平或者垂直方向呈任意夹角、向任

意方向延伸的直线。在系统默认状态下，它以单击的起始位置作为

起点向另一端连接；如果结合控制键，还可以该起点为中心位置同时
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向两边绘制。在不同的图形中，可以用不同的方法来满足图形绘制的要求。使用 Line 工具

绘制任意角度直线的方法是：

（1）打开 FreeHand 9 。

（2）单击工具箱中的 Line工具按钮，光标会变成十字形。

（3）在绘图页面上的任意位置单击鼠标，将确定一个起点，按住鼠标键并拖动到另一位

置后，放开鼠标键，即可绘制一条直线。图 3-1 所示为利用 Line工具绘制的不同方向的任意

直线。

图 3-1 绘制不同方向的任意直线

（4）若要以起点为中点向多个方向画直线，可以在第（3）步操作中确定起点之后，按下

Alt键，从起点处向外拖动即可得到不同方向的任意直线。

FreeHand 9是一个优秀的美术绘图软件，但它同时又是一个机械的绘图软件。这一点在

绘制直线时表现得尤为明显：如果沿水平或者垂直方向拖动鼠标就能够绘制出表面较为平滑

的直线；但如果想要以不同的角度来绘制直线，它只能够以一种逐渐过渡的方式来实现，这就

会在直线的表面形成一个个细小的锯齿，从而使该直线看起来相当粗糙，如图 3-2所示。

图 3-2 具有锯齿效果的直线
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3. 1. 2 绘制特殊角度的直线

Line工具的另外一种功能是能够画一些较为特殊的直线。这些直线的特殊之处在于能

够与水平或者垂直方向呈一定的夹角，夹角的度数与在 Preferences 对话框中的相关设置有

关，系统默认状态下，该夹角限制为 45°或者 45 的倍数的增量。要想绘制与水平或者垂直

方向呈一定夹角的直线，同样是使用工具箱中的 Line工具来进行。使用 Line工具定位起点

后，在拖动鼠标键的同时按下键盘上的 Shift 键，就会以 45°的增量来绘制直线。例如，第一

次拖动鼠标时是沿水平方向，系统就会绘制一条与水平方向成 0°夹角的直线；如果向上或

向下拖动鼠标，就会绘制出与水平方向呈 45°、90°以及 135°夹角的直线，如图 3-3 所示。使

用这种方法绘制出来的直线其表面都较为平滑，不会出现粗糙的“锯齿”。如果在绘制过程

中同时按住 Shift + Alt键，然后再拖动则可以 45°为增量从中心向两端绘制一条直线。

图 3-3 绘制特殊角度的直线

3. 2 使用 Pen工具

自从法国数学家 Bezier创建了著名的贝塞尔定律以来，贝塞尔曲线在图形图像软件界

便很快流行起来，尤其是在矢量绘图方面更是一个必不可少的工具，在许多大型专业绘图软

件中都加上了贝塞尔工具。使用 Pen 工具能够通过 2 个控制柄来生成一条较为平滑的曲

线，用户还可以通过改变这 2 个控制柄的长度和位置来设置曲线和曲率（弯曲度）等属性。

对初学者来说，贝塞尔曲线的绘制有一定的难度，在这里将介绍几种简单的贝塞尔曲线及其

绘制方法。

在 FreeHand 9 中能够绘制贝塞尔曲线的工具除了 Pen 工具外，还有 Bezigon 工具，Pen

工具能够更直观、方便地绘制出贝塞尔曲线，在本节只介绍 Pen工具。
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3. 2. 1 使用 Pen 工具绘制直线

FreeHand 9 中的 Pen工具具有强大的绘图功能，能够绘制任意方向的直线和曲线，在绘

制直线（一种特殊的曲线）和曲线后还能够进一步地修改它们。使用 Pen 工具绘制直线的

操作步骤如下：

（1）打开 FreeHand 9。

（2）单击工具箱中的 Pen工具按钮。

（3）在绘图页面中单击鼠标确定一个起点后，放下鼠标按键，移动光标到页面中的另一

个位置上单击选定直线的终点，就可以引出一条从起点到终点之间的一条直线。

（4）连续向不同方向移动鼠标然后单击以创建不同角度的任意直线，如图 3-4 所示。

图 3-4 使用 Pen工具绘制任意角度的直线

使用 Pen工具也能够绘制与水平方向呈一定角度的直线。在使用 Pen工具绘制直线的

过程中，按住 Shift键不放然后移动光标到另一个位置上单击，就可以依 45°及其倍数增量来

绘制直线，如图 3-5 所示。

图 3-5 结合 Shift键绘制特殊直线
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3. 2. 2 使用 Pen 工具绘制相互垂直的直线

上一节学习了简单直线的绘制，这一节将介绍如何使用 Pen 工具来绘制 2 条或者多条

两两垂直的直线。在这里值得说明的一点是，我们所说的 2 条两两垂直的直线，是任意方向

的 2 条相互垂直的直线，而不仅仅是水平的或者垂直方向上的直线，这将为精确绘制图形提

供最大的方便。使用 Pen工具绘制相互垂直的直线的操作步骤如下：

（1）启动 FreeHand 9。

（2）单击工具箱中的 Pen工具按钮。

（3）按住 Shift键并移动鼠标光标到绘图页面上单击定位一个起点 A，然后放下鼠标按

键（按住 Shift键不放）。

（4）在页面的其他位置上单击定位直线的终点 B，从而确定了第一条直线（当用户选定

的终点和起点的连线与水平方向的夹角大于 22. 5°时，该连线自动地改变为 45°方向；小于

该值时，就会与水平方向相一致）。

（5）继续移动鼠标到第三个位置单击（注意让 C点和 B点的连线 BC与第一条直线 AB

的夹角保持在 45°到 90°之间），就会引出与第一条直线 AB垂直的线段 BC，如图 3-6 所示。

（6）用同样的方法可以尝试继续设置点 D、E、F、H等，并使它们之间的连线两两垂直，

如图 3-6 所示。

图 3-6 使用 Pen工具能够绘制 2 条相互垂直的直线

在结合 Shift键使用 Pen工具绘制直线时，应该注意以水平方向为基准，当用户选定的

终点和起点的连线与水平方向的夹角小于 22. 5°时，该连线就会与水平方向相一致，若夹角

大于 22. 5°小于 22. 5°时，该连线将与水平方向成 45°角，若夹角大于 45°小于 90°时，该连线

就会与水平方向垂直。
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3. 2. 3 使用 Pen 工具绘制曲线

Pen工具最主要的功能是绘制较为专业的贝塞尔曲线，用户可以选择该工具然后在绘

图页面中拖动来绘制曲线，鼠标光标拖动的距离能够控制该曲线的高度和曲率等属性。如

果结合一些控制键，还可以绘制出一些实现精确控制的曲线。使用 Pen 工具绘制曲线的操

作步骤如下：

（1）打开 FreeHand 9。

（2）单击工具箱中的 Pen工具按钮。

（3）移动鼠标光标到绘图页面中任一位置单击定位一个起点。

（4）按住鼠标键不放拖动并鼠标就可以得到如图 3-7 所示的控制柄。

图 3-7 贝塞尔曲线控制柄及绘制出的曲线

（5）继续拖动以延长该控制柄。

（6）放下鼠标按键，移动光标到页面中另一位置上单击就可以得到一条曲线。

如果使用 Pen工具并结合不同的控制键还能够绘制出有一定精确度的曲线。例如，按

住键盘上的 Shift键，移动鼠标光标到绘图页面中任一位置单击定位一个起点，拖动鼠标就

会以 45°的增量来设置贝塞尔曲线的第一个控制柄；放下鼠标键（仍然按住 Shift 键），移动

鼠标光标到另一位置单击并拖动，可以看到出现的第二个控制柄也与水平方向呈一定的角

度，该角度大小同样是 45 的倍数。为了进一步验证 Pen 工具的这种属性，连续重复上述的

操作以绘制出第二条曲线、第三条曲线，如图 3-8 所示。如果使每个控制柄与水平方向的夹

角都相同，就会出现图中所示的曲线。Pen工具也能够结合 Alt键进行绘图。使用该工具时

按住 Alt键不放，移动鼠标光标到绘图页面中单击定位一个起点并拖动，这时的控制柄只有

原来的一半，而不再是同时向两个方向延伸，如图 3-8 中下面的曲线所示。
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图 3-8 结合控制键精确地绘制曲线

3. 3 使用 Rectangle工具

矩形是一种基本的几何图形，虽然绘制操作较为简单，但在绘图工作中有着重要的意

义。几乎每一种绘图软件中都有绘制矩形的工具，在 FreeHand 9 中也不例外。

在 FreeHand 9 中使用 Rectangle工具可以绘制不同大小的矩形，也可以结合一些控制键

来绘制正方形等。通过参数对话框可对矩形工具的属性进行一些设置，还能够绘制矩形的

一些变形图，如圆角矩形、圆角正方形、圆等。

3. 3. 1 使用 Rectangle工具绘制矩形

Rectangle 工具的最主要也是最基本的功能就是用来绘制不同形状、不同大小的矩形。

在 FreeHand 9 中绘制矩形的方法非常简单，它同样遵循选择工具→定位起点→拖动进行绘
制→松开鼠标，完成绘制这样的工作流程。当然，FreeHand 9 为用户提供了绘制矩形的不同

方法，用户可以从 4 个角开始绘制矩形，也可以从中心向外绘制矩形。从 4 个角开始绘制矩

形的操作步骤如下：

（1）启动 FreeHand 9。

（2）单击工具箱中的 Rectangle工具按钮。

（3）移动鼠标光标到绘图页面中单击定位一个起点。

（4）按住鼠标键不放向右下角拖动鼠标，就可以从左上方开始向右下方绘制一个矩形。

用户也可以从 4 个不同的角开始向其他方向绘制出不同的矩形。
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（5）当所得的矩形大小满意时，放下鼠标键即可，如图 3-9 所示。

图 3-9 从四个角开始绘制矩形

结合相应的控制键，也可以从起点开始向外绘制矩形。方法如下：使用矩形工具定位起

点，然后在按住 Alt键不放的同时拖动鼠标就可以以该起点为中心点向外绘制一个矩形，如

图 3-10 所示。

图 3-10 从中心向外绘制矩形

在放开 Alt键前，必须先放开鼠标键，否则得到的矩形仍然是以起点开始向一个方向绘

制的，该矩形要比从中心向外绘制的矩形小得多。

3. 3. 2 使用 Rectangle工具绘制圆角矩形

Rectangle工具的另一个功能是能够用来绘制圆角矩形，双击工具箱中的 Rectangle工具
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图标可以打开 Rectangle Tool对话框，通过该对话框可以设置不同边角半径以绘制不同形状

的圆角矩形。使用 Rectangle工具绘制圆角矩形的操作步骤如下：

（1）打开 FreeHand 9。

（2）双击工具箱中的 Rectangle 工具按钮，系统会自动弹出图 3-11 所示的 Rectangle

Tool对话框。

图 3-11 Rectangle Tool对话框

（3）在该对话框中的 Corner Radius（边角半径）数字框中键入数值，该数值代表矩形外

接圆的半径，数值的范围在 0 ～ 100 之间（用户也可以拖动该数字框右边的滚动条来设置，向

左拖动时，数值变小，圆角的度数越小；相反，如果用户向右拖动，该数值变大，圆角的度数越

大）。

（4）完成设置后，单击 OK按钮，返回 FreeHand 9 的工作窗口。

（5）移动鼠标光标到绘图页面中，单击定位一个起点并拖动，就可以绘制出一个圆角矩

形。用户也可以改变不同的圆角半径值，以观察生成的不同效果，如图 3-12 所示。

图 3-12 绘制圆角矩形

3. 3. 3 使用 Rectangle工具绘制正方形

使用 FreeHand 9 中的 Rectangle工具还能够结合键盘上的一些功能键来绘制正方形，
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用户可以从 4 个角向其他的方向绘制正方形，也可以从中心向外绘制正方形。

要想使用 Rectangle工具绘制一个正方形，可以遵循以下方法：在 FreeHand 9 中单击工

具箱中的 Rectangle工具，按住 Shift键不放，移动鼠标光标到绘图页面中单击定位一个起点

然后拖动，就可以从起点位置开始向其他方向绘制一个正方形。如果在拖动的同时按下

Shift + Alt键，就可以以起点为中心向外绘制一个正方形，如图 3-13 所示。

图 3-13 使用 Rectangle工具能够绘制正方形

3. 3. 4 使用 Rectangle工具绘制圆

在 FreeHand 9 中，Rectangle工具并非专门用来绘制圆的工具，但还是可以通过简单的

操作，使用 Rectangle来绘制圆，方法是只要先绘制一个正方形，再通过圆角的设置将它变成

一个圆。在 Feehand 9 中，边角半径的最大值为 20，所以绘制出的圆将会受到一定的限制。

但在 FreeHand 9 中还有专门绘制圆形的 Ellipse工具。使用 Rectangle 工具绘制圆的操作步

骤如下：

（1）打开 FreeHand 9。

（2）双击工具箱中的 Rectangle工具按钮，打开 Rectangle Tool对话框。

（3）在 Corner radius数字框中键入 100，或者拖动滚动条到最右边。

（4）完成设置后单击 OK按钮，返回 FreeHand 9 工作窗口。

（5）移动鼠标光标到绘图页面中单击定位一个起点并拖动就可以绘制一个圆。由于绘

图精度所限，当用户拖动的幅度较小时，能够绘制出圆；当图形较大时，仍然是一个圆角矩

形，如图 3-14 所示。
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图 3-14 使用 Rectangle工具能够绘制出圆

3. 4 使用 Ellipse工具

Ellipse工具的主要功能是用来绘制不同形状的椭圆。利用 Ellipse 工具并结合一些控

制键还可以得到一个圆。用户可以选择从不同的方向绘制椭圆，例如，可以从边角开始向相

对的方向绘制椭圆，也可以从中心向外绘制椭圆。使用 Ellipse 工具绘制椭圆和圆的操作步

骤如下：

（1）打开 FreeHand 9。

（2）单击工具箱中的 Ellipse工具按钮。

（3）移动鼠标光标到绘图页面中单击定位一个起点，按住鼠标键不放拖动就可以绘制

出一个椭圆，如图 3-15 上图所示。

图 3-15 使用 Ellipse工具绘制椭圆和圆
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（4）如果在拖动的同时按住 Shift键不放拖动鼠标就可以绘制出一个圆；同时按住 Shift

+ Alt键，就可以以起点为中心向外绘制一个圆，如图 3-15 下图所示。

3. 5 使用 Polygon工具

使用 Polygon工具可以绘制多边形，系统默认状态下总是画一个等边的多边形（在几何

中叫做正多边形），它的每一条边都是平滑的直线，并且各边边长相等、各个内角的度数也

相同。FreeHand 9 中的 Polygon工具和其他工具不同的是，它不受键盘上控制键的影响，因

而无法绘制不规则的多边形，但是可以通过参数设置来绘制不同边数的多边形和星形。

3. 5. 1 使用 Polygon 工具绘制不同边数的多边形

Polygon 工具最主要的功能就是用来绘制不同边数的多边形，当然也包括矩形与正方

形。系统默认状态下绘制出来的是一个正六边形；如果用户需要绘制其他边数的多边形，可

以双击 Polygon工具按钮以打开 Polygon Tool对话框（如图 3-16 所示），在该对话框中就可以

设置多边形的边数，该设置不会对已经绘制出来的多边形产生任何影响，它只会影响将要绘

制的图形。

图 3-16 Polygon Tool对话框

Polygon Tool对话框中包括以下选项：

（1）Number of Sides（边数）：用来指定要绘制的多边形的边数。可以直接在数字框中

键入数字，也可以拖动右边的滑块来调整。在 FreeHand 9 中，可以绘制最小边数的多边形

为 3 条边的三角形；最大边数为 20。

（2）Shape（类型）：在绘制正多边形与星形之间切换。系统默认状态下启用的是左边

的 Polygon单选按钮。

使用 Polygon 工具绘制多边形的操作步骤如下：

（1）打开 FreeHand 9。

（2）双击工具箱中的 Polygon工具按钮，弹出 Polygon对话框。

（3）在 Polygon对话框的 Number of Sides栏中，填写需要绘制的多边形的边数，通过预
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览确定图形后，单击 OK按钮。

（4）移动鼠标光标到绘图页面中单击定位一个起点，按住鼠标键不放并向其他方向拖

动鼠标。

（5）用户可以在拖动的过程中调整正多边形的大小、方向，对所得的多边形满意后放下

鼠标键即可，如图 3-17 所示。

图 3-17 使用系统默认设置绘制正多边形

3. 5. 2 使用 Polygon 工具绘制星形

使用 Polygon工具也能够绘制星形。双击工具箱中的 Polygon 工具按钮，打开 Polygon

Tool对话框，在该对话框的 Shape 选项组中启用 Star 单选按钮，对话框会变成图 3-18 所示

的样子，它为星形的绘制提供了一些精确的设置选项，它们是：

图 3-18 Star（星形）设置对话框

 Number of Sides：用来指定星形的角数。在数值框中键入星形的角数或者拖动右边

的滑块来调整。

 Start Points：主要用来设置指定星形角的锐度方式，它包括 2 个单选按钮。Automatic
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（自动）是系统默认状态下的设置；一旦用户改变了星形的锐度，就会自动地切换到第二个

按钮 Manual（手动）按钮上。

 星形锐度设置标尺：拖动对话框底部的滚动条可以设置星形的敏锐度。当向左（靠
向 acute）拖动时，星形的锐角度数变小，尖角更明显，最小时各夹角为 0 度，看上去只有向不

同方向延伸的直线；当向右（靠向 obtuse）拖动时，星形的锐角度数变大，尖角会逐渐变得平

滑。

通过预览确定图形后，单击 OK按钮，返回 FreeHand 9 工作窗口，移动鼠标光标在绘图

页面中单击定位一个起点并拖动就可以绘制不同锐度的星形了。图 3-19 显示了星形依锐

度不同而产生的渐变过程，右边中间是锐度最小时的星形，它的各个角几乎是一条直线。

图 3-19 改变星形的锐角度数能够绘制各种星形

3. 6 使用 Bezigon工具

Bezigon工具是专门用来绘制贝塞尔曲线的。在 FreeHand 9 中，绘制贝塞尔曲线时要结

合一些控制键才能完成，在系统的默认设置下，Bezigon 工具只能用来绘制直线，配合 Alt 键

才能够绘制出贝塞尔曲线来。

3. 6. 1 使用 Bezigon 工具绘制直线

学习过前面绘制直线的工具，再来利用 Bezigon 工具绘制直线就不会有什么困难。在

绘图页面上单击确定一个起点，移动到另一位置再次单击确定一个终点，这条直线就绘制出

来了。和 Pen工具一样，在绘制直线时它不会显示控制柄，而是显示一个个的点所依次连接

起来的直线。使用 Bezigon工具绘制直线的操作步骤如下：
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（1）打开 FreeHand 9。

（2）单击工具箱上的 Bezigon工具按钮。

（3）移动鼠标光标到绘图页面中的任一位置上单击确定该直线的起点。

（4）放下鼠标按键，移动光标到另外一个位置上单击确定该直线的终点，就会从起点

到终点之间引出一条直线。

（5）设置终点的不同位置和方向，以绘制出不同角度的直线，如图 3-20 所示。

图 3-20 使用 Bezigon工具可以绘制出不同角度的直线

结合 Shift键，Bezigon工具也能够绘制出与水平或者垂直方向呈 45°倍数的直线，会使

图形看上去更平滑。

3. 6. 2 使用 Bezigon 工具绘制曲线

Bezigon工具的主要功能是绘制贝塞尔曲线。在曲线的绘制上，Bezigon 工具确实有其

独到之处：它可把由许多节点组成的曲线简化到只剩下 2 个控制点，从而大大简化了绘图的

工作量，同时也提高了绘图的精度。FreeHand 9 中的 Bezigon 工具必须结合键盘上的 Alt 键

才能进行曲线的绘制，下面说明该工具的使用方法。使用 Bezigon 工具绘制曲线的操作步

骤如下：

（1）打开 FreeHand 9。

（2）单击工具箱中的 Bezigon工具按钮，按住键盘上的 Alt键并移动鼠标光标到绘图页

面中单击定位一个起点。用户需要注意的是，该起点不仅是所绘曲线的起点，而且也是第一

个控制柄的起点。

（3）放下鼠标按键（仍然按住 Alt键），移动光标到另一位置上单击，就出现了 3 个控制

柄如图 3-21 中的（1）、（2）、（3）所示。

（4）移动鼠标光标到第 3 个位置上单击并拖动以调整生成的曲线的形状和位置，完成
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后先放下鼠标按键，再松开 Alt键即可得到一条较为平滑的曲线，如图 3-21 所示。用户可以

看到，该曲线比起使用 Pen工具所绘制出的曲线来说，表面更为光滑，控制更为灵活。

图 3-21 使用 Bezigon工具能够绘制出较为光滑的曲线

3. 6. 3 使用 Bezigon 工具绘制相互垂直的直线

和 Pen工具一样，使用 Bezigon工具也能够绘制出相互垂直的直线，操作步骤和 Pen 工

具的使用相同。为了方便用户更好地理解在结合 Shift 键时所绘制的直线与水平方向的夹

角的问题，下面介绍一下在 FreeHand 9 的屏幕上隐含的方向控制轴。图 3-22 显示了在系统

默认状态下的方向控制轴。

图 3-22 系统默认状态下屏幕上的方向控制轴

用户可以看到，该控制轴主要提供了 8 个不同的方向，当结合 Shift 键使用 Pen 工具或

者 Bezigon工具时，绘制出的直线或者控制柄就只能在这 8 个方向上移动。
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3. 7 使用 Spiral工具

Spiral工具是 FreeHand 9 中绘制螺旋线的工具。创建螺旋线的过程与绘制椭圆相似，

它的起点和终点同样是 2 个参考点，并不在绘制成的螺旋线的轨迹上。用户还可以进一步

地设置螺旋线的圈数、螺旋线绘制的起始位置以及螺旋的旋转方向等属性。

3. 7. 1 绘制对称螺旋线

在 FreeHand 9 中所能够绘制的螺旋线有 2 种类型：对称螺旋线和对数螺旋线。对称螺

旋线是指螺旋线圈之间的距离是一个固定的值，相邻的 2 个线圈之间的距离是相等的。系

统默认状态下，可以直接使用工具绘制的就是对称螺旋线。

要想绘制螺旋线，打开 FreeHand 9，单击工具箱中的 Sprial 按钮，移动鼠标光标到绘图

页面上单击定位一个起点并拖动，就可以系统的默认设置绘制对称螺旋线了，如图 3-23 所

示。

图 3-23 使用系统默认设置绘制出的对称螺旋线

3. 7. 2 精确设置螺旋线的属性

FreeHand 9 提供了能够精确设置螺旋线属性的 Spiral 对话框。双击工具箱中的 Spiral

按钮，就可以打开如图 3-24 所示的 Spiral对话框。在系统默认状态下，该对话框主要提供了

用以设置对数螺旋线属性的选项，它们是：
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图 3-24 Spiral 对话框

 Spiral type：用以指定绘制螺旋线的类型，启用左边的按钮将会绘制对称螺旋线，这

也是系统的默认方式；启用右边的按钮，能够绘制对数螺旋线。

 Draw by下拉列表框：用以指定螺旋线的绘制方式。从中选择 Rotations（圈数）选项，

下边的数字框就会变成 Number of rotations（圈数）设置，在数字框中键入数字以设定需要绘

制的螺旋线的圈数。用户也可以拖动该数字框右边的滑块来设置圈数，当向左拖动时，圈数

减小，最小值为 1；向右拖动时，圈数增大，最大值为 200。图 3-25 显示了设置不同圈数时所

绘制出的螺旋线的例子。

图 3-25 绘制不同圈数的对称螺旋线

如果在 Draw by列表框中选择了 Increments（圈间距）命令，下边的数字框就会变成 In-

crements width数字框。在该数字框中键入数字或者拖动该数字框右边的滑块可设置螺旋

线圈间的距离。与设置圈数不同的是，该数字框中的数值越大，螺旋线就越稀疏；数值越小，

螺旋线越紧密；该数值的范围是在 1 到 200 之间。图 3-26 显示了以不同间距绘制出的对称

螺旋线。

当启用间距设置时，螺旋线的圈数与用户在绘制螺旋线时拖动的频度有关。如果用户

在定位起点后，鼠标拖动的距离较短，螺旋线的圈数就较少；反之，如果用户拖动了较远的距
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图 3-26 以不同间距绘制出的对称螺旋线

离，螺旋线的圈数就较多。

 Draw from下拉列表框：该列表框提供了几种创建螺旋线的方式，其中，Center（中心）

选项使用户能够定义螺旋线从中心向外延展的半径。它能够以用户开始绘制螺旋线时单击

所定位的起点为螺旋线的中心位置，用户结束绘制时放下鼠标键的位置为螺旋线的最外边

缘，如图 3-27 中的（1）所示。

Edge（边缘）选项正好相反。启用该选项时，是从螺旋线的边缘向中心位置来定义半径

的。在系统的默认状态下采用的就是这种绘制方式，如图 3-27 中的（2）所示。

选择了 Corner（对角）选项后，用户可以拖动一条对角线来决定螺旋线的边界框，如图

3-27 中的（3）所示。

图 3-27 设置螺旋线的不同绘制方式以及旋转方向

 Direction（方向）：主要用来指定螺旋线的旋转方向。单击左边的按钮，可以设置螺
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旋线按顺时针方向旋转，这也是系统的默认值，图 3-27 中的（1）、（2）、（3）所示的螺旋线都

是以顺时针旋转的；单击右边的按钮，可以将它设置为逆时针方向旋转，如图 3-27 中的（4）

所示。

3. 7. 3 绘制对数螺旋线

对数螺旋线是一种基于复杂数学运算的螺旋线，相邻的线圈之间没有固定的间距，圈间

距随着螺旋线的向外扩展而不断增大。当用户在 Spiral对话框中的 Spiral type 选项中选择

了右边的按钮以后，该对话框就会变成图 3-28 所示的对数螺旋线设置对话框。

图 3-28 对数螺旋线设置对话框

该对话框与对称螺旋线比较，只添加了 Expansion（间距扩展率）选项，用户可以在该数

字框中键入一个 1 到 200 之间的数值或者拖动滚动块来指定这个值。和对称螺旋线一样，

用户也能够设置对数螺旋线的一些属性，如绘制方式、旋转方向以及相邻螺旋线圈之间的距

离等。绘制对数螺旋线的操作步骤如下：

（1）打开 FreeHand 9。

（2）双击工具箱中的 Spiral 工具按钮，打开 Spiral 对话框。在该对话框中单击 Spiral

type选项右边的按钮，对话框就会变成如图 3-28 所示的样子。

（3）在 Expansion数字框中键入数值或者拖动右边的滚动块来指定螺旋线的扩展率。

（4）选择 Draw by下拉列表框中的 Rotations选项以指定螺旋线的圈数，选择 Increments

选项以指定螺旋线的间距。

（5）启用 Draw from下拉列表框中的一个选项以指定螺旋线的绘制方式。

（6）单击 Direction选项中的一个按钮以指定螺旋线的旋转方向。

（7）完成设置后，单击 OK按钮返回 FreeHand 9 工作窗口。

（8）移动鼠标到绘图窗口中单击定位起点并拖动，就可以绘制出对数螺旋线了，如图 3-

29 所示。
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图 3-29 对数螺旋线

3. 8 使用 Arc工具

Arc工具是一个 Xtra工具，系统默认状态下它并不出现在工具箱中；要使用它必须打开

Xtra Tools浮动面板。使用 Arc工具可以创建不同形状的圆弧，例如它可以创建 90°的圆弧，

也可以创建开放的、闭合的或者凸面的圆弧。如果用户在进行拖动绘制时按住 Shift 键，还

可以进行一些精确控制。使用 Arc工具绘制一个开放圆弧的操作步骤如下：

（1）打开 FreeHand 9。

（2）依次选择Window→Xtras→Xtra Tools命令，打开 Xtra Tools浮动面板。

（3）单击该浮动面板中的 Arc工具按钮，移动鼠标光标到绘图窗口中单击定位一个起

点。

（4）按住鼠标键不放并向任意方向拖动光标，对得到的圆弧满意后放下鼠标键，就可以

从起点位置到放下鼠标键的位置之间引出一段圆弧。

要使用 Arc对话框设置不同形状的圆弧，可双击 Xtra Tools 面板中的 Arc 工具按钮，系

统会弹出如图 3-30 右图所示的 Arc对话框。该对话框中包含了 3 个复选框。

 Create open arc（创建开放的圆弧）：启用该选项能够创建一段开放的圆弧，这也是系

统默认状态下自动启用的选项。

 Create flipped arc（创建反转的圆弧）：启用该选项时可以创建一段反转的圆弧。

 Create concave arc（创建凹面圆弧）：启用该选项时能够创建出一段凹面的圆弧。

完成设置后，单击 OK按钮，返回 FreeHand 9 工作窗口。移动鼠标光标到绘图页面中任

意位置单击定位圆弧的起点，保持按住鼠标键不放并拖动就可以绘制出不同形状的圆弧了。
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图 3-30 绘制不同形状的圆弧

3. 9 Freehand工具

Freehand工具是一种绘制自由度较高的工具，可以很方便地绘制出自由形状的线条。

在 FreeHand 9 的 Freehand工具中增加了许多智能控制，能够使绘制出的图形更加形象化。

图 3-31 的右图显示了一幅大鸟的草图，左图则是在绘制过程中 Freehand 工具所经过的轨

迹。

图 3-31 智能化 Freehand工具

Freehand工具的主要功能是用来绘制自由形状的曲线。该工具的使用方法很简单，只

需经过选择工具→定位起点→拖动鼠标绘制→松开鼠标键这样一个简单的过程即可。同
时，Freehand工具可以通过一些不同的设置来绘制不同外观的曲线（例如，虚线路径的曲线

等）。Freehand工具还可以通过设置其包含的一些选项来生成不同的笔划模式。例如，用户

可以使用压力笔模式、书法笔模式来绘制不同形状的线条，也可以更进一步地通过相关的控
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件来改变这些模式笔的属性。

3. 9. 1 Freehand 工具的精确设置

工具箱中的 Freehand工具图标的右上角有一个很小的参数选择标记，表明用该工具能

够进行更精确的参数设置。双击该按钮，可以打开如图 3-32 所示的 Freehand Tool对话框。

图 3-32 Freehand Tool对话框

在该对话框中的 Tool Operation选项中提供了 3 个单选按钮，它们主要用来设置 Free-

hand工具的不同模式，分别是：

 Freehand（手绘模式）：这是系统默认状态下的绘图模式，也是最常用的自由绘制模

式。使用该模式能够绘制线条粗细相同、笔划均匀的曲线。

 Variable stroke（压敏模式）：启用这种模式时，Freehand Tool 对话框的选项会有所不

同，绘制出的曲线的笔划也会随着用户拖动力量的大小而显示不同的宽度。

 Calligraphic pen（书法笔模式）：这也是 Freehand 工具的一种较为特殊的模式，启用

该选项时 Freehand Tool对话框也会有不同的显示，使用该模式下的 Freehand 工具绘制出来

的曲线的线条也会随着相关设置的不同而变化。

在 Freehand模式下绘图时可以设置以下 2 种选项：

 Precision：该选项主要用来控制 Freehand工具的灵敏度，启用时能够更紧密地进行曲

线拟合，它将拖动更精确地反映到使用 Freehand工具绘制出来的路径上；如果禁用该选项，

Freehand工具将做松散拟合，产生一条较为平滑但精度较低的路径。

 Draw dotted line（画虚线）：启用该选项时，在绘制曲线的过程中会以虚线显示模拟路

径，直到绘制完成才会显示曲线的形状；禁用时，在绘制过程中也以实线模拟路径。
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3. 9. 2 使用压敏模式的 Freehand 工具

启用 Freehand Tool对话框中的 Variable Stroke单选按钮，就可以使用压力模式的 Free-

hand工具。在该模式下，Freehand 工具能够与压敏板相兼容，它能够根据用户用力的大小

而改变线条的粗细和形状。为了和上节所介绍的 Freehand 工具相区别，把在系统默认状态

下的 Freehand工具模式称之为固定模式，因为它与用户用力程度无关，始终都会保持同一

线条宽度。而这种压敏模式下的 Freehand工具就能够充分地表现出用户的不同用力程度：

当用户用力大时，线条就会变得较粗；用力小时，线条就会变得较细，也能够进一步设定线条

最粗处和最细处的数值。压敏模式下的 Freehand Tool 对话框提供了一些更为精确的选项，

如图 3-33 所示。下面简要介绍对话框中的一些组件：

图 3-33 压敏模式下的 Freehand Tool对话框

（1）Min（最小）数字框：用于设置压力最小时的线条宽度，该数值的取值范围在 0 ～ 72

之间。用户也可以通过拖动该数字框右边的滚动条来改变该数值，向左拖动时数值减小；向

右拖动时数值增大。

（2）Max（最大）数字框：用于指定压力最大时的线条宽度，该数值的取值在 0 ～ 72 之

间。同样地 ，也可以通过拖动右边的滚动条来改变该数值。

（3）Auto remove over lap（自动闭合重叠部分）：系统会在绘制曲线时自动地将重叠部

分拟合为一个封闭路径；禁用时将不执行这种操作。

使用压敏模式的 Freehand工具绘图的操作如下：

（1）在 Freehand 9 中双击工具箱上的 Freehand工具，从打开的 Freehand Tool对话框中

启用 Variable stroke选项，打开如图 3-33 所示的对话框。

（2）调整 Min框中的数值为 4，Max框中的数值为 40，单击 0K按钮，返回 Freehand 9 作

窗口并绘制曲线。观察曲线笔划的粗细变化。在系统默认时，没有启用 Auto Remove Over-
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lap选项，注意生成的路径的轮廓的重叠部分。

（3）跳转到第一步，在对话框中启用 Auto Remove Overlap 选项，重新返回工作窗口绘

制曲线，注意这时路径轮廓的重叠部分紧紧地融合到一起了，如图 3-34 所示。

图 3-34 压敏模式的 Freehand工具

3. 9. 3 使用书法笔模式的 Freehand 工具

要启用 Freehand工具的书法笔模式，可从 Freehand Tool 对话框中选择 Calligraphicpen

单选按钮，Freehand Tool对话框就会变成如图 3-35 所示的样子，该对话框能够改变笔头的

角度、宽度等属性，其中包括以下选项：

图 3-35 书法笔模式下的 Freehand工具对话框

 Fixed（固定的）：启用该选项可以使书法笔线条保持固定的粗细，这时 Width 数字框

只有一个，键入数值就可以设置书法笔线条的粗细，或者拖动滚动条来调整；该值的范围在
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0 到 72 之间。

 Variable（可变的）：启用该选项时，Width数字框变为 Min 框和 Max框。和压力模式

下的 Freehand工具一样，它可以设置随着用户用力程度不同而使线条粗细不同。

 Angle（角度）：用以设置书法笔头与纸张间的角度值。既可以直接键入数值也可以

拖动右边的旋转手柄来改变角度。

图 3-36 显示了用不同类型的书法笔绘制出来的曲线：上图是使用固定模式，线条粗细

从始到终是相同的；下图则使用了可变模式，在拐角处线条较细。

图 3-36 书法笔模式的 Freehand工具应用举例
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第四章

对象的调整

作为矢量绘图的优秀工具，FreeHand 9 能够把各种图形用矢量

方法绘制出来，这些图形称为“对象”。在上一章中，学习了如何绘

制简单的几何形状，其中包括椭圆、矩形和正多边形等等，这一章将

进一步学习如何对对象进行调整，以便得到更加复杂的图形。

本章中的主要内容包括：

 路径和点；
 路径的基本操作；
 对象的基本操作。

4. 1 FreeHand 9 中的对象、点和路径

在矢量图像的设计中，对象、点和路径等是一些基本的概念。掌

握它们对用户绘制出效果更好图形很有帮助，下面将逐一介绍。

4. 1. 1 基本对象

在 FreeHand 9 中，用多种基本绘图工具创建出的各种基本对象

是绘图的基础，通过各种编辑工具对基本图形进行放大、拉伸、排列、

组合操作以及对图形进行颜色填充，可增添各种特殊效果，最终可以

生成漂亮的作品。

FreeHand 9 中主要包括以下几种基本对象，如图 4-1 所示。

 直线对象：可以通过 Line 工具、Bezigon 工具和 Pen 工具完

成。

 曲线对象：主要绘制工具是 Pen工具、Bezigon工具。

 矩形、正方形、圆角矩形：双击 Rectangle 工具进行设置，然后

再用基本的绘图方法进行绘制。
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 椭圆和圆：用 Ellipse 工具直接绘制，参照第 3 章的绘制方法

也可调节成圆。

 多边形（包括星型）：用工具箱中的 Ploygon工具可绘制多边形和星形。

 螺旋线：单击 Spiral工具可得到不同圈数、不同间距的螺旋线（对称螺旋线和对数螺

旋线）。

 圆弧：双击 Xtras面板中的 Arc工具可以调整内部的参数值以得到不同的圆弧。

 文本：使用工具箱的 Freehand工具得到。

图 4-1 几种基本对象

4. 1. 2 路径与点

一切绘图工具都是以绘制点和路径为基础的。所有对象都有它相应的路径。路径没有

分辨率，无论如何拉伸、缩放都不能影响到它的清晰度。另外，路径按照它的特性可分为开

放路径和闭合路径。开放路径有起点和终点之分，而闭合路径没有区别，它的起点、终点连

在一起。点是对象中的一个重要元素，可以按照它自身的属性以及所在位置分为端点、曲线

点、角点等不同的类型。通常可以通过节点来改变路径，对对象形状进行调整，以控制曲线

的弯曲度。另外，我们也可以通过某一点进行变换，也可用某些工具选择它，这将在下一节

中进行具体的介绍。

4. 2 选择和转换点

在具体进行绘图的过程中，往往需要对图形对象进行调整，如缩放、移动、变形等操作。

点是最基本的图形对象，对图形的调整首先从点开始。
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4. 2. 1 选择点

点是最为简单的对象，点的选择也是最基本的操作，因而我们首先来介绍点的选择操

作，其具体操作方法如下：

（1）启动 FreeHand 9。

（2）单击工具箱中的 Pointer工具按钮。

（3）将鼠标移到要选择节点所在的路径中单击选中该路径。

（4）在该路径上找到所要选择的点并单击它。

由上一节中，了解到点按其性质的不同可分为角点、端点、曲线点等。因此在用工具选

中点时，不同性质的点的表现形式也不尽相同。具体有 4 种形式，在表 4-1 中给予说明。

表 4-1 点的各种表现形式

图标 状态 表现形式

未被选中的点 黑色小方块

选中的角点 空心的正方形

选中的曲线点 空心的圆形

控制柄端点 黑色的小圈

通常情况下，选择点并不是特指选择一个点，有时需要选择多个点，可以选择 Pointer工

具按钮，同时按住 Shift键连续选择多个点；另一个方法是用框选方法来选择。在 FreeHand

9 中，选中 Pointer工具按钮，在绘图框空白部分拖动以创建一个用点线表示的矩形框。在开

始拖动的位置设定框选的一个角，另一个相对角便随光标的移动而移动。

4. 2. 2 转化点

FreeHand 9 既然提供给用户不同性质的点，它就具备在这些点之间相互转换的功能。

用户可以使用 Object面板来转换点的类型，具体做法如下：

（1）启动 FreeHand 9。

（2）选择 Inspector面板中的 Object面板。

（3）选择 Pointer工具图标，然后单击面板上图 4-2 所示的相应工具按钮，即可将选择的

点转换成所需的类型。

如果需要对多个同类型的点进行操作，则只需用 Shift 键来分别选中它们，再单击相应

的图标即可。若选中不同类型的点，则图标变为灰色，然而用户能通过单击图标使选中的点

变得相似。
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图 4-2 转换工具按钮

4. 3 关于路径的基本操作

关于路径的操作主要包括选择路径、移动路径、删除路径、添加路径，以及通过对贝塞尔

控制柄的控制来改变路径。

4. 3. 1 获取路径信息

绘图页面内的路径往往是多种多样的，像矩形、贝塞尔曲线以及徒手画的图形，甚至一

个点，FreeHand 9 都在 Path面板提供出它的具体信息，显示出该路径的状态。Path 面板中

的内容自上而下分别是：

 Even /odd fill（奇偶校验）：实现对闭合路径重叠部分的控制。

 Closed（闭合）：显示路径的开放与闭合状态。

 Flatness（扁平度）：显示路径的曲度。

 Point type（点的类型）：转换点的类型。

 Handles（控制柄）：所用点与贝塞尔控制柄的关系。

 Point location（点的位置）：描述路径上点的信息。

4. 3. 2 选择路径

路径也是对象，和选择其他对象（点）的方法一样，使用工具箱中的 Pointer 工具即可完

成。选择路径的操作步骤如下：

（1）启动 FreeHand 9。

（2）单击工具箱中的 Pointer工具按钮。

—26—

FreeHand 9 应用指南



（3）移动鼠标到绘图窗口要选择的对象上并单击，则将某一路径选中。

选择多条路径的方法有 2 种：一种是按住 Shift键，用鼠标逐个单击所需选中的对象；另

一种是用框选法，单击绘图窗口处一点作为起点，按住鼠标不放并拖动出一个矩形框框选所

需的对象。需要注意的是，在方法二中要把对象全部包括在框内，不要只框选对象的一部

分。

4. 3. 3 移动元素来改变路径

在对路径进行调整时，最基本、最简单的方法就是移动点、线或者贝塞尔控制柄等基本

元素来实现对某个路径的调整。通过点的移动可实现对线的拉伸、利用贝塞尔控制柄来调

节曲线的曲度等等。下面介绍如何运用最基本的方法对路径进行整形。

1. 移动点

对象调整的关键是对路径的整形，而路径的调整又是基于点进行的，这里首先介绍如何

移动点。

首先绘制一个比较完善的图形，其中包括几种基本的几何图形，像曲线、直线以及几种

封闭和闭合的路径，如图 4-3 所示。

图 4-3 未发生改变时的原型

移动点时先要选择点，然后按住并拖动鼠标来改变点的坐标，从而达到使直线或曲线发

生改变的效果。移动点可以达到两种目的：

 对线段进行拉伸或收缩。
 通过选择点产生贝塞尔控制柄对曲线进行缩放，并改变它的弯曲度（见图 4-4 左

图）。

要移动多个点，首先按住 Shift键选中多个点，然后再对这一组点进行拖放操作。任何

位于 2 个未被选中的点内的点或线段都保持不变（见图 4-4 中图）。

FreeHand 9 还提供了另一项功能，那就是可以分别选中 2 条不同路径上的点，并且能够

对 2 条不同的路径进行改变，对多条路径也适用（见图 4-4 右图）。

当用户选择点，并在开始拖动点的同时按住 Shift键，该点就按任何 45°角倍数的方向移

动。但是用户可以通过旋转控制轴来改变 Shift 键的影响。控制轴设置在默认情况下有 8

个特定方向，用户能按这些方向通过拖动来移动一个元素。表 4-2 中列出了这 8 个方向。

表 4-2 控制轴的方向列表

0° 45° 90° 135° 180° 225° 270° 315°
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图 4-4 对路径的改变

0° 45° 90° 135° 180° 225° 270° 315°

向正右方 右上倾斜 垂直向上 左上倾斜 向正左方 左下倾斜 垂直向下 右下倾斜

如果输入 15°，在用 Shift键拖动一个元素时，用户只能遵循图中标识的方向，不能水平

拉伸或拖动，如图 4-5 所示。另外，捕获是移动点的一个特殊的方法。当一个点靠近另一点

达到一定的像素位时，该点就会突然靠向另一个点。在绘图框中一般为 15 个像素位。当用

户拖动的点在一条选中的自由形状路径上时，可以利用 FreeHand 9 这一特点，按住 Ctrl 键

拖动该点以达到拖动整条路径的目的，使之与另一条要连接的路径连接起来，而不会使图形

产生参差交错的感觉。但应注意本操作只限于一条路径，如果用户选中了多条路径，当移动

时，仍然只移动一条路径，如图 4-6 所示。

图 4-5 图形的变化情况

图 4-6 用捕获功能调整路径

2. 移动贝塞尔控制柄

在上一章中已经简单介绍了贝塞尔路径的性质以及如何控制贝塞尔路径。在本节中，

将进一步介绍怎样对贝塞尔路径的拖动进行有效的控制。

要对控制柄进行拖动，首先要选中某路径，或者某个贝塞尔控制柄，然后才能随意拖动

它。图 4-7 至图 4-9 反映了贝塞尔控制柄对路径产生的不同程度的影响。其中每个图有 4

—46—

FreeHand 9 应用指南



个曲线点，每个点都位于图中的同一位置。从第一个图到最后一个图，只有加标注的控制柄

移动了，但每一次微小的调整都使路径产生了极大变化。为了方便用户理解，可给活动控制

柄标上字母以显示控制柄移动中路径的具体变化过程，如图 4-7 所示。

图 4-7 普通的贝塞尔路径

用户可以把 A、B、C、D这 4 条控制柄形象地看成 2 个杠杆，其中控制柄 A用于控制最

右边的线段，控制柄 B、C用于控制中间的部分，控制柄 D用于控制最左边的线段。当拖动

A逆时针旋转时，控制柄 B向相反方向移动。若控制柄 C与控制柄 D有极小的移动，则控

制柄 A与控制柄 B便剧烈移动。在图 4-8 中，控制柄 C强制中间的线段在由左边曲线出来

时上升，但因为控制柄 B线段在进入右边的曲线点时也须向上，因此 2 个点之间的线段必

须改变方向：线段先向上，接着向下，然后向上。

图 4-8 贝塞尔控制柄对路径产生的影响之一

在图 4-9 中，2 个相对控制柄 B、D从原来位置上移得越远，两者之间的线段就延伸得越

剧烈，控制柄 B与控制柄 D移动了一段距离，现在，在线段离开点或进入点时，都是由左向

右，而两者之间的部分也是向右，结果线段是向 3 个方向凸出：左、右、下。

图 4-9 贝塞尔控制柄对路径产生的影响之二

在 FreeHand 9 中有 2 条贝塞尔路径移动原则：其一是两极原则，其二是 30%原则。两

极原则是指在路径中每个线段要么连着 2 个贝塞尔控制柄，要么一个也没有，也就是说没有
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线段能只靠一个控制柄来确定它的曲度。如果 2 个曲线段只被一个控制柄控制，则将导致

曲线平坦。

“30%”原则是指任何控制柄长度都应该是其控制线段长度的大约 30%。若中间控制

柄杠杆太长，外面 2 条又太短则曲线显得不匀称。图 4-10 反映出 30%原则的 2 种应用情

况。

图 4-10 30%原则的具体表现形式

4. 3. 4 添加元素来改变路径

上面通过对路径的调整介绍了移动点和调整控制柄这 2 个最基本的方法，但图形处理

的需要是多种多样的。有时，仅通过以上 2 种方法并不能满足用户的需求。接下来介绍一

种扩展路径的方法：添加元素。添加元素包括下列 3 项内容：

 添加端点；
 添加路径内部点；
 添加贝塞尔控制柄。

1. 在路径上添加端点

在 FreeHand 9 中，路径分为开放路径和闭合路径 2 种。一条开放路径由起始点和终点

分别表示路径的两端；但闭合路径没有端点，其中每个点都是通过线段连接其他 2 个点，下

面介绍如何在开放路径上添加新的端点。

一条直线或一段曲线都可看成是开放路径，在一段直线或曲线的两端添加端点的具体

操作步骤如下：

（1）启动 FreeHand 9。

（2）单击工具箱中的 Line工具按钮，然后在绘图页面中绘制一段直线，并标上字母。

（3）当绘制完成时，用户可以看到直线处于选定状态，如图 4-11 所示。该直线有 2 个

端点 A和 B。使用 Pointer工具单击端点 B，用户可以看到该端点显示为一个空心的方形。

（4）单击工具箱中的 Pen工具，拖动鼠标光标到该直线外任意点单击，就可以从 B点到

C点引出一条曲线，原来的 B端点就变成了一个内部点不再具有端点的属性了；而 C点成

为新的端点，并且以空心的方形显示。

（5）继续使用 Pen 工具，从 C点向另一位置拖动到 D点，放下鼠标键就会在 C点和 D

点之间引出一个曲线控制柄，D点显示为黑色的圆圈而不是空心的方形，表明 C、D之间的

轨迹是曲线控制柄而不是直线。

（6）继续移动鼠标到 E点单击，就会从 C点到 E 点引出一条曲线，而 E 点就成为一个

端点。
—66—

FreeHand 9 应用指南



图 4-11 在路径两端添加端点

在开放路径上添加端点的操作过程，简而言之就是在某一开放路径上添加一个端点，用

Pointer工具单击选择点，用 Bezigon或 Pen工具在某一位置单击或拖动，使端点和新产生的

点之间产生一条线段，这种方法与闭合路径的方法基本相似。

2. 在闭合路径内部添加点

除了在开放路径的两端添加端点外，还可以在闭合路径中添加内部点。添加内部点的

工具有 2 种，一种是 Bezigon工具，另一种是 Pen工具。用 Bezigon工具添加点的具体操作步

骤如下：

（1）在 FreeHand 9 中使用 Rectangle工具绘制一个矩形。

（2）使用 Pointer工具选中矩形。

（3）单击主工具栏中的 Ungroup按钮来取消组合图形。

（4）单击工具箱中的 Bezigon工具按钮，移动鼠标光标到矩形上想添加点的位置单击，

每次单击添加一个点（如果对圆进行操作，那么，在单击的同时 2 个控制柄在单击的位置也

会出现）时就会出现一个空心的正方形，重复操作可以在路径上添加多个点。

（5）要进一步改变路径的形状，使用 Pointer工具选中添加节点后的矩形

（6）使用 Bezigon工具单击要改变的点，并向任意方向拖动即可，如图 4-12 所示。

图 4-12 用 Bezigon工具添加内部点

用户也可用 Pen工具在路径上插入点并拖动来改变原路径，实现 FreeHand 9 中添加内

部点的功能，具体操作与上面相似。

3. 添加贝塞尔控制柄

当用户想使一条直线变弯曲或者改变一条曲线的弯曲度时，可以用不同的方法来解决。

简单的解决方法是单击 Operation面板中的 Correct Direction图标，使所选的路径朝着顺时针

的方向弯曲，无论它是用何种方式画出来的。另一种方法是在 Xtras→Cleanup 子菜单中选
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择 Reverse Direction和 Correct Direction 命令。本节将介绍 FreeHand 9 中提供的另一种方

法———添加贝塞尔控制柄。要添加控制柄，首先选中所需的点，然后在按住 Alt 键的同时拖

动鼠标。进行该操作必须遵循以下规则：

 如果这个点还没有控制柄，则这个新的控制柄会影响 2 个邻近线段中后形成的一

段。

 如果这个点已经有一个控制柄，这个新的控制柄会影响相对的线段。
 如果这个点已经带有 2 个控制柄，按住 Alt键并拖动仅仅会把该点移到新的位置。

对添加贝塞尔控制柄的操作要谨慎对待。一条控制柄往往并不能达到预期的效果，需

要再添加另一条控制柄，使得操作难度加大。

4. 3. 5 删除元素来改变路径

用户为了绘图的需要，往往需要对某一路径进行割舍，去掉那些有碍于图形形状的部

分。在 FreeHand 9 中，删除操作包括删除点、删除一段路径，以及删除整条路径。本节中将

就以上 3 个方面进行讲解，使用户对 FreeHand 9 中的删除操作有进一步的了解。

1. 删除点

删除点是最简单的删除操作，删除某个点或某些点后，它们所连接的线段也随之消失。

为了减少删除点操作对路径产生的裂缝，FreeHand 9 将用新的线段来连接与删除点相连的

点。由于路径分为开放路径与闭合路径 2 种，所以删除点对它们产生的影响也不尽相同。

下面是删除路径上点的具体操作步骤：

（1）在 FreeHand 9 中使用基本的绘图工具绘制一个用绳拴着的苹果。绳和苹果分别

代表开放路径和闭合路径的实例，然后在图形上选择几点标上字母，如图 4-13 所示。

图 4-13 开放路径和闭合路径对象

（2）使用 Pointer工具选中该对象。

（3）在选定的对象路径上某一点单击，该点便显示为方形，闭合路径要先执行 Ungroup

命令，当解除组合后再进行上述操作。

（4）按下 Delete键即可删除该点，同时 FreeHand会用新的线段连接那些与删除点相邻

的点。

（5）当删除多个点时，在选择点时要先按下 Shift 键然后进行连续选择，最后执行删除
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操作即可。

图 4-14 为开放路径、闭合路径及多点删除的前后变化情况。原来曲线“绳”上包括曲线

点 A、B、C。图 4-14 左图在删除 B后，FreeHand 将 A，C点相连。中图中在苹果上的 4 个点

分别为M、N、R、Q。当删掉 Q后就将 N，Q自动连接起来。右图为删除多点的情况。图上原

有 4 点 4M，N，R，Q，当我们同时删除 N，R 点时，图形发生很大的改观，这正是 FreeHand 中

自动连接功能的作用。

图 4-14 自动连接功能

2. 删除线段

由于 FreeHand有自动修复裂缝的功能，所以会产生一条新的路径使得与删除点相邻的

点连接起来。如果用户想要删除一条线段并断开开放路径或者闭合路径，可以使用 Knife

工具，见图 4-15 和图 4-16，具体操作步骤如下：

（1）单击工具箱中的 Knife工具按钮，然后移动鼠标在路径上要删除的线段上单击。

（2）使用 Pointer工具单击并拖动选框以选中端点，然后按下 Delete 键，被选中的端点

就会被删除，并会断开原来的路径。

图 4-15 用 Knife工具分割开放路径

图 4-16 用 Knife工具分割闭合路径

3. 删除整条路径

在 FreeHand 9 中，删除整条路径的方法十分简单，使用 Pointer 工具在该路径上单击选

中路径，然后按下 Delete键即可。这种方法同时适合于删除开放路径和闭合路径。

对于一条闭合路径，可以选中路径中任意一点，然后连击两次 Delete键来删除。
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4. 3. 6 连接与分割路径

FreeHand 9 的强大功能充分表现在对路径的分解和组合上。连接路径主要包括连接开

放路径和连接闭合路径，而连接开放路径又有几种惯用的方法。分割路径则是对 Knife 工

具进一步的应用。

1. 连接路径

连接路径最主要的作用就是将两条路径连接起来成为一条路径，或将某一条开放路径

的对象封闭成为一个闭合的形状，从而能应用填充属性。连接路径分为连接开放路径和连

接闭合路径两种。

连接开放路径的方法有 3 种：鼠标拖动、使用 Object 面板、执行 ModifyJoin 命令。使

用鼠标连接开放的路径使之封闭的操作步骤如下：

（1）启动 FreeHand 9。

（2）使用基本的绘图工具（如 Pen 工具）在绘图页面中创建一条具有开放路径的曲线

对象。

（3）单击工具箱中的 Pointer工具按钮，移动鼠标光标到该曲线上单击，使之处于选中

状态。

（4）在该曲线的起点上单击并拖动鼠标到终点上，此时用户可看出曲线的变化。

（5）放下鼠标按键，该曲线将实现封闭。

对于图 4-17 所示的曲线，当我们将它的 A和 B两点用 Pointer工具进行连接时，就可以

生成一条闭合路径。

图 4-17 用鼠标连接路径

使用鼠标拖动的方法简单易行，下面介绍的第二种方法是使用 Object 面板来封闭开放

路径，也称为自动连接方法。

采用该方法首先应使用工具箱中的 Pointer工具按钮选中开放路径对象，单击工具栏上

的 Object面板，使之显示在屏幕上。在 Object面板上启用 Close复选框，FreeHand 会自动连

接该对象的起点和终点，形成一个闭合路径的对象，如图 4-18 所示。

图 4-18 自动连接路径
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当绘图页面内有 2 条分离路径，其中一条路径的端点恰好位于另一个端点的上方时，

Join命令将融合这 2 个点成为一个内部点。首先，用 Pointer工具把一个端点拖动到另一个

端点上，或用 View菜单的 Snap to Point 命令使 2 点重合，然后按住 Shift 键，用 Pointer 工具

分别选中 2 条路径，最后选择 Modify→Join命令，使 2 个端点融合成一个内部点。

若绘图页面内的 2 条分离路径没有端点重叠，当选择 Modify→Join 命令时，FreeHand 会

用一条直线将 2 个端点连接起来。

闭合路径是基于 2 个分离路径进行连接。这里，可以分为使用直线连接和使用曲线连

接。用直线连接封闭路径对象可用 Line 工具、Pen 工具或 Bezigon 工具；用曲线连接可用

Pen工具和 Bezigon工具。

下面，举一个例子来说明闭合路径的连接方法。用基本的绘图工具绘制一个椭圆和一

个矩形。用 Pointer工具选中椭圆，单击工具栏中的 Ungroup 工具按钮以解除组合状态。按

住 Shift键，并单击选中椭圆上的一点和矩形上的一点。启用 Object浮动面板并单击 Line工

具按钮。移动鼠标光标到矩形的角点上单击，然后拖动鼠标到椭圆上的点上，将从两点间引

出一条新线段。最后启用 Object面板上的 Close复选框完成连接，如图 4-19 所示。

图 4-19 闭合路径的连接

2. 分割路径

在 FreeHand 9 中分割路径的主要工具是 Knife 工具。用 Knife 工具可分割任何选中的

组合路径里的点和线段。用 Knife工具选中线段的某一位置单击就会在线段的单击处插入

2 个端点，该线段被一分为二成为 2 条线段；当用 Knife工具在内部点上单击时，该内部点被

分为 2 个端点。使用 Knife工具可打开一条开放路径或一条闭合路径。如果用户选中一条

或多条路径，Knife工具还能分割或复合路径元素，但剪断的路径将从组合中除去。Knife 工

具发挥作用的前提是要处于被选中状态，否则它将不起作用。

首先介绍一下图 4-20 所示的 Knife Tool对话框的组件：

（1）Tools Operation选项组：FreeHand选项使用户能使用 Knife工具像使用 FreeHand工

具画路径那样切割线条。Straight选项仅仅使用户能切割直线路径。

（2）Width选项组：定义用户所要切割的宽度。仅在用户拖动 Knife 工具时有用，在单

击 Knife工具时无用。

（3）Option选项组：Close Cut Paths复选框用于闭合切割路径，启用后能使 Knife工具两

边的路径自动闭合。Tight Fit复选框能使切割轨迹更精确地反映出鼠标的移动。

下面结合具体实例运用 Knife工具及 Bezigon工具来完成路径的分割：

（1）用 Ellipse工具绘制一个圆。
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图 4-20 Knife Tool对话框

（2）在工具箱中双击 Knife工具图标。

（3）选中圆，并按住 Shift键拖动 Knife工具在圆的右边产生一个垂直小片，使圆变成 2

个闭合路径，如图 4-21 所示。

图 4-21 拖动 Knife工具切割圆并把它变成两个闭合形状

（4）选中右边的路径，使用 Bezigon工具单击垂直切片的中点来放置一个曲线点。选择

该点，进入 Object Inspector并启用 Automatic复选框，对左边路径重复该操作。

（5）在右边的路径上拖动用户刚产生的点到右边线段中心曲线点的镜像位置。拖动添

加到左边路径上的点以使左边的形状与右边的形状对称。

（6）对圆的左边重复上述步骤，通过分割椭圆产生一个网球形状，如图 4-22 所示。

图 4-22 拖动线段来产生网球形状

4. 4 对象的基本操作

对路径和点进行整形的主要目的是为了满足用户调整图形的要求。本节将进一步对对

象进行整形。最基本的方法是用鼠标拖动来进行整形，另一种方法是对组合路径进行操作，

它需要用一些特殊的工具来执行由简单图形向复杂图形的过渡。
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4. 4. 1 简单几何图形的调整

简单的几何图形包括椭圆、圆、矩形、正方形、星形等常见的图形，许多奇特的图形都是

由这些图形逐步变化而来的，因此，首先要介绍一下简单几何图形的整形操作。例如，椭圆

与矩形是 FreeHand中比较常用的几何形状，下面介绍对它们进行整形的操作步骤：

（1）在 FreeHand 9 中用 Pointer工具选中椭圆和正方形组成的图形。

（2）单击主工具栏中的 Ungroup按钮，解除它们的组合，如图 4-23 左图所示，解除组合

后的图形与原图形有一些质的变化。正方形角点的黑色方块变为空心方形，圆上的点出现

了控制柄。

（3）单击 Pointer工具选中该图形，然后移动鼠标到想要拖动的点，单击并拖动到其他

方向，使图形出现改观，如图 4-23 右图所示。

图 4-23 圆及正方形的调整

与椭圆和矩形不同的是，对多边形的整形不需要进行取消组合的操作。用户只要在其

路径上的任意一点进行拉伸，就可改变其形状，而不会影响到其他的点，这是因为 FreeHand

是把多边形作为一个曲线对象来处理的。

下面我们以一个示例来说明：使用 Ploygon工具绘制一个星形对象，单击 Pointer工具选

中该对象。移动鼠标光标到路径上任一点，单击并拖动该点改变它的形状，依次调整星形的

各个角，效果如图 4-24 所示。

图 4-24 星形的调整

4. 4. 2 组合路径轮廓

修改几何图形就是为了创造出更完美的图形，不能只满足于利用简单的鼠标操作来实

现对对象的修改。在本节中将介绍 Xtras 菜单的 Path Operations 子菜单中的 8 个路径类命

令，它们分别是 Intersect（相交）、Transparency（透明度）、Punch（穿孔）、Union（联合）、Crop
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（剪切）、Divide（分割）、Expand Stroke（扩展封套）及 Inset Path（内置路径），这些命令能够修

改、组合简单对象，以生成复杂的更高层次的图形。

1. Instersect 命令

Instersect命令能够保留所有选中路径的重叠部分，而将其他部分移除，如果选中的图形

对象没有相互重叠的部分，应用 Intersect命令后，将移除全部选定的对象而不会显示任何警

告信息。下面以一个具体例子来说明 Instersect命令的用法和效果。

用基本绘图工具绘制 3 个基本形状的图形：三角形、圆形、正方形，使三者相互重叠，将

三者选中，如图 4-25 左图所示。执行 Xtras→Path Operations→Intersect 命令，效果如图 4-25

右图所示。而若使三者两两重叠，选中三者，并执行 Intersect命令时，则将删除选中的路径，

不显示出三者之间的公共部分，如图 4-26 所示。

图 4-25 三种基本的对象

图 4-26 两两重叠的情况

2. Transparency命令

在生成新的图形时，Transparency命令是唯一能保留原有形状的命令。用户不但可以保

留用户的原图形，而且可以混合图形的填充；当用户单击 Operation 面板上的 Transparency图

标时，可改变前景对象的透明百分比。如果用户想用最后面的对象进行填充，则输入值为

100。要用最前面的对象进行填充，则输入值为 0。要想混合前后对象的色彩，则输入中间

值。按回车键后，FreeHand会产生一个新的图形，并保留了原图。

Transparency命令产生的新对象没有边线，而且，透明命令不能用于混合渐变色。如果

用户试图用透明命令混合渐变对象，则需用 Form颜色进行渐变填充，用 Outer 颜色进行径

向填充，从而完成透明操作。Transparency对话框没有预览选项。换句话说，评判颜色混合

唯一的方法就是移动滑块并单击 OK。如果用户不喜欢得到的结果，就必须选择 Undo命令

再试验。

以图 4-27 为例，验证一下输入值为 0、70、100 时图形交叉部分填充颜色的变化情况，其

中左图为输入值为 0 时的情况，中图为输入值为 70 的情况，右图则为输入值为 100 的情况。

3. Punch命令

Punch命令同样是针对多个有着相互重叠的区域的图形对象进行操作，它的主要功能

是使用选中的第一个对象将其后面的所有被选中的对象穿一个孔，从而生成一个新的图形
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图 4-27 三种变化的情况

对象，该对象具有最上面的图形的全部或者一部分的形状。下面以一个具体例子来说明

Punch命令的用法和效果。图 4-28 左图为执行命令前 2 个图形相互重叠的形状，而右图五

角星的尖端被咬去，但依然为五角星的填充属性。

图 4-28 执行 Punch命令的前后变化

4. Crop命令

Crop命令适用于 2 个或 2 个以上的对象，并且生成的剪切路径会排在最前面的路径上，

与穿孔不同，它只保留挖去的部分，而将其余部分的图形完全去掉，要使用该命令必须先用

Pointer工具将 2 个图形选中。下面以一个具体例子来说明 Crop 命令的用法和效果。首先

用基本的绘图工具绘制一个苹果及一个五角星，然后用 Pointer 工具选中苹果及五角星，最

后执行 Crop命令，效果如图 4-29 所示。

图 4-29 执行 Crop命令的前后变化

5. Union命令

Union命令提供一条围绕着所有选中图形的轮廓线，该命令去掉了重叠部分的细节，仅

保留了整个轮廓。与前几个命令不同的是它将使生成的图形变大，该命令围绕所选中的图

形的轮廓线来生成新的图形对象，然后再对对象进行颜色填充。使用 Union 命令的具体操

作过程如下：

首先绘制一个三角形与一个苹果。按住 Shift键，然后用 Pointer工具使它们处于选中状

态。单击 Union命令产生新的图形，并对其进行颜色填充，如图 4-30 所示。

6. Divide命令

Divide命令是最“残酷”的命令，执行该命令后图形将会被肢解，其操作的基本原理是用

原对象去分割目标对象，原对象与目标对象重叠的部分，从原对象中分解为一个独立的单
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图 4-30 执行 Union命令产生的图形

位，而目标对象中被切去的部分也能从目标对象中分离出来。

仍以苹果与五角星的重叠图形为例。执行 Divide 命令后，苹果与五角星的重叠部分会

从各自的原对象中分割出来，成为各自独立的 3 个部分，而图形的颜色却保持原样不改变，

如图 4-31 所示。

图 4-31 执行 Divide命令的前后变化

7. Expand Stroke命令

Expand Stroke命令的应用范围十分广泛，它不仅可以用于开放路径，也可以用于闭合路

径，但它只是对对象的轮廓线进行处理。在应用该命令前应选中对象，然后双击该按钮就会

弹出一个对话框，如图 4-32 所示，对话框的基本选项如下：

 Width选项：主要用来指定轮廓线的宽度，可以直接在左边的数值框中键入数值，也

可以拖动滚动条进行调整，轮廓线宽度的范围在 0 ～ 50 之间。

 Cap选项：包括 3 个按钮，分别代表轮廓线线头的形状。

 Join选项：其中的 3 个按钮主要用来指定轮廓线拐角处连接点的类型。

 Miter limit选项：键入数值以指定扩展后轮廓线的平滑程度。

图 4-32 Expand Stroke对话框

Expand Stroke命令适用于开放路径和闭合路径两种对象。对于开放路径对象使用 Ex-

pand Stroke命令，可以将路径轮廓线变宽，得到一个新的开放路径，如图 4-33 左图所示。如

果原路径是封闭的，Expand Stroke将使该路径轮廓线变宽，并将原来对象的轮廓线换为组合

路径的子路径，然后将填充的各个封闭路径，如图 4-33 右图所示。
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图 4-33 执行 Expand Stroke命令前后的变化

8. Inset Path命令

Inset Path命令是使图形产生轮廓的效果，它的应用范围仅限于封闭路径，要创建轮廓

化效果，首先使用 Pointer工具选中对象，然后选择 Xtras→Path Operation→Inset Path 命令，

打开 Inset Path对话框，如图 4-34 所示。下面简要介绍 Inset Path对话框中的组件：

 Steps：可以设置路径的圈数，右边的下拉菜单主要用于选择轮廓之间的扩展方式，其

中 Uniform 选项表示轮廓圈之间距离相同，Further选项指间距随原对象的距离变远而变小，

Nearer选项是指间距随与原对象距离变近而变小。

 Inset：包括一个数值框和一个标尺，它们都是用来指定扩展方向的，键入正值时轮廓

向外扩展，键入负值时向内扩展。

Join和 Miter limit的功能与 Expand Stroke 中相应选项的功能相同，分别用于控制连接

点的类型及轮廓线的平滑程度。

图 4-34 Inset Path对话框

绘制一个图形对象，当选中它并执行 Inset 命令时，可以看到其生成的效果。FreeHand

9 会自动改变原路径边缘如图 4-35 所示。

图 4-35 Inset Path命令前后的图形变化
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第五章

对象的变换

在 FreeHand 9 中提供了许多对象变换的方法，其中包括对齐、

分布、锁定、分层等基本方法，还在 Transform面板上提供了执行移

动、缩放、旋转、倾斜、反射等变换功能的工具。本章将结合具体示

例，介绍各种变换方法和变换工具的使用技巧和效果。

本章包括以下要点：

 对齐与分布对象；
 群组与合并对象；
 锁定与解锁对象；
 按图形安排对象。

5. 1 对齐与分布对象

对齐与分布是对象通过 Align面板实现的，其主要功能是调整 2

个或多个对象的相对位置，以满足用户的制作需要。

要想对齐或分布 2 个或多个对象，首先打开 Align 面板，如图 5-

1 所示，然后选中要变换的对象，从水平或垂直下拉列表中选出合适

的选项，并单击相应的按钮。

5. 1. 1 对齐对象

对象对齐的操作主要是运用 Align 面板来实现的，对齐分为水

平对齐和垂直对齐 2 种，其中水平对齐包括顶端对齐、中心对齐、底

端对齐，而垂直对齐则包括左对齐、中心对齐和右对齐。另外，要说

明的一点是，点的对齐与其他对象的对齐操作过程是相同的。下面

结合实例讲解对齐对象的操作步骤：

（1）用基本的绘图工具绘制 3 个图形对象：苹果、五角星、网球。
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图 5-1 Align面板

（2）用 Pointer工具分别选中 3 个对象。

（3）打开 Align面板，从水平对齐列表中选择 Align top选项，然后在垂直对齐列表中选

择 No change选项。

（4）单击 Align面板右下角的按钮，完成对齐操作，如图 5-2 所示。

图 5-2 执行对齐后的图形

在 Align面板中，左对齐（Align left）和右对齐（Align right）操作的完成是通过移动路径

使其关键点与保持不动的路径的关键点对齐。顶对齐（Align top）和底对齐（Align bottom）

操作也是一样。然而，中心对齐（Align center）操作与以上操作不同。首先，FreeHand 需要

找出定义所有选中路径轮廓的方程式。在沿着这个轮廓绘制了几个点后，平均这些点的位

置值以找出水平和垂直坐标的中心。最后，FreeHand 移动每一个路径以使它们的中心位于

平均值坐标。

水平对齐后的对象会排成垂直的一列，垂直对齐后的对象会排成水平的一行。如果用

户需要精确地对准选择对象的中心，则可以在水平和垂直列表中都选择 Align center 选项。

注意，用户在执行对齐对象的操作之前可以选择 Lock 命令锁定一个对象。这样，锁定的对

象会保持绝对静止，其他对象可以以锁定的对象为参照进行对齐操作。

5. 1. 2 对象的分布

对象的分布主要应用于等距分布的情况，可以使对象 A和它邻近的对象 B之间距离等

于对象 B和它邻近对象 C之间的距离。因此，在 FreeHand 中，分布操作必须要针对 3 个或

3 个以上的对象。和对齐操作一样，分布操作也分为垂直分布和水平分布 2 种。其中垂直
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分布包括左分布、右分布、中心分布及等宽分布；水平分布包括顶端分布、底端分布、中心分

布及等高分布。下面结合具体实例说明具体的操作步骤：

（1）首先用 Pointer工具选中苹果、网球、五角星 3 个对象。

（2）从主工具栏中打开 Align面板。

（3）从水平分布列表中选择 Distribute bottom选项，然后从垂直分布列表中选择 Distrib-

ute widths选项（或从水平分布选择 Distribute heights选项，然后从垂直分布中选择 Distribute

widths选项）。

（4）最后单击面板右下角的 Apply按钮，图 5-3 显示了 2 种对象水平与垂直分布所产生

的效果。

图 5-3 执行分布变化后的图形

5. 2 组合与合并对象

用户可以将所选对象使用 Group命令组合起来，也可以用 Join 命令合并起来。这 2 个

命令的相同点就是把对象作为独立的整体来进行操作。当进行组合或合并的操作时，首先

选中所有要组合或合并的对象，然后打开 Modify下拉菜单，选择相应的 Group 或 Join 命令

即可实现对象的组合或合并操作。取消组合或合并时，只要将对象选中，然后从 Modify菜

单中选择 Ungroup或 Split命令即可。

5. 2. 1 组合与取消组合

当用户选择 Group命令时，不管选中的是一个单独的点、线段，还是整个路径，用户所得

到的结果都是相同的。所有被选中的对象，即便仅部分被选中都组合起来成为一个整体。

用户能够把对象组合到单独的路径上，使得点与线段之间的联系保持不变。当用户组合了

一个或多个对象后，由其 4 个角的控制柄来定义组的周边，就像一个几何图形一样。使用

Pointer工具能拖动任意一个角的控制柄来缩放组中的对象。

当一个组被选中时，Object浮动面板将显示有关组的信息，如图 5-4 所示。前 2 个 Di-

mensions参数显示了组的左下角相对于标尺原点的位置。后 2 个 Dimensions参数控制组的

宽和高。
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图 5-4 Object面板及基本图形

进行对象组合时具体的操作步骤如下：

（1）用基本的绘图工具绘制一个苹果和一个椭圆。

（2）用 Pointer工具分别选中它们。

（3）选择 ModifyGroup选项完成组合。

（4）用 Pointer工具拖动任意一个角的控制柄，对组内对象进行缩放选中组合对象。

（5）要解除对象的组合，用 Pointer工具选中该组合对象，再选择 Modify→Ungroup 命令

即可。执行命令后，各个组中的所有对象都会保持组合前的属性。

取消组合的方法是通过选择 Modify→Ungroup命令来实现的，但要注意以下几点：

 用户可以同时取消组合多个组，但每次只能处理一层。也就是说，如果一个组包含
其他组，用户必须首先取消最近创建的组。然后在所有的组仍被选中时，选择 Modify→Un-

group命令取消组合那些成员组。

 当用户选择 Ungroup命令时，如果选择的对象中只包含组合对象与非组合对象，放

弃非组合对象的选择，仅保留那些组合对象。

 默认情况下，用户不能取消组中的成员组的组合。通过按住 Alt键，单击选中的组中

的成员组，再选择 Modify→Ungroup命令即可。

 用户可以取消利用 Rectangle或 Ellipse工具创建的几何路径的组合状态。

5. 2. 2 合并与分离对象

合并与组合操作有相似之处，它们都将对象作为整体来进行处理，然而二者之间又存在

区别。合并是修整路径的操作，会创建一条复合路径，而组合是基于对象的操作，使之成为

一个组合；合并之后对象内部填充的属性发生改变，使对象具有统一的填充属性，而组合对

对象内部的填充属性不发生改变，即分离操作使对象保持合并后的填充属性，而取消组合后

的对象仍保持未组合前的填充属性。

下面结合具体实例来看一下组合与合并二者的区别：

（1）用基本的绘图工具绘制一个椭圆、一个矩形和一个五角星形，并分别填充其颜色，

如图 5-5 所示。

（2）将 3 个对象排成一排，两两无重叠区域。
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（3）单击工具箱中的 Pointer工具按钮，然后按住 Shift键，分别单击各个对象，使之处于

选中状态。

（4）从 Modify菜单中选择 Join命令，单击得到如图 5-5 上图所示的图形。

（5）从 Edit菜单中选择 Undo命令，恢复未进行合并前的状态。

（6）选择 Modify菜单中的 Group命令，单击可得到如图 5-5 下图所示的图形。

图 5-5 合并与组合图形对象

（7）将该独立的对象执行 Ungroup命令，得到如图 5-6 上图所示的图形。

（8）将对象分别选中，执行 Join命令，然后执行 Split 命令，出现如图 5-6 下图所示的图

形。

图 5-6 分离与取消组合图形对象

由图 5-5 和图 5-6 对比可以看出：合并和分离改变了原对象的填充属性，是基于路径的

修整，而组合与取消组合操作未对对象的填充属性进行更改，是基于对象的操作。但合并对

象时对颜色的填充与对象是否相互重叠有关。如果将图 5-4 中的对象如图 5-7 所示放置，

然后分别选中这 3 个对象，执行合并命令后将得到图 5-8 左图所示的图形，未重叠的部分与

3 者全部重叠的部分以相同的颜色显示，而两两重叠的部分则为白色的空洞。执行分离命

令后，可以看到 3 者均以同种颜色来显示（如图 5-8 右图所示）。

图 5-7 三对象相互重叠
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图 5-8 合并及分离时填充颜色的变化

5. 3 锁定与解除锁定

当用户进行一幅复杂图形的绘制时，经常需要绘制一些相互重叠的对象。在修整或变

换图形时，用户很可能不小心选中并改变了重叠的对象，而这个对象是已准确定位了的。

FreeHand中提供了一种锁定对象的方法来保护文字框和图形不被破坏或修改。

5. 3. 1 锁定对象

锁定一条路径可避免这条路径以及路径上所有的点被移动。任何一种方式都不能改变

一个锁定的对象。然而，锁定的对象也不是完全不能被改变。用户能够改变它的填充或笔

画属性。要锁定一个对象，选中它并从Modify菜单中选择 Lock命令即可。用户不能单独锁

定路径上的一个点。如果用户锁定一个点并选择 Lock命令，FreeHand将锁定整条路径。下

面结合具体实例说明 Lock命令的操作步骤：

（1）启动 FreeHand 9。

（2）使用基本绘图工具在绘图页面中绘制两个图形对象：一个苹果和一个五角星形。

（3）使用 Pointer工具在苹果上单击以选中它，为了更好地显示生成的效果，先使用 Un-

group命令解除它的组合。

（4）选择 Modify菜单中的 Lock命令以锁定苹果。

（5）按下 Shift键依次单击苹果和五角星形，可以看到，未被锁定的五角星形上的所有

点都被选中，但没有选中苹果上的点（以黑色的小方块显示），如图 5-9 左图所示。

（6）拖动锁定的苹果并移动到其他位置，可以看到，只有未被锁定的五角星形发生了位

移，而一点也没有影响到苹果，如图 5-9 右图所示。

图 5-9 图形锁定前后
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5. 3. 2 给对象开锁

要想给对象开锁，选中对象并选择 Modify中的 Unlock命令或单击主工具栏中的 Unlock

按钮。如果选中的对象没有被锁定，Unlock命令不可用。FreeHand 随文件保存对象的锁定

状态。当用户打开一个已保存的文件时，先前被锁定的所有对象仍被锁定。

5. 4 按图层安排对象

通常情况下，分层是按用户绘画的次序进行的。最先画的对象在最底层，最后画的对象

在最上层。在 FreeHand中，用户能够调整已存在的图形对象和文字框的重叠次序。使用

Layers面板，用户能创建多个完备的绘图层，它们就像透明的玻璃纸一样工作。一幅插图能

包含任意多个层，每个层可包括任意多个对象，用户能给层命名并按需要改变它们的次序。

5. 4. 1 使用绘图层

要显示 Layers面板，选择Window→Panels→Layers命令，FreeHand在 Layers面板里以列

表的形式显示当前文件所有的绘图层，如图 5-10 所示。用户可以用 Options 弹出菜单中的

选项来定义和操作层。

图 5-10 Layers和 Options弹出菜单的内容

Layers面板主要用于显示当前文档中对象的分层结构。这种分层显示出该文档中每个

页面上对象或图层的堆叠顺序。对于文档中的每个对象，该面板中都会显示出一个小图标

和简要说明，指明该对象的基本填充和轮廓属性。应当注意到，无论是在 Layers 面板中还

是在绘图窗口中选定对象后，它都会自动地醒目显示以与便其他对象区分开来。

Layers面板包括以下组件：

 Options 按钮：单击该按钮可以弹出用于图层操作的选项。包括显示图层、隐藏图

层、新建图层等。
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 图层名称：显示各图层中包含的对象的名称。
 前景层：这个层包含所有可以打印的对象。
 辅助线：显示辅助线所在的图层、颜色等属性。放到该层中的所有图形都被当作辅

助对象。

 背景层：显示背景层的属性。
 锁定状态：系统默认状态下图层中的图形都是非锁定状态；要锁定它，单击锁状图标

即可。

 显示标记：用来指示各个图层中的对象是否显示于绘图窗口。
 色样框：显示各图层中对象的填充颜色。
 图层标记：显示所有图层中的图形对象。
当用户在绘图页面中选择一个对象时，FreeHand 在 Layers面板的列表中醒目显示对象

所在层的名字。如果用户从不同的层选择若干个对象，将没有层名会被醒目显示。如果没

有对象被选中，醒目显示的层名是默认的绘图层，将来所有的对象都在那里创建。

5. 4. 2 给对象分配层

要想使用 Layers面板把一个或多个被选中的对象放置在同一个图层上，方法非常简

单，只要在层名列表里单击一个层名即可。用户只能将一个完整的对象放置到不同的图层

上。如果只选中了路径的一部分，FreeHand同样会移动整个路径到该层上。送到 Guides层

的所有对象都将变成辅助对象。用户不能够移动被锁定的对象。如果将一个对象送到

Background（背景）层中，那么这些对象都会以灰色显示出来，不能够被打印。把对象送到不

同的层时，将改变默认层。

5. 4. 3 创建和命名一个新层

要想在文件中创建一个新的图层，单击层面板中的 Options 按钮，从其弹出的菜单中选

择 New命令即可。在系统默认状态下，新建的图层将以 Layer - 1、Layer - 2 等名称来命名，

如果用户需要为新建的层重新命名，可以在该名称上双击，然后键入一个新的名字，按回车

键即可。创建新图层的另外一种方法是拷贝一个已经存在的图层。选中要拷贝的图层，然

后单击 Layers面板上的 Options按钮，从其弹出的菜单上选择 Duplicate 命令即可，FreeHand

将复制已有层里的所有对象，而且把复制品送至一个新层里。

5. 4. 4 重新排列层次

Layers面板上层名显示的顺序决定了文件中层的重叠顺序，在层名列表中的第一个名

字是最前面的层，最后一个名字是最后面的层。要想改变在绘图文件中层次的顺序，只要在

Layers面板的层名列表中拖动层名到不同的位置即可。根据用户的拖动，FreeHand 把被拖
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动层上的对象重新排列到新的重叠顺序中。在 Layers 面板中把某个层拖动到虚线下面将

使它变为不可打印的背景层。被拖到虚线下面后，在该层上的所有对象显为灰色。把层名

拖动到上面会使它成为可打印的前景层。

默认情况下，Guides层在所有背景层的前面，而在所有前景层的背后。用户能按自己的

需要重新排列它们。

5. 4. 5 显示和隐藏层

位于层名前面的对号标志表明该层的所有对象将显示在屏幕上。名称前标有对号的前

景层将被打印。单击对号标志将隐藏层，这时，在绘图窗口中该层上的所有对象都隐藏了起

来。要显示隐藏层的对象，单击层名的前端以显示出对号标志即可，如图 5-11 所示。

图 5-11 隐藏层时的选项框

如果用户需要隐藏当前作品中的全部图层，从 Option 弹出菜单中选择 All off（全部隐

藏）选项就可以了；如果要显示所有的图层，则可以选择 All on（全部显示）命令。还有一种

方法是通过 View→Hide Selection命令来隐藏层，只要选择 View菜单中的 Show All 命令就

可以使隐藏的层显示出来。

5. 4. 6 保护层

就像保护一个选中的对象不被改变一样，用户也能保护一个层上的全部对象不被改变。

保护层的一个方法是隐藏它。由于用户看不到它，所以不能对它进行处理。用户还可以通

过锁定层来保护层中的对象。要这样做，单击在 Layers 面板中层名前面的锁形图标；当锁

显示为开时，层没有被锁定，而当锁显示为锁定时，在相应的层上的所有对象都会同时被锁

定。要给层开锁，再次单击锁形图标即可。要想锁定文件中的所有层，按住 Ctrl键单击任意

一个开着的锁形图标即可。要想给所有层开锁，按住 Ctrl 键单击任意个锁定的锁形图标即

可。

5. 4. 7 删除已有层

用户能删除任意一个绘图层，通过在 Layers 面板中选中层名并从弹出菜单中选择 Re-

move命令即可。如果层上有对象存在，FreeHand会显示一个警告对话框提示用户在层上的
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所有对象都将被删除。如果用户错误地删除了一个层，可以从 Edit 菜单选择 Undo Remove

Layer命令来恢复层和层中的对象。Guides层不能被删除。

5. 4. 8 改变同一层内的次序

用户能够在一个单独的层上重新排列对象。打开 Modify菜单中的 Arrange 子菜单，然

后选择 Bring to Front命令或 Send to Back命令即可。

Bring to Front命令执行后可以将选中的对象移至所在层的最前面。但打印或浏览时，

这个对象将在最后显示。

Send to Back命令执行后，FreeHand将把它当作层中的第一条路径来处理，当用户打印

或浏览时，它首先被显示。

但要注意，这 2 个命令只限于对一个对象进行处理。当用户选中路径的一部分时，

FreeHand将把整条路径进行移动。如果用户选中多条路径，执行这 2 个命令时，各个选中

对象的相互次序将保持不变。移至最前面和最后面是相对于所选中对象而言的，如图 5-12

所示。Arrange子菜单中用于调整同一层内次序的命令还有以下 2 个：

 Move Forward（向前）命令：使所选的对象在它所在的层内向前移动一步。

 Move Backward（向后）命令：使所选的对象在它所在的层内向后移动一步。

图 5-12 执行向前命令图形的前后变化

FreeHand还提供了使一个对象直接送到另一个对象之后的 Paste Behind 命令。首先选

中对象 A，执行 Edit→Cut 命令，然后选择对象 B，执行 Edit→Paste Behind 命令。FreeHand

将直接把对象 A放在对象 B之后。当多个对象被选中时，FreeHand把剪贴板的内容放在最

后面那个选中对象的后面。

5. 5 使用鼠标进行变换操作

在 FreeHand 9 中，对象的变换操作包括位移、缩放、倾斜、镜像以及旋转等。使用鼠标

可以进行一些常规的变换操作。这种方法的优势在于操作简便，而且能够将变换的效果迅

速地显示在屏幕上；它的不足之处在于操作精度受到很大的限制，受操作者熟练程度的影

响。
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5. 5. 1 使用鼠标进行对象的位移

使用鼠标移动对象同时，无论选定的对象是矩形、圆、直线或者曲线，FreeHand 都会以

一个矩形框来作为移动的预览示意图，如图 5-13 所示。如果在对象的端点上单击并拖动，

会产生缩放、倾斜等其他操作，而不是位移。具体操作步骤如下：

（1）单击工具箱中的 Pointer工具按钮。

（2）选中要位移的对象。

（3）移动鼠标光标到该对象的轮廓线上除端点外的任意位置单击并拖动鼠标。

图 5-13 使用鼠标位移对象

使用鼠标进行位移的另一种方法是在对象上双击以显示旋转和倾斜控制柄，然后移动

鼠标光标到控制柄所在的矩形范围以内，这时光标会变成位移光标，单击并拖动到新位置就

可以实现位移。

5. 5. 2 使用鼠标进行对象的延展

延展操作是指选定对象的一端固定，另一端朝一个方向扩大或者缩小。同样的，延展操

作可以在 2 种不同的状态下进行。一种是对象的选定状态时，在这种状态下进行的延展较

为复杂，它与鼠标拖动的方向关系很密切。如果用户单击对象的某一角点沿水平或者垂直

方向拖动，就可以实现单方向延展，如图 5-14 左图所示；如果用户在拖动过程中方向发生了

偏移，延展就会同时向 2 个方向发生，如图 5-14 右图所示。

图 5-14 对象延展的具体过程

另外一种延展操作是在该对象上双击以便出现旋转与倾斜控制柄，即将变换对象切换

至“变换”状态。在这种情况下，用户只需单击一条边，按住鼠标键不放并拖动就可以实现

沿水平或者垂直方向的延展了，如图 5-15 所示。
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图 5-15 使用鼠标进行对象的延展操作

5. 5. 3 使用鼠标缩放对象

使用鼠标缩放对象时，必须使对象处于变换状态。在要进行缩放的对象上双击，该对象

周围就会出现 8 个黑色小方块形状的控制柄，如图 5-16 左图所示；将鼠标光标移动到对角

线方向的角点控制柄上，单击并拖动就可以等比例地实现该对象的缩放：当向远离中心点的

位置拖动时，会等比例放大对象，如图 5-16 中图所示。当向靠近对象的中心点位置拖动时，

就会等比例缩小对象，如图 5-16 右图所示。与处于选中状态下对象的双向延展操作不同的

是，这种缩放操作需要单击控制柄来实现，而双向延展是通过角点来实现的。

图 5-16 使用鼠标实现对象的等比例缩放

5. 5. 4 使用鼠标倾斜对象

要想使用鼠标对对象进行倾斜操作，同样需要使对象处于变换状态下。在 FreeHand 9

中，既可以对一个选定对象进行水平方向的倾斜，也可以对它进行垂直方向的倾斜操作。系

统默认状态下，倾斜操作是根据选定对象的中心点位置来进行的，FreeHand 9 还能够使用鼠

标来改变倾斜的中心点位置以生成不同的倾斜效果。使用鼠标倾斜对象的操作步骤如下：

（1）在 FreeHand 9 中使用 Pointer工具双击对象，使对象周围的控制柄显示出来。

（2）移动鼠标光标到水平方向上的 2 个控制柄中的一个上单击，然后沿水平方向拖动，

就可以实现该对象在垂直方向上的倾斜，如图 5-17 左图所示。

（3）单击垂直方向上的 2 个控制柄中的一个并沿垂直方向拖动，就可以实现该对象在

水平方向上的倾斜，如图 5-17 中图所示。

（4）在该对象中心点上单击并拖动到其他位置上，然后再分别执行以上 2 步的操作就

可以以中心点的新位置为参照点来倾斜对象，如图 5-17 右图所示。
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图 5-17 使用鼠标倾斜对象

5. 5. 5 使用鼠标旋转对象

使用鼠标对对象进行旋转时，对象的每条边都要绕旋转中心点作圆周运动。默认情况

下，FreeHand 9 以选定对象的中心点来旋转对象。用户也可以改变中心点的位置，以生成不

同的旋转效果。使用鼠标旋转对象的具体操作步骤如下：

（1）使用 Pointer工具在要进行旋转操作的对象上双击。

（2）移动鼠标光标到 8 个控制柄所组成的矩形区域的对角线位置上的控制柄上时，光

标会变成旋转光标，如图 5-18 左图所示。

（3）单击旋转控制柄中的一个，并沿圆周的轨迹拖动，就可以实现对象的旋转，如图 5-

18 中图所示。

（4）移动鼠标光标到对象的中心点位置上单击并拖动到其他的位置，改变旋转中心点

后再进行旋转，该对象就会围绕新设定的中心点进行旋转，如图 5-18 右图所示。

图 5-18 使用鼠标旋转对象

5. 6 使用变换工具

在 FreeHand 9 的工具箱中，为用户提供了一组进行对象变换的工具，它们是 Scale（比

例）工具、Rotate（旋转）工具、Skew（倾斜）工具以及 Reflect（镜像）工具等。使用这些变换工

具进行的变换操作，能够提供比鼠标操作更多的变换方法，同时在精确度上也大大提高了。

5. 6. 1 Scale工具

Scale工具是一种功能强大、操作简便的工具。它能够将选定的对象根据拖动鼠标的方

法的不同来进行不按比例的缩放；或者将它们朝一个方向增高、变矮，或者将它们压缩、放
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大，并能够同时实现旋转和倾斜。使用 Scale工具缩放具体对象的操作步骤如下：

（1）启动 FreeHand 9。

（2）使用 Pointer工具选中要进行缩放的对象。

（3）单击工具箱中的 Scale工具按钮。

（4）移动鼠标光标到选定的对象上单击并拖动，将以单击点为中心进行缩放。如果开

始时的单击点在对象的左下角，那么当向右拖动时，可以从水平方向上拉长对象，如图 5-19

中图所示。

（5）沿垂直方向向上拖动可以使对象拉长，如图 5-19 左图所示。

图 5-19 使用 Scale工具能够缩放对象

（6）沿垂直方向向下拖动则可以压缩对象，图 5-19 右图所示。

（7）当用户的拖动达到一定的极限时，就可以产生该对象的镜像效果。例如，如果放下

鼠标的位置低于开始点的位置，就会以水平方向为轴心垂直镜像对象，如图 5-20 左图所示；

如果该位置在开始点位置的左侧，则以垂直方向为轴心水平镜像对象，如图 5-20 右图所示。

图 5-20 使用 Scale工具也能够镜像对象

5. 6. 2 Magnification 工具

Magnification工具在对选定的对象进行放大操作时，是以等比例进行缩放的。也就是

说，使用该工具时，缩放前后对象的宽和高的比例是相等的。进行放大操作时就只能对选定

的对象进行放大，而不能将之缩小；如果要缩小一个对象，必须通过在 Status 工具栏上改变

视图尺寸来实现。另外需要注意的是，当使用 Scale 工具时，是将选定对象的实际尺寸进行

了放大或者缩小；放大操作只是改变了视图的大小，而选定对象仍然保持原来的大小。下面

将结合具体实例进行说明，使用 Magnification工具放大对象的操作步骤如下：

（1）在 FreeHand 9 的工具箱中，使用 Pointer工具选中要进行放大操作的对象。

（2）单击工具箱中的 Magnification工具按钮。

（3）移动鼠标光标到该对象上单击，就可以放大该对象；再次单击，可以再次将它放大。
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用户如果想对对象的递增频率进行控制，就需要打开视图下拉菜单，然后单击放大选

项，如图 5-21 所示，可以任意选择一种递增频率。

图 5-21 图形的放大与缩小

如果用户需要快速地放大某个对象，可以使用 Magnification 工具在对象上单击并拖动，

这时会出现一个虚线的矩形框，当放下鼠标时，该矩形框消失，选定的对象能够以用户自定

义的尺寸快速地放大。

5. 6. 3 Rotate工具

Rotate工具的主要作用就是用来进行对象的旋转操作。与使用鼠标进行旋转操作不同

的是，Rotate工具能够以在对象上的单击点位置为参照点来进行旋转。并且在使用该工具

时，FreeHand 9 会从该参照点引出一条直线来指示旋转的方向。指示直线是一条虚拟的参

照直线，不会出现在最终的旋转结果中。具体操作步骤如下：

（1）在 FreeHand 9 中使用 Pointer工具选定旋转对象。

（2）单击工具箱中的 Rotate工具按钮，然后在该对象的任意位置上单击。

（3）单击点会被确定为旋转的中心点，按住鼠标键不放沿圆周方向拖动就可以旋转该

对象，效果如图 5-22 所示。

图 5-22 使用 Rotate工具旋转对象

5. 6. 4 Skew工具

倾斜对象是指将选定的对象在水平或者垂直方向上以一定角度进行倾斜。工具箱的
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Skew工具不但提供了以鼠标的拖动来倾斜对象的功能，而且能够根据拖动时的方向与角度

的不同而产生不同的效果。使用 Skew工具倾斜对象的操作步骤如下：

（1）在 FreeHand 9 中使用 Pointer工具选中要倾斜的对象。

（2）单击工具箱中的 Skew工具按钮。

（3）移动鼠标光标到对象上单击定位倾斜的中心点。

（4）按住鼠标键不放，水平地拖动鼠标就可以将对象沿水平方向倾斜，如图 5-23 左图

所示。

（5）垂直地拖动鼠标就可以沿垂直方向倾斜对象，如图 5-23 右图所示。

图 5-23 使用 Skew工具水平或者垂直地倾斜对象

如果用户在拖动的同时按住 Shift键不放，就可以控制选定的对象只在水平或者垂直方

向上产生倾斜。如果用户选定的倾斜中心点位置在对象内部，使用倾斜工具时会产生不同

的效果。

5. 6. 5 Reflect 工具

镜像操作能够使选定的对象产生投影到镜子后的效果。工具箱中的 Reflect 工具能够

参照一条轴线来镜像对象，轴线的位置及方向可以由用户自己来设定。如果结合 Shift键还

可以较为精确地控制镜像轴线的角度。使用 Reflect工具镜像对象的操作步骤如下：

（1）启动 FreeHand 9。

（2）使用 Pointer工具选中要进行镜像的对象。

（3）单击工具箱中的 Reflect工具按钮。

（4）移动鼠标光标到绘图页面上任意位置单击以定位镜像的中心点位置，然后按住鼠

标键拖动就可以镜像对象，如图 5-24 所示。

图 5-24 以任意角度来镜像对象
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进行镜像操作时，反射轴可以以任意角度来放置。如果用户按住 Shift 键并拖动，该反

射轴就会以 45 度角的倍数来放置，也就是所选对象以水平、垂直或者对角线角度来进行镜

像，如图 5-25 所示。

图 5-25 以 45 度角的倍数来放置反射轴

5. 7 精确变换对象

工具箱中的变换工具按钮的图标上都有一个参数标记，表示可以通过双击按钮进行精

确的设置。在 FreeHand 9 中，无论双击了变换类工具按钮中的哪一个，都会打开用于能够

精确控制变换操作的 Transform 面板。Transform 面板顶部提供了 5 个按钮，它们分别是

Move（位移）、Rotation（旋转）、Scale（比例）、Skew（倾斜）以及 Reflect（镜像）按钮，当用户启

用不同的按钮时，该面板的组件会有一些相应的变化。

5. 7. 1 精确位移对象

启用 Transform面板，然后在该面板中单击第一个按钮，会打开用于对选定对象进行精

确位移设置的 Move（位移）面板，如图 5-26 所示。

图 5-26 Move面板

Move面板的组成非常简单，它包括了移动距离（Move distance）数字框、Contents和 Fills
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复选框，以及一个执行按钮 Move。如果用户要对选定的对象进行水平位移，可以直接在 x

数字框中键入数字以设置该对象在水平方向上移动的距离；在 y数字框中键入数字可以设

置垂直方向上的移动距离。完成设置后，单击 Move 按钮即可实现位移操作。Move 面板中

数字框的数字并不代表对象的水平和垂直坐标，而只是相对于原来对象的位移。也就是说，

如果将选定的对象设置为原始对象，那么在 x框和 y框中都会显示为 0；在 x框中键入的值

为正值时，选定的对象将会向右移动，键入负值时向左移动；在 y框中键入的值为正值时，选

定的对象将会向上移动，键入负值时向下移动。例如，在绘图页面中选定了一个网球，并将

该对象确定为位移的起始处，设置为 x = 0，y = 0；要想将该网球向右上方移动，在数字框中

键入 x = 100，y = 100，然后单击 Move按钮，可以看到该网球出现在原来的网球的右上方；再

次单击时，将以第二个网球为参照位置进行位移，依次类推即可。位移所经过的轨迹如图

5-27 所示。

图 5-27 多次位移所经过的轨迹演示

如果想要在移动对象的同时，移动它的填充属性，就可以选中 Fills 复选框；否则，移动

对象时将不移动它的填充属性。

5. 7. 2 精确旋转对象

单击 Transform面板中的第二个按钮，就可以打开用于精确旋转对象设置的 Rotate 面

板，如图 5-28 所示。该面板提供了一些进行对象旋转的精确控件，可以精确地设置旋转的

图 5-28 Rotate面板

角度、旋转的中心位置等。精确旋转对象的操作步骤如下：

（1）在 FreeHand 9 中使用 Pointer工具选中要旋转的对象。
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（2）双击工具箱中的 Rotate工具按钮打开 Rotate面板。

（3）在该面板中的 Rotation angle（旋转角度）数字框中键入要旋转的角度值，如果键入

正值，选定的对象将按逆时针方向旋转，如图 5-29 左图所示；键入负值，将按顺时针方向旋

转，如图 5-29 中图所示。完成设置后，单击该面板中的 Rotate按钮，选定的对象将按用户指

定的角度进行旋转。

（4）要改变旋转的中心点位置，转到第 2 步，在 Center选项中的 x框中键入要设定的中

心点位置的横坐标，在 y框中键入要设定的中心点位置的纵坐标，旋转效果如图 5-29 右图

所示。

图 5-29 使用 Rotate面板来精确控制旋转图形

5. 7. 3 精确缩放对象

Transform面板中的第三个按钮是 Scale 按钮，单击时会打开如图 5-30 所示的 Scale 面

板。该面板允许用指定的数值来精确地控制选定对象的缩放，并且能够设置不同的缩放方

式。例如，用户可以启用 Uniform复选框以实现等比例缩放，也可以禁用该选项分别缩放选

定对象的高或宽。在系统默认状态下，Uniform选项处于启用状态，当用户禁用它时，该面板

会变成图 5-30 右图所示的样子。

图 5-30 Uniform选项启用（左图）和禁用时（右图）的 Scale面板

使用 Scale面板缩放对象的操作步骤如下：

（1）在 FreeHand 9 中使用 Pointer工具选中要进行缩放的对象。

（2）启用 Transform浮动面板，并打开 Scale面板。
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（3）系统默认状态下将启用该面板中的 Uniform选项，表示可以直接使用等比例缩放。

在 Scale数字框中键入数值以确定缩放的比例，该数值以原来对象的百分比来表示，如果用

户键入的数值大于 100，则可以放大对象；小于 100，将缩小该对象；等于 100，将不改变原来

对象的大小。

（4）在 Center选项的 x框中键入数值以设置缩放的中心点位置的横坐标，在 y框中键

入数值以设置中心点的纵坐标。

（5）启用 Lines选项时，将在缩放选定对象的同时缩放该对象的轮廓线的宽度，如图 5-

31 左图所示；如果禁用该选项，则无论如何缩放对象，对象的轮廓线都会保持原始宽度，如

图 5-31 的右图所示。

图 5-31 使用 Scale面板可以决定缩放时是否改变对象轮廓线的宽度

当禁用 Uniform选项时，将不按比例缩放对象，原来的 Scale 选项框就会变成 2 个：用以

设置选定对象宽度的 h数字框和用以设置高度的 v数字框。当 h 框中的值固定不变时，增

大 v框中的值可以使选定的对象变高；减小该数值可以使它变矮，如图 5-32 左图所示。当 v

框中的数值不变时，增大 h框中的数值可以将选定的对象变宽；减小该框的数值可以使该对

象变窄，如图 5-32 右图所示。

图 5-32 不按比例缩放对象

5. 7. 4 精确倾斜对象

Skew面板主要用来进行精确倾斜对象的设置。用户可以在工具栏里双击 Skew工具按

钮，或者在 Transform面板顶部单击 Skew按钮，打开图 5-33 所示的 Skew面板。在该面板中

可以设置倾斜的方向、角度以及倾斜的中心点位置。使用 Skew面板进行精确倾斜对象的操

作步骤如下：

（1）在 FreeHand 9 中使用 Pointer工具选中要进行倾斜的对象。

（2）启用 Transform面板，并单击该面板中的 Skew按钮，以打开 Skew面板。

（3）在 Skew面板中的 Skew angles选项中有 2 个角度框，用户可以分别键入数值以设

置倾斜的角度。在 h框中键入正值，以使选定的对象沿水平方向向右倾斜，键入负值可以使

选定对象沿水平方向向左倾斜。同理，正的 v值使选定的对象的右边部分向上移动，而左边
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部分向下移动；负的 v值使选定对象的右边部分向下移动，而左边部分向上移动。

（4）在 Center选项所包含的数字框中键入数值以设定倾斜的中心点的坐标。

（5）完成设置后，单击该面板底部的 Skew按钮即可。

图 5-33 Skew面板及图形变化

5. 7. 5 精确镜像对象

Reflect面板主要用来精确镜像对象，如图 5-34 所示。和 Skew面板一样，该面板也可以

通过 2 种方式调出：在工具栏上双击 Reflect 工具按钮或者在 Transform面板上单击 Reflect

按钮。

图 5-34 对选定对象进行精确镜像的 Reflect面板

Reflect面板可以提供以下几个精确镜像对象的选项：

 Reflect axis数字框：它的主要功能就是用来设置镜像轴线的方向，要使选定的对象

左右镜像，可以在该框中键入 90；要使对象沿水平方向镜像，就可以键入 0；如果用户需要任

意方向的镜像，就可以在该框中键入 0 ～ 180 之间的数值。

 Center选项框：该选项中的坐标用于设置镜像中心点的位置，中心点一定在轴线上，
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但不一定是镜像轴线的中点。

 其他选项：该面板中还包括了和其他面板一样的 Contents 选项和 Fills 选项，它们执

行的功能和前面介绍的相同。

上述几种面板都只是对整个对象进行操作，FreeHand 9 还可以对对象的局部进行各种

操作，像路径的局部缩放，路径的局部镜像等。它只对选中的部分进行变换，而未选中的部

分不会发生变化。例如，镜像时只镜像选中的部分的效果，如图 5-35 所示。

图 5-35 局部路径的镜像
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第六章

文本的录入与编辑

相信用户都使用过 Word 系列，会为其在文字处理上的强大功

能所折服。相比较而言，图形软件的文字处理有它独到的一面，文字

的各种特殊编排和特殊效果使图形作品更具特色。FreeHand 9 所具

有的强大的文本处理功能使它在各种图形处理软件中独树一帜。

本章将主要介绍如下内容：

 文本录入；
 字符的文本格式编排；
 段落的文本格式。

6. 1 文本录入

在使用 FreeHand 9 以前，首先应保证在工具栏中有如下的部

分：Main、Text、Toolbox，打开的方法是单击Window→Toolbars，再依次

单击Main、Text、Toolbox选项即可，如图 6-1 所示。在这种状态下，我

们就能方便的完成各种文本编辑工作了。

使用 FreeHand 9 进行文本录入的主要方法有以下两种：

 使用工具箱中的 Text工具；

 使用 Text菜单中的 Editor命令的文本编辑器。

图 6-1 Toolbars子菜单中的各选项
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6. 1. 1 文本的直接录入

文本直接录入方法是用户最常用的录入方式，它主要通过使用工具箱中的 Text 按钮禁

用时来实现录入。

在录入之前，应该对 Text 选项卡的设置做一下预处理。具体操作是依次单击 File→
Preferences→Text命令来启动 Text 选项卡，如图 6-2 所示。注意第一选项 Always use Text

Editor只有在禁用时才能采取直接录入的方式。另外第四项 New text containers auto - ex-

pand启用后，直接录入的文本以一行显示并无限延伸下去，换行必须按 Enter 键；当禁用此

选项时，默认的文本框只有 7. 62 厘米（3 英寸）宽，5. 08 厘米（2 英寸）高，它所容纳的文本数

量明显不够。

图 6-2 Textt选项卡

使用 FreeHand 9 直接录入文本的具体步骤如下：

（1）启动 FreeHand 9。

（2）单击工具箱中的 Text按钮，进入文字录入状态。

（3）确定文本框时也有 2 种方法：

 在绘图页面中任意位置单击定位一个绘图点，可以看到有输入提示光标在闪烁，此
时用户就可以将要输入的文本内容开始录入了。录入时随着键入的文字增多，文本框的标

尺也不断的扩展，如果需要换行时按下 Enter键即可。

 在绘图页面上先单击定位一点，按住向右下方拖动形成段落文本框，到适当的位置
松开鼠标按键，插入点会自动地位于文本框的左上角，输入提示符也会出现在文本的第一

行，此时键入的文本会自动换行，避免了按 Enter键的麻烦，当然，文本框的大小也是可以调

整的，如图 6-3 所示。

（4）录入完成后，单击绘图页面的任意空白位置，页面上就只剩下录入的文本了。这一

点也是 FreeHand 9 比 FreeHand 8 有所改进的地方，在 FreeHand 8 中还必须单击工具箱中的

Pointer工具再确定，而 FreeHand 9 已实现了自动转化。
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图 6-3 使用段落文本框录入

6. 1. 2 使用文本编辑器录入文本

与直接录入法相比，文本编辑器适于较大量的文本录入，并且录入的文本较为直观，文

字以实际大小显示，文本在录入时，排到窗口右边界时能够自动换行。

使用文本编辑器录入文本的具体步骤如下：

（1）启动 FreeHand 9。

（2）单击工具箱中的 Text工具按钮。

（3）单击绘图页面的任意位置，将弹出 Text Editor对话框，如图 6-4 所示。

图 6-4 文本编辑器的对话框

（4）如果用户想看到不带修饰的状态，启用对话框左上角的 12Pt Black，复选框。

（5）在文本编辑器中的输入符提示下，用户可以将要录入的文本输入对话框，键入的文

字达到右边界时会自动换行。

（6）文本编辑器分别有 OK、Cancel和 Apply这 3 个按钮，单击 OK按钮表示录入完成，

录入文本就显示于绘图页面中；单击 Cancel按钮取消此次录入；单击 Apply可以在对话框旁

生成编辑文本的预览效果。
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6. 1. 3 文本录入的常用编辑键

标准键盘上提供的一些常用编辑键，可以让用户在录入文本时随心所欲地控制光标。

下面提供一些常用的编辑键：

 ←键：将光标前移一个全角或半角字符。
 ↑键：将光标上移一行。
 →键：将光标后移一个全角或半角字符。
 ↓键：将光标下移一行。
 Delete 键：按一次删除其后的一个字符，并使字符后边的文字全部前移一个字符的

宽度。

 Home键：将光标移到所在的行首。

 End键：将光标移到所在的行尾。

 退格键：按一次删除光标前边的一个字符。
 Page Up键：向上翻一页。

 Page Down键：向下翻一页。

 Enter键：强行将光标移到下一行的行首。

6. 2 字符的文本格式

FreeHand 9 在对录入文本对象的编辑过程中沿用了一些专业的文字处理软件的方法。

用户可以通过对文字的字体、字号进行调整，也可以对文字的字形和间距进行编辑。

6. 2. 1 文字字体的设置

在 FreeHand 9 中支持各种常用字体，而具体字形的使用种类直接取于安装系统时的选

择。用户可以通过在系统中添加字体的方法丰富 FreeHand 9 的字体库，创造出更多、更鲜

活的文字效果。

不管是中文字体还是英文字体，通常都带有正常字体（Plain）、粗体（Blod）、斜体（Italic）

和粗斜体（Bolditalic）4 种字型信息，如图 6-5 所示。这当中也有些字体只包含 4 种字型的 2

种或 3 种。另外系统还以默认的方式确定了一种英文字体和一种中文字体。

要改变文本的字体与字型，具体操作如下：

（1）选择所需要改换字体的文字，可直接将鼠标移至该处双击，文字会醒目显示，如图

6-6 所示。

（2）通常改变字体和字型有 3 种途径，用户可以任选一种使用：

 通过 Text工具栏中的 Font下拉列表框指定字体和字型，如图 6-7 所示。
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图 6-5 一种字体的 4 种字型

图 6-6 选择文字后醒目显示

图 6-7 通过工具栏的下拉列表框改换字体

 通过 Text面板中的 Font列表框指定字体，Font style列表框指定字型。

 通过 Text菜单中的 Font命令指定字体，Font style命令指定字型。

（3）用户选择字体后，旁边还会生成字体的预览窗口。如果在 Text 选项卡中禁用 Dis-

play font preview复选框，预览功能自动取消。

（4）当用户确定了所选用的字体和字型后，单击绘图页面的空白区域，将会看到指定的

文字被改换成用户所要的字体形状了。

6. 2. 2 设置文本的字号

字号就是字体的大小，在 FreeHand 9 中字号的大小是以磅作为单位的，从最小的 8 磅

到最大的 72 磅。在文本编辑中，字号表示字符的最高晨分到字符最下伸部分的尺寸。要改

变文本的字号，同改换字体和字型一样，在 Text 工具栏、Text 面板和 Text 菜单中都能进行。
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除了直接使用下拉列表框的各种数值以外，也可以在工具栏的尺寸数字框中键入数值，

FreeHand可以接受 1 到 5000 磅的任何数值。用户采用这种方法时应注意，必须在输入完成

以后按 Enter键才能作用到选定的对象上。

6. 2. 3 字符的缩放

为了创造出更多生动的字形效果，用户可以将每个字符的高度和宽度以不同的比例进

行改变，这就是字符的缩放。在 FreeHand 9 中，只对字符的水平缩放作了规定，但并不意味

着没有字符的垂直缩放。通过水平缩放和改变字体大小，完全可以做到对字符的垂直缩放。

对字符水平缩放的具体操作如下：

（1）启动 FreeHand 9。

（2）依次单击 View→Text命令，启动 Text面板，然后选择第四个面板中的第三选项，如

图 6-8 所示其中 Horizontal scale就是用来控制字符的水平宽度的。

图 6-8 Text面板

（3）移动光标，选择想要进行缩放的字符，选中的字符会醒目显示。

（4）现在可以改变 Horizontal scale的数值了，按 Enter键确定，水平缩放的效果如图 6-9

所示。

图 6-9 使用 Text面板中的选项缩放字符
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6. 2. 4 字符的垂直间距

FreeHand 9 提供了 3 种计算行间距的方法，全都列在 Text 面板中的 Leading选项组里。

其中，Extra（用“+”表示）和 Percentage（用“%”表示）在计算间距时与所选字符的字体大小

有关。另外，Text菜单的 Leading子菜单中的 Solid命令和 Auto命令也可以调整行间距。它

们的具体作用如下：

 Extra（+）：默认的情况下，行间距等于字体大小。

 Fixed（=）：若要把一行文本的基线到另一行文本的基线距离作为行间距，选择此

项。

 Percentage（%）：用字体大小的某一比例来衡量行间距时选择此项，这个选项的默认

值是 120%。

 Solid命令：该选项可以使所有选定的字符都有一个固定的行距，其值在 Percentage

中设定。

 Auto命令：由系统自动以默认值来调整行距。

用户可以通过在选项框中输入一个值并按 Enter 键来改变行间距，行间距的单位也是

磅。调整字符行间距的具体步骤如下：

（1）使用 Text工具选定要进行调整的字符。

（2）选择 Text菜单中的 Leading命令，如图 6-10 所示。

图 6-10 Text菜单下的 Leading选项

（3）要使用固定的行间距，选择子菜单的 Solid命令；要使用自动调节，选择子菜单中的

Auto命令；想进行精确的调整，可以选择 Other命令，在打开的 Leading对话框中进行设置。

（4）要进一步精确调整字符的间距，可以启动 Text 面板，单击面板上的第一个按钮，如

图 6-11 所示。

（5）Range kerning选项用来改变字符的水平间距，用户可以直接键入数值调整，也可以
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图 6-11 Text面板中的 Character页面

以字符的百分比来计算。对于一些特殊的字符来说，可以指定特定的字符对，使它们可以比

其他字符靠的更近，称之为嵌连字对。

（6）在 Baseline shift（基线漂移）数字框中键入的数值可以设置所选字符与其基线的距

离。键入正值，与基线的距离增大，字符上移；键入负值，与基线的距离减小，字符下移。图

6-12 和图 6-13 分别是调整行间距和水平间距的 2 个示例。

图 6-12 调整字符行间距的示例

图 6-13 调整水平间距和进行基线漂移
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6. 2. 5 特殊字符的插入

插入特殊字符的功能主要是通过 Text菜单的 Special Character 子菜单中的各种命令实

现的。用户只需在文本中想要插入特殊字符的地方单击定位一个插入点，然后再应用 Spe-

cial Character子菜单中的相关命令即可。

插入特殊字符的具体步骤如下：

（1）在 FreeHand 9 的文本中插入特殊字符的位置单击，文本框会在该处出现闪烁的输

入光标提示符。

（2）单击 Text菜单中的 Special Character命令，以显示该命令的子菜单。

（3）从子菜单中选择 End of column（列尾）命令，可以在选定的位置插入列的结束标

志，并且插入点位置以后的所有字符全部被删掉。

（4）选择 End of line（行尾）命令，可以使插入点位置以后的字符另起一行。

（5）选择 Non-Breaking Space（紧排）命令，可以使插入点位置前面和后面的字符同时以

更紧密的格式排列。

（6）选择 Em Space（全角字符空格）命令，在插入点插入占一个全角字符大小的空格。

（7）选择 En Space（半角字符空格）命令，在插入点位置插入占一个半角字符大小的空

格。

（8）选择 Thin Space（1 /5 字符空格）命令，插入占 1 /5 个字符大小的空格。

（9）选择 Em Dash（破折号）命令，插入一个全角大小的破折号。

（10）选择 En Dash（连字符）命令，插入一个半角大小的破折号。

（11）选择 Discretionary Hyphen（离散的连字符）命令，插入一个连字符。

6. 2. 6 字符的大小写转换

FreeHand 9 提供了强大的字母大小写转换功能，用户可以将选定的字母全部改为大写

字母，也可以将它们全部显示为小写字母或者进行首字母大写。大小写的转换命令只是针

对录入的英文文本，对于中文字符不会产生任何效果。如果对系统的默认设置不满意，用户

还可以进一步地设置大、小写字母的大小。进行大小写转换主要是 Convert Case 子菜单中

的相关命令来实现的。使用该子菜单中的命令，可以实现以下几种字母拼写方式：

 Upper（全部大写）：将选定的字符全部转换成大写形式，但对于已经是大写形式的字

符不能够再一次改变。

 Lower（全部小写）：将选定的字符全部转换成小写形式，同样地，它不能够再将原本

小写的字符进行转换。

 Small Caps（小型大写字母）：将选定的字符转换为小型大写字母。

 Title（首字大写）：将选定的字符作为一段的开头并将首字母大写。

 Sentence（句首大写）：将选定的字符作为一句话的开头而应用首字母大写。
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使用 Convert Case子菜单中的 Settings 命令能够精确地指定要转换的字母的大小。选

择 Settings命令时，弹出图 6-14 所示的对话框。在该对话框中用户可做以下几个方面的设

置：

图 6-14 Settings对话框

 启用 Upper Case 复选框，将在 Small Caps设置数字框中指定的值应用于所有的大写

字母。

 启用 Lower Case复选框，将指定的值应用于所有的小写字母。

 启用 Small Caps复选框，将指定的值应用于所有的小型大写字母。

 启用 Title Case复选框，将指定的值应用于所有的段首字母。

 启用 Sentence Case复选框，将指定的值应用于所有的句首字母。

6. 2. 7 文本的对齐

要想对选定的文本应用不同的对齐格式，可以使用 Text工具栏上的 Align 按钮，也可以

使用 Text面板上的 Character面板中的相关选项，或者使用 Text菜单的 Align 子菜单中的命

令。在 FreeHand 9 中能够应用于文本的对齐格式主要有以下几种：左对齐（默认的对齐方

式）、右对齐、居中对齐和强制分散对齐；不同的对齐格式能够改变文本的外观形状。Free-

Hand 9 中的文本在很大程度上受到段落文本框的限制，任何一种文本对齐的格式都是以文

本框的边界为参照的。要对选定的文本应用各种对齐格式，必须首先使用 Text 工具选定要

应用对齐的部分文本或者使用 Pointer工具选定全部文本，这些对齐方式如下：

 单击 Text工具栏中的 Left（左对齐）按钮，选中的文本会以文本框的左边界为基准对

齐，如图 6-15 中左上所示。

 单击 Right（右对齐）按钮，使文本以文本框的右边界对齐，如图 6-15 中右上所示。

 单击 Center（居中对齐）按钮，所有选中的文本会以文本框的中心线位置对齐，如图

6-15 中左下所示。
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 单击 Justified（分散对齐）按钮，所有选中的文本会同时向文本框的左右边界对齐，如

图 6-15 中右下所示。

图 6-15 文本的不同对齐格式

6. 3 段落的文本格式

在 FreeHand 9 中，文本都是以文本框的形式出现的，我们把所录入文本的外形叫做文

本框，而基于文本框的文本叫做段落文本。在编辑段落文本时，用户可以应用一些专门的编

辑格式，如更改和使用文本框，创建自由形状的段落文本框，利用指示符缩进文本和多个文

本框的链接等。

能够应用于段落文本的编辑格式在 FreeHand 9 中可以通过多种方式获得：一些基本的

编辑格式是使用鼠标来完成的，另外一些则来自于 Text 面板中的相关页面。大多数用户还

是比较习惯于运用鼠标来操作。

6. 3. 1 段落文本框的种类

FreeHand 9 中的段落文本框的应用涉及了文本的所有使用方法。掌握了它就能熟练地

对段落文本进行编辑。

使用工具箱中的 Text 工具能够拖动出一个矩形的文本框。FreeHand 允许用户结合

Shift键来创建一个正方形的文本框或者使用任何一个封闭路径的图形对象作为段落文本

的文本框。段落文本框有 2 种形式。

一种是在使用 Text工具录入时的文本框，它以较浅的蓝色显示，可以通过使用 Pointer

工具双击文本来显示。严格来说，这种情况下显示的只是文本框的示意图，而不是真正的段

落文本框，因为用户不能对文本框做任何修改，但也只有在这种情况下才是文本的可编辑状

态，并显示文本标尺。
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第二种是使用 Pointer工具在文本上单击时，文本框以黑色显示，在这种情况下用户可

以使用鼠标更改文本框的大小、链接文本流，FreeHand 9 不支持在该状态下的文本编辑工

作，并且也不显示制表定位符。图 6-16 所示为段落文本框的 2 种显示方式，左图显示的是

插入状态下的文本框，右图则是使用 Pointer工具选定后的文本框。

从图中可以看到，无论是哪一种状态下的文本框，都由以下几部分组成：

 插入光标（A）：指示插入点的位置。系统默认状态下，该光标自动位于文本框的左

上角，随着用户不断地键入文本它会自动地右移，每次都移动一个字符的位置。

 制表定位标尺（B）：显示或控制制表符的位置。使用制表定位符可以在段落文本中

添加制表符。

 延展控制柄（C）：位于文本框 4 条边上的 4 个控制柄，单击并拖动可以向一个方向扩

大或者缩小文本框。

 缩放控制柄（D）：位于文本框的 4 个角上的 4 个控制柄，拖动时可以等比例地缩放

文本框。

 链接控制柄（E）：通过拖动可以控制文本框中的文本“流向”另外一个文本框。

图 6-16 段落文本框的 2 种形式

6. 3. 2 使用控制柄编辑文本

在 FreeHand 9 中使用鼠标能够方便地调整段落文本框中文本的间距。使用 Pointer 工

具在段落文本上单击选中文本块后，就会出现带有控制柄的段落文本框，只需要使用鼠标拖

动不同的控制柄就可以调整文本的间距，这种调整方法和运用 Text 面板进行字体缩放和改

变行间距有异曲同工之妙，具体操作方法如下：

 调整段落文本的水平间距：单击位于文本框两条垂直方向边上的 2 个控制柄中的一

个并拖动就可以调整文本的水平间距。当向远离中心点方向拖动时就会增大文本中各字符

间的距离；反之，当向靠近中心点方向拖动时就会减小字符之间的距离。

 改变垂直间距：拖动文本框水平方向 2 个边上的控制柄，就可以改变文本中 2 行之

间的垂直距离；同样的，如果向靠近中心点方向拖动时，将会减小行间距；反之，则会增大行

间距。
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 调整字符间距：按下 Alt键不放同时拖动 4 条边上的控制柄中的一个可以改变单词

间的距离而单词中字母的间距不变。

 改变文本框：拖动角上的控制柄可以缩放文本框的大小，而文本框中的文本的间距
保持不变。

 改变文本框和文本：按住 Alt键并拖动角控制柄可以在缩放文本框的同时缩放文本。

 等比例改变文本框和文本：按住 Shift + Alt 键同时拖动角控制柄可以在等比例缩放

文本的前提下缩放文本框。

图 6 - 17 显示了使用控制柄调整段落文本的效果。

图 6-17 使用控制柄调整段落文本的效果

6. 3. 3 创建自由形状的段落文本框

为了满足用户对文本形状的不同需要，FreeHand 9 提供了任意的文本框形状。用户可

以使用工具箱中的基本绘图工具创建任意一种具有封闭路径的基本图形对象，然后使之成

为选定段落文本的文本框。这种功能主要是通过 Flow inside path（排在路径中）命令来实现

的。要使用该命令，可以执行 Text菜单中的 Flow inside path 命令，或者单击 Text 工具栏中

的 Flow inside path按钮，以及 Text面板中的相关选项。

使用任意一个封闭路径作为文本框的操作步骤如下：

（1）在 FreeHand 9 中使用 Text工具录入一段文本。

（2）选择工具箱中绘图工具并绘制自由形状的文本框。

（3）使用 Pointer工具在绘图页面中单击并拖动出一个圈选框，同时选中文本和刚绘制

的文本框。

（4）选择 Text菜单中的 Flow inside path命令，选定的矩形文本框中的文本就会全部置

入自由形状的文本框中，并且在它的周围出现文本框控制柄，如图 6-18 左图所示。

（5）要想进一步地隐藏路径轮廓，使用 Pointer 工具选定嵌入了文本的路径对象，禁用

Object面板底部的 Display border复选框就可以不显示文本周围的文本框，而只显示按自由

文本框形状排列的文本了，如图 6-18 右图所示。

（6）若要将文本从自由形状的文本框中分离出来，先选择文本对象，然后在 Text 菜单

中选择 Remove Transforms 命令，FreeHand 9 将自行创建一个新的矩形文本框，将文本转入

其中。
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图 6-18 使用 Flow inside path命令将椭圆作为文本框

6. 3. 4 制表符的使用

当用户录入文本时，总会看到文本顶端的文本标尺。文本标尺能够指示段落文本框的

宽度，同时也允许用户为一个或者多个选中的段落设置制表位。如图 6-19 所示，制表标尺

分成三条：图标条（A）、标记条（B）和一个水平标尺（C）。图标条包括 5 个不同样式的制表

位图标，每个都可产生不同的制表位。每个制表位控制 2 个制表符之间或一个制表符和一

个回车符之间的文本。多个串组成一个栏。各个图标的作用按出现在标尺中的顺序描述如

下：

图 6-19 制标尺的结构

 左制表位（D）：所选文本串的左边界沿制表符的位置对齐。

 右制表位（E）：所选文本串的右边界沿制表符的位置对齐。

 居中制表位（F）：所选文本串的中心沿制表符的位置对齐。

 小数点制表位（G）：所选文本串数字中的小数点沿制表符的位置对齐。

 换行制表位（H）：该制表符有些特别，它总是成对出现。所选文本串的左边界总是

沿第一个换行制表位对齐，如果文本串的右边界超出第二个换行制表位，超出部分就会被自

动移动到下一行。

FreeHand 9 允许用户通过在段落文本中添加制表符来对文本框中的所有文本应用不同

的对齐方式，方法是：在 FreeHand 9 中使用工具箱中的 Text工具选中要添加制表符的文本，

根据上述制表符的作用选定要添加的制表符类型，单击图标条中的制表符图标并拖动到文

本标尺上要添加的位置上即可。

6. 3. 5 段落文本的缩进

除各种制表位图标外，制表标尺还提供了 3 种缩进标记来控制一个文本块中各行的左

右边界。设置段落文本缩进的操作步骤如下：
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（1）在 FreeHand 9 中使用工具箱中的 Text工具选定要应用缩进的文本。

（2）要使用缩进标记来设置首行缩进，使用鼠标单击并拖动首行缩进标记，这时可以独

立于其他缩进标记移动它；当向右拖动时，可以增加缩进量，向左拖动时，可以减小缩进量。

（3）单击并拖动左缩进标记，就可以设置段落中除首行外其他行文本与文本框左边界

的距离。请注意，拖动左缩进标记时，会连首行缩进标记一起拖动。

（4）要设置所选文本与文本框右边界的距离，单击并拖动右缩进标记。图 6-20 中左图

应用了首行缩进，中图应用了左缩进，右图应用了右缩进。

图 6-20 制标尺的缩进功能

FreeHand 9 中为用户提供的另外一种设置段落文本缩进的方法是：使用 Text 面板中单

击第二个按钮所打开的 Text Paragraph面板，如图 6-21 所示。使用该面板上的 Indents选项

组能够精确地设置段落文本的缩进属性，它使用了 3 个数字框来设置缩进：

图 6-21 Text Paragraph面板

 Left（左缩进）：在该数字框中键入需要的左缩进值，该数值是从文本块左边界开始算

起的。

 Right（右缩进）：键入的数值以设置段落文本的右缩进量。该数值是从文本框的右

边界开始算起的。

 First（首行缩进）：键入数值从左缩进标记的位置开始算起，而不是从文本框的左边

界算起。所以，如果首行缩进标记在左缩进标记右边，First 数字框中的值就是正的；如果首

缩进标记在左缩进标记左边，First数字框中的值就是负的。
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用户必须注意，使用该面板设置缩进时，可以不考虑段落文本的文本标尺。所以，即使

使用 Pointer工具选择文本也能够应用缩进。

6. 3. 6 多个文本框的链接

说到 FreeHand 9 的段落文本框，用户会发现：一方面，段落文本框赋予了文本以丰富奇

特的外部形状；另一方面，文本框也大大限制了文本的功能，特别是在处理一些大型的文本

块时更是这样。一旦用户录入或者导入的文本太长，而预先拖出的文本框又不够用时，超出

的文本就会被“抹掉”。为了解决这一问题，FreeHand 9 提供了文本链接功能，它使得所有

的文本可以连成一个整体。

用户也许会注意到，当某个文本框中的文本超出它所能够容纳的范围时，文本框底部的

链接控制柄里会出现一个黑色的小圆圈，这是 FreeHand 9 在提醒用户：文本框太小了，已经

有许多文本被“隐藏”起来了。

用户可以使用 2 种方法来显示超出文本框的文本：

（1）放大文本框：使用这种方法的前提是用户所拖出的文本框必须是一个标准的文本

框，因为 FreeHand只能将矩形或者正方形的文本框放大，而不能放大其他形状的文本框。

使用鼠标向外拖动文本框周围 4 个角控制柄中的一个就可以扩大文本框而不改变文本框中

原来文本的大小。

（2）创建文本流：将原来文本框中的文本通过链接的方式链接到一个新的文本框中去，

这样看起来好像是文本从第一个文本框流向了第二个文本框一样。要创建文本的流动，必

须首先为超出的文本创建一个新的文本框。

创建文本流的操作方法如下：

（1）使用 Pointer工具单击要链接到其他文本框中的文本，FreeHand在屏幕上显示该文

本框的边角控制柄，右下角的方形中带有小黑色圆圈的就是链接控制柄。

（2）使用 Text工具单击或拖动文本创建一个新的文本框，或者使用绘图工具创建一个

新的闭合路径作为第二个文本框。

（3）单击第一个文本框底部的链接控制柄并拖动到新的文本框中，在拖动的过程中会

显示一条用以指示方向的曲线，如图 6-22 所示。

（4）完成链接后，源文本框的链接控制柄中黑色圆圈被一双向箭头取代了，超出的文本

自动地流入新文本框中。

在链接 2 个文本框时，最好将视图模式切换为文本录入状态，即有标尺显示在文本框

上，且文本框为浅蓝色，这样可以看见文本框的轮廓线。而在预览模式下，系统默认状态下

所有未被选中的文本框都没有轮廓线。此外，链接到的目标文本框可以是一个新建的空文

本框，也可以是已经装有文本的文本框，在这种情况下，系统会将原来的文本挤到后面，腾出

位置给新插入的文本，插入的文本会和原来的文本融合成一段文本。

使用上述方法，用户还可以进一步地将多个文本框链接到一起来控制文本的流动。图

6-23 显示了 4 个文本框链接在一起的样子，每个文本框中的文本都是首尾相接的。
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图 6-22 链接两个文本框创建流动的文本

图 6-23 多个文本框的链接

6. 3. 7 链接文本框的修改

文本框一旦链接成功，各个文本框内的文本就是一个整体，链接后的文本框中的文本在

使用时会受到一些限制。用户可以自由地添加或者删除目标文本框中的内容而不会改变源

文本框；当改变源文本框中的文本内容时，直接影响着目标文本框。具体地说，在链接后的

文本流中作修改包括以下几方面：

 删除文本框：在文本流中删除一个文本框不会影响文本的内容。文本会跨过被删除
的文本框流动到下一个文本框中去。

 缩小源文本框的尺寸：如果用户拖动源文本框的角控制柄减小文本框的尺寸，文本
将被挤出去，流入链接到的下一个文本框中去。

 增大源文本框的尺寸：如果用户增大源文本框的尺寸，文本将从链接中的目标文本
框中“倒流”回来，填入源文本框中。这样做有可能使得链中的最后一个文本框中的所有内

容被吸空。然而，FreeHand 9 并不删除空的文本框，也不会将其从链中移走，必须用手工来

完成。
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 改变链接中文本的字体：要更改链接后的各文本框中文本的字体，使用 Pointer 工具

选定要更改字体的文本所在的文本框，或者使用 Text 工具选定文本中的字符，然后选择一

种字体即可。链接后的各文本框的字体属性是相对独立的，无论改变哪一个文本框中的字

体，都不会影响到其他的文本框。要想调整所有文本必须使用 Pointer工具选中所有的文本

框。

 改变文本字号：在系统默认状态下，改变文本框中文本的字号会改变文本占用的空
间和字符间的距离。所以在一个文本链中，改变任何一个文本框中的字号都会同时对下一

级链接文本框中的文本的位置产生影响。当增大字号时，源文本框中的文本会有一部分流

入下一级文本框；而减小字号时，文本则会向上一级链接文本框中流动。

 调整间距：和改变字号一样，调整链接中某一文本框中的文本的间距都会影响到下
一级文本框，但对上一级文本框不会产生任何影响。

 调整对齐方式：调整对齐方式只对选定的文本框中的文本产生影响而不会影响到上
一级文本框。

 更改文本的流动方向：要更改文本的流动方向，使用 Pointer 工具单击源文本框底部

的链接控制柄并拖动到要流向的文本框即可。如果用户拖动的位置没有文本框，则源文本

框及其中的文本不会发生任何改变。在一个文本流中有多个链接文本框的情况下，更改文

本的流向会在很大程度上改变文本的外观。例如，一个文本流中链接了 A、B、C、D 4 个文本

框，链接顺序也按字母顺序依次排列，如图 6-24 左图所示。如果要将 A文本框改为链接到

文本框 D，则 B和 C 两个文本框都会成为空文本框，A中超出的文本会直接流到 D中，但文

本框 B、C依然存在，如图 6-24 右图所示。

图 6-24 通过改变链接的方向改变文本流的方向

 断开链接状态的文本框：使用 Pointer工具选择要断开链接的文本框，单击链接控制

柄并拖动到绘图页面中的空白区域中的任一位置上放下鼠标键即可。例如，在图 6-24 所示

的 4 个文本框所组成的文本流中，要想从 B框开始断开链接，就可以拖动该文本框底部的

链接控制柄到页面空白处，松开鼠标键时，B框后面的 C、D2 个文本框会变成空的文本框，

而 B的链接控制柄中会显示为有超出部分的黑色小圆圈。
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第七章

文本的特殊效果

作为专业的图形设计软件，FreeHand 9 提供了大量的文字和段

落的高级编辑技巧，它能够把文本、路径和图形有机的结合起来，运

用图文混排效果生成美观大方的图案。另外，FreeHand 9 还提供了

将文本转换成图形对象的功能，这样创造出来的文字图形有着独特

的艺术效果。总之 FreeHand 9 提供了丰富的图文编辑功能，使普通

用户创造出专业水平的图像设计的梦想得以实现。

本章中的主要内容包括：

 字符特效；
 段落文本特效；
 捆绑路径特效；
 图文混排特效。

7. 1 字符特效

在 FreeHand 9 中，字符的特效主要包括高亮效果（Highlight）、阴

影效果（Shadow）、嵌入效果（Inline）、投影效果（Zoom）、下划线（Un-

derline）和删除线（Strikethrough）6 种，通过对字符做这些特效处理，

能够使录入的文字更具艺术效果。

7. 1. 1 高亮效果

高亮效果是一种经常使用的字符特效。在默认状态下，Free-

Hand 9 能够将选定的文本用彩色矩形区域包围起来，在一些大型的

段落文本中用于突出显示一些需要特别强调或者比较重要的部分。

选择 TextEffectHighlight命令，将打开如图 7-1 所示的 High-

light Effect对话框。
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图 7-1 Highlight Effect对话框以及应用效果

该对话框可以设置以下选项：

 Position（位置）：用于设置高亮显示区域相对于基线的位置。当输入正值时，可以将

高亮的矩形区域移动到文本基线以上；输入负值时，移动到基线以下。

 Dash（线条形状）：可以从选项中为高亮的矩形区域选择一种线形。

 Stroke Width（边框宽度）：用于设置矩形区域的边框的宽度。在默认时宽度为文本

中字符的大小，用户也可以直接键入一个数值来设置边框的宽度。

 Stroke Color（边框颜色）：用于打开系统的颜色列表，从中可以选择高亮显示的颜色。

 Overprint（叠印）：选择该复选框打开叠印高亮效果。

7. 1. 2 阴影效果

Effect 菜单中的 Shadow命令能够为选定的文本添加阴影效果。要想为选定文本添加阴

影效果，可以通过以下途径：

 依次单击 Text→Effect→Shadow命令。

 从 Text面板中选择 Shadow命令。

文本的阴影效果在系统默认时就能够显示，但如果在 Preferences面板中不启用 Redraw

选项卡的 Display text effect复选框，如图 7-2 所示，用户就不会看到阴影效果。Shadow命令

执行后，添加到文本上的阴影会自动地稍低于文本位置放置。虽然在 FreeHand 9 中仍然不

提供对文本添加阴影的精确控制功能，使用户不能够像在其他绘图软件中一样来改变阴影

的强度、阴影颜色、阴影方向，但它在以后所提供的投影效果足以满足用户的字形美化的需

要，它所创造的阴影效果更具观赏性，如图 7-3 所示。

7. 1. 3 嵌入效果

Inline 命令能够将选定的文本生成加边框的雕刻图的效果，这种效果类似于 Corel-

DRAW中的轮廓图效果。它能够根据指定的步长值以及其他的设置从文本的外围描绘轮

廓，从而产生一种特殊的视觉效果。

为文本添加嵌入效果，要首先选中要添加嵌入效果的文本。依次单击 Text→Effect→In-
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line，系统会弹出 Inline Effect 对话框，如图 7-4 所示。该对话框主要提供了以下几个设置选

项：

图 7-2 为 Preference对话框中的 Display Text Effect选项

图 7-3 为文本添加阴影效果

 Count（步数）：设置轮廓线的圈数。圈数越多，嵌入的效果越明显，同时系统的处理

速度也越慢。

 Stroke Width（笔划宽度）：用于设置轮廓圈的线宽。

 Stroke Color（笔划颜色）：用于打开颜色列表，从中为轮廓线选择一种颜色。

 Background Width（背景宽度）：设置最外圈的轮廓线的线宽。

 Background Color（背景色）：用于打开颜色列表，从中为嵌入的字符选择一种背景颜

色。用户应避免选择的颜色与笔划颜色相同，因为这样会使嵌入效果和原来的文字混成一

片，而无法分辨。
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图 7-4 对文本添加嵌入效果

7. 1. 4 投影效果

FreeHand 9 中的 Zoom命令能够产生文本的立体化效果，这种立体化效果主要是通过 2

种颜色的渐变来实现的，它和阴影效果有一定的相似之处，只是功能上更加全面一些。用户

可以通过 Zoom Effect对话框对立体化的深度和方向加以改变。

使用 Zoom命令为文本添加立体化效果的具体操作如下：

（1）首先选定要添加投影效果的文本。

（2）依次单击 Text→ Effect →Zoom命令，打开 Zoom Effect对话框，如图 7-5 右图所示。

Zoom Effect对话框提供了以下的选项：

图 7-5 对文本添加投影效果

 Zoom To（放大到）：用来设置渐变终止位置文本的大小与原来文本的百分比。

 Offset（渐变方向）：该选项为渐变效果设置了一个坐标，它包括 2 个数字框。x框用

以指定渐变终止位置的横坐标，y框指定纵坐标。同时改变 2 个数字框中的数值可以改变

立体化阴影的方向。

 From（“从”颜色挑选器）：用于打开颜色列表，从中为渐变选择一种起始颜色。

 To（“到”颜色挑选器）：用于打开颜色列表，从中为渐变选择一种终止颜色。

（3）完成设置后，单击 OK按钮即可，生成的效果如图 7-5 左图所示。
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7. 1. 5 下划线效果

Effect菜单中的 Underline 命令的作用很单一，就是为选定的文本添加下划线。通过

Underline Effect对话框，用户可以对下划线进行精确的设置。

为文本添加下划线的具体操作如下：

（1）首先选定要添加下划线的文本。

（2）依次单击 Text→ Effect →Underline命令，打开 Underline Effect对话框，如图 7-6 右

图所示。Underline Effect对话框提供了以下的选项：

 Position（位置）：用于设置下划线与文本之间的距离。键入值为 0 时，下划线与文本

的基线相重合；键入的值为正时，下划线上移；键入的值为负时，下划线下移。

 Dash（线条形状）：用于设置下划线的线条形状。

 Stroke Width（线条宽度）：用于设置划线线条的宽度。

 Stroke Color（线条颜色）：用于设置划线线条的颜色。

 Overprint（叠印）：选择该选项时，以显示叠印轮廓。

（3）完成设置后，单击 OK按钮，所做的设置将应用于选定的文本上，如图 7-6左图所示。

图 7-6 对文本添加下划线效果

7. 1. 6 删除线效果

Strikethrough命令能够横穿文本的正中心加上一条删除线，在系统默认设置下，该删除

线和文本的基线是相重合的。通过 Strikethrough Effect 对话框，用户可以改变删除线的位

置、线条粗细、线条颜色等属性。

为文本添加删除线的具体操作如下：

（1）首先选定要添加下划线的文本。

（2）依次单击 Text→ Effect →Strikethrough命令，打开 Strikethrough Effect 对话框，如图

7-7 所示。Strikethrough Effect对话框中可以设置删除线的以下属性：

 Position（删除线的位置）：在该数字框中键入数字以设置删除线与文本基线的距离。

当键入 0 时，与文本的基线相重合；键入正值，删除线上移，键入负值，删除线下移。

 Dash（线条形状）：该列表框提供了一些可以用于删除线的线条形状。
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 Stroke Width（线条宽度）：用于设置删除线的宽度。键入的值越大，删除线越粗；反

之则线条越细。

 Stroke Color（线条颜色）：用于打开颜色列表，用户可以从中为删除线选定一种颜色。

 Overprint（叠印）：启用该选项可以显示叠印轮廓。

（3）在该对话框中设置完成后，单击 OK按钮就可以将设置应用于选定的文本上。图

7-7左图显示了在文本中添加不同属性删除线的效果。

图 7-7 为文本添加删除线效果

用户在使用字符特效时应注意，当对文本添加的特殊效果太多时，系统内存会被过多占

用，系统的处理速度和屏幕的刷新速度就会变慢。用户可以使用 Effect菜单中的 None 命令

或者从 Text面板的 Effect弹出式菜单中选择 No Effect 命令来撤消添加到文本上的特殊效

果，撤消特效后的文本会保留原来的格式编排。

7. 2 段落文本的特效编辑

为了使段落文本的编排更适合图形的形状，更加美观，用户可以对段落文本进行分栏和

分节处理，这样就把一个文本框的内容分成了几个部分，这时又涉及到段落内文本的编排工

作。在 FreeHand 9 中使用平衡栏和拷贝适应来完成此项任务。

7. 2. 1 段落文本的分栏和分节

为选定的段落文本分栏或分节是 FreeHand 9 中一个非常有用的段落编辑手段。它的

操作只适用于一个文本块的整体，用户不能够只对某一个文本块中的几行或者一段进行分

栏或者分节。对段落文本进行分栏、分节主要是通过 Text面板的 Text Columns and Rows 面

板中的一些选项来实现的，如图 7-8 所示。

Text Columns and Rows 面板主要提供了对分栏、分节和换行次序的以下设置：

 Column（栏数）：主要用来设置分栏数。用户可以在这个数字框中键入想创建的栏

数，栏的数值可以在 1 ～ 100 之间。

 Height（高度）：主要用来设置栏的高度。这一选项只在编辑标准文本块时才生效。
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图 7-8 Columns and Rows面板

如果有一个或多个自由形状的文本对象被选中，该项是无效的。

 Spacing（间距）：用于设置栏与栏之间的距离值。

 Rules（标线）：用户可以选择 2 种标线来分离栏或节，也可以选择 Full height（整个文

本块高）或者 Full width（整个文本块宽），保证标线贯通全部文本块的高度或者宽度。

 Rows（节数）：设置需要的小节数。

 Width（节宽）：设置各节的宽度。

 Rows Spacing（节间距）：设置各节之间的间距。

 Flow（文字流方向）：用户可以选择分节文本的竖向分布和横向分布。就是说，将以

前的文本内容按由左到右的顺序分布在各个栏中，或者将以前的文本内容按由上到下的顺

序分布在各个栏中。

在 FreeHand 9 中，完成设置后系统会自动按照输入的数值改变对所选文本块进行分栏

和分节的设置。图 7-9 显示了分栏和分节后的效果，中图为原始段落文本，左图为分栏后的

效果，右图为分节后的效果，文字流都采用了由上到下的方式。

图 7-9 段落文本的分栏和分节

7. 2. 2 添加段落标线

段落标线在 FreeHand 9 中是用来分隔文本中一个个小节的特殊辅助线。用户既可以
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为选定的段落文本添加水平方向的标线，也可以添加垂直方向的标线；既可以添加一条贯穿

全部文本高度的标线，也可以添加一条贯穿文本宽度的标线。

为段落文本添加标线的操作步骤如下：

（1）首先选择要添加标线的段落。

（2）启动 Text 面板，单击面板中的第 4 个按钮，打开 Columns and Rows面板。

（3）在该面板中，从上边的 Rules下拉列表框中选择一个选项，该选项主要用来为文本

添加垂直方向的标线，它提供了以下几种选择：

 None：该选项可以不对选定的文本添加标线，也可以使用它来移除已添加的标线。

 Inset：该选项可以为文本添加高度与各小节高度相同的垂直方向的标线。

 Full height：该选项可以为文本添加一条贯穿整个文本高度的标线。

（4）使用下边的 Rules列表框中的选项可以为文本添加不同性质的水平方向的标线：

 None：不添加或者移除已添加的标线。

 Inset：该选项可以为文本添加长度与各小节宽度相同的垂直方向的标线。

 Full width：该选项可以为文本添加一条贯穿整个文本宽度的横向的标线。

（5）设置完成后，就可以为选定的段落文本添加标线了。但是，当用户使用的是 Pre-

view（预览）模式时，标线是看不到的。图 7-10 显示了添加了水平和垂直方向标线的段落文

本。

图 7-10 为文本添加标线

7. 2. 3 平衡栏的使用

用户可能在使用完分栏和分节命令后，会觉得所得到的效果并不如想像的那样美好，通

常会出现文本在各栏中分布不均衡的情况：左边栏分布的文本太多，充满了整个栏高；右边

栏的文本却太少了，只占用了很少一部分栏高。为此，FreeHand 9 提供了 Adjust Columns和

Copyfit命令，来解决所分各栏中文本分布不均衡的问题，它们能够将选定文本框中的文本

均衡地分布到各栏中，或者将各栏中的文本自动放大或者缩小以适应栏的宽度和高度。

平衡栏和拷贝适应的设置面板可以通过单击 Text 面板中最右边一个按钮来激活，如图
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7-11 所示。该面板中的 Adjust columns选项组提供了 2 个用来设置文本分栏后的效果的选

项：Balance（平衡栏）和 Modify Leading（调整间距）。它们的主要作用是用来调节多栏文本

块中的字体长度和栏宽，用户一次只能对各栏或节中的一个文本块使用这些选项。

图 7-11 Balance and Copyfit面板

使用 Text面板创建平衡栏的具体操作如下：

（1）首先选定已分栏的段落文本。

（2）启动 Text面板，并单击最右边的按钮，启动 Balance and Copyfit面板。

（3）在该面板中启用 Balance复选框，FreeHand 9 会自动地使选定的文本框中的多栏文

本的每一栏所包含的行数相等。

（4）Modify leading选项可以进一步调整各栏中文本的行间距，同时可以使 Threshold数

字框也处于可用状态。在该框中键入数字，就可以调整文本的行间距，以使文本确切地适应

栏的高度。在默认情况下，系统对填入文本不满 50%的栏不作调整，但是如果用户输入一

个较小的值，系统连很短的栏也会进行调整。

（5）要将所有的文本行平分在各栏中，并使每一栏中的文本行都填满整栏，可以同时选

择 Balance和 Modify leading这 2 个选项。图 7-12 显示了 Balance 命令使用前后的不同效

果：左图中的文本只启用了 Balance选项；中图是同时启用了 Balance 和 Modify Leading 2 个

选项之后的各栏效果；右图是在 Threshold框中键入较小的值后对栏中文本的影响效果。

图 7-12 使各栏中的文本平衡
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7. 2. 4 使用拷贝适应

在设置完文本的分栏和分节后，如果用户再进行缩放或者延展时，其中的文本部分有时

会显得很难看，这时我们可以运用 Balance and Copyfit 面板中的 Copyfit（拷贝适应）选项来

解决这个问题。它能够自动调整选定文本的字体大小和行间距的值，以使文本框中的文本

能够更好地适应文本框的大小。拷贝适应这个名词听起来很专业，但它的使用却是非常简

单的。

Copyfit选项组中提供了以下 2 个数字框：

 Min（最小值）：它代表 FreeHand 9 中能够放大文本的最小百分比。如果文本太大，

以至无法塞入一个文本块中，可减小 Min值。

 Max（最大值）：它代表 FreeHand 9 中能够放大文本的最大百分比。如果字体太小，

无法装配在文本块中，可增大 Max的值。

图 7-13 显示了调整最大值和最小值的过程：左图是调整之前的文本，它们已经应用了

Balance命令，但在扩大文本框后，各栏都位于文本框的上部；中图是进行的第一次调整，保

持 Copyfit选项组中的 Min框中的数值仍为 100，加大 Max框中的值为 200；右图是进行的第

二次调整，保持 Max框中的值不变，将 Min框中的数值改为 200。

图 7-13 使文本适合文本框大小

7. 2. 5 文本首行设置

用户也许会注意到，在 FreeHand 9 中使用普通方法只是设置每行文本与上一行文本之

间的行距，但是第一行文字的位置是无法设置的，First line leading（首行文本间距）命令就是

用来弥补这个缺陷的。该选项用来设置选定文本的第一行与文本框顶部的距离，也就是第
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一行文字在文本框中的垂直位置。该选项包括两个设置项：行距方式列表框和行距设置数

字框。在左边的数字框中键入的值就是从文本框的顶部到首行文本的基线的距离；用户也

可以在选项框中输入一个值并在弹出菜单中选择 +、=、% 中的一项，这 3 个选项的使用方

法和文本工具栏中 Leading选项的使用方法相同。

图 7-14 显示了进行首行调整的不同效果，左图显示未调整前系统默认的首行位置；右

图则是在 First Leading框中选择“+”，并在左侧的数字框中键入 100 后得到的调整效果。

图 7-14 设置文本的首行位置

7. 3 文本捆绑在路径上的特殊效果

不规则路径上文本效果的原理就是应用了将文本捆绑到路径的技术，这是一个非常有

用的文本处理方法。在 FreeHand 9 中，通过创建、修改路径和对路径上文本的修饰，就能创

造出文字效果来。能够嵌合文本的路径对象有很多种：它可以是一条直线或者曲线，也可以

是任意一个几何形状；既可以是一个开放的路径，也可以是任意一个封闭路径的对象。

7. 3. 1 创建路径上的文本

我们通常使用下面 2 种方法创建路径上的文本：直接在选定的路径上创建文本，使文本

沿着路径跑。将现有的文本嵌合到某条路径上，直接完成文本和路径的结合。

首先，介绍直接在路径上创建文本的方法，执行在路径对象上直接录入文本的功能主要

是通过 Attach to path命令来实现的，要使用该命令，用户可以通过 Text 菜单，也可以使用

Text 工具栏中的 Attach to path按钮，如图 7-15 所示。具体操作如下：

（1）使用基本绘图工具在绘图页面中绘制一条路径并选中它。

（2）选择 Text菜单中的 Attach to path命令或者单击 Text工具栏上的 Attach to Path 按

钮。

（3）被选中的路径显示为蓝色，并且在路径的起始位置显示了一个小三角形的插入标

记，路径的末端出现链接控制柄。

（4）录入需要的文本，文本会自动地沿路径延伸。
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图 7-15 使键入的文本自动沿路径放置

接下来介绍将现有的文本嵌合到某条路径上的方法。与直接在路径上键入文本的方法

不同的是，现有的文本必须是在标准文本框中的文本，而嵌合到的路径对象也有一定的限

制。要将现有的文本捆绑到路径对象上，必须首先进行两个方面的准备工作：

 准备文本：可以使用 Text工具键入需要捆绑到路径上的文本。用户必须注意，该文

本必须具有一个标准的文本框，如矩形、正方形等，而不能使用自由形状的文本框。

 准备路径：可以用绘图工具绘制的一条线或者是一些基本的几何形状。如果选择的
路径是椭圆或者矩形，就必须先使用 Ungroup命令将它们的组合取消；如果选择的路径是文

本对象，必须将它们转换成路径。

文本和路径准备好后，使用 Doinrer 工具同时选中文本与路径，使用 Text 菜单中的 At-

tach to path命令或者单击 Text工具栏中的 Attach to path按钮，就可以将该文本捆绑到选定

的路径上了，如图 7-16 所示。

图 7-16 将现有的文本捆绑到路径上

捆绑到路径上的文本的属性并没有改变，同样可以用处理规则路径上的文本方法来处

理它。例如，可以将它和其他文本框进行链接等。用户也许注意到，嵌合了文本的路径其实

包含了一个文本框，也有自己的链接控制柄等，所以当文本较多而路径太短时，链接框是开

放的，使用 Pointer工具单击并拖动到另外一个路径上，就会创建一个链接在一起的文本流，

这和多个文本框的链接方式是一样的。

7. 3. 2 修改捆绑文本的路径

用户在实际操作中，经常会出现由于路径不够长或者文本太多的原因，无法在路径上放
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进所有的文本，超出的文本会使链接框中出现黑圈，而以前的文本块在标准的文本框中可以

显示成若干行。对于这种情况可以应用以下几种处理方法来解决：

 缩短字体的大小或将它们紧缩。
 将路径链接到一个文本框中。
 通过增加控制点和延伸线段来修改路径直到所有文本全部出现。具体可以使用

Pointer工具拖动控制点和贝塞尔控制柄，每次拖动后，系统重新将文本放置在新路径上。

修改捆绑了文本的路径的具体操作步骤如下：

（1）创建一个捆绑文本的路径。

（2）选中要修改的路径，然后单击路径最右边的端点选中它。

（3）拖动右端点使该路径向一方延长，超出的文本就会显示在路径上，继续拖动直到全

部文本都显示到路径上为止，如图 7-17 所示。

图 7-17 延长路径可以同时延长路径上的文本

（4）要想继续调整路径上点的属性以改变路径的外形，单击工具栏中的 Undo按钮恢复

到未修改以前的路径。按住 Alt键使用 Pointer工具在该路径上单击，就会只选择该路径而

不会选择文本。

（5）选择路径上要更改的点并启用图 7-18 右图所示的 Path 面板。在该面板中选择 3

个 Point type按钮中的一个可以将选定的点转换为不同属性的点，这 3 个按钮从左到右依次

是：曲线点、角点和内部点。图 7-18 左图显示为系统默认状态下选定点为曲线点时文本与

路径的嵌合状况；当改变该点为角点时，路径与文本则会显示为图 7-19 左图所示的形状。

图 7-18 改变路径上的点为曲线点时文本也会随着改变

（6）拖动路径上该点的贝塞尔控制柄以改变路径的形状，文本也会随着路径的改变而

改变。
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图 7-19 文本会在角点位置发生一个大的转折

7. 3. 3 修改捆绑在路径上的文本

文本基线或许对用户来说还是一个新名词。其实，当文本捆绑到路径上时，文本和文本

基线就密不可分了。细心的用户会发现，字符上有一些随着路径方向延伸的虚线，那就是文

本基线。字符除了基线以外，还有上伸线和下伸线，它表示最高字符的顶部和最低字符的底

部。当用户将文本捆绑到路径后，这些上伸线和下伸线和基线一样也随路径弯曲。用户可

以选择垂直对齐来改变文本在路径中的方式，它通过上伸部分代替基线将文本捆绑到路径

中。

如果同时选择了嵌合了文本的路径以及路径上的文本，就可以通过 Text on a path 上的

Text alignment选项组中的 Top和 Bottom列表框设置，如图 7-20 所示。Top列表中的选项分

别是：

图 7-20 Text on a path面板

 None（无）：取消路径上部或下部的文本。
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 Baseline（基线对齐）：此时文字的排列与基线对齐。

 Ascent（基线升高）：此时文字的排列与字符的最顶部对齐。

 Descent（基线下降）：此时文字的排列与字符的最底部对齐。

Bottom列表框中的内容只能应用于椭圆上的文本，后面将进行介绍。

Orientation选项组提供了文本在路径上旋转时垂直位置的 4 种不同方式，这 4 种不同的

选项分别是：

 Rotate around path（顺着路径转动）：每个字符的基线是路径上该点的切线。也就是

说，字符随着路径的扭曲和转向而倾斜，如图 7-21 中左上图所示。该项是默认值，也是最清

晰自然、最常用的选项。

 Vertical（垂直）：尽管基线随路径而弯曲，但字符始终保持水平，就像标准文本块中

的文本一样，如图 7-21 中右上图所示。当用户选择这个选项时，字符经常重叠在一起，效果

不是很好。

 Skew horizontally（水平倾斜）：字符随着路径的倾斜而倾斜。虽然该项的名字暗含着

文本只能沿水平倾斜，但实际上既有水平方向的倾斜也有垂直方向的倾斜，如图 7-21 中左

下图所示。

 Skew vertically（垂直倾斜）：仅在垂直方向上发生字符倾斜，这个选项对创建三维效

果很有用，如图 7-21 中右下图所示。每个字符仍然保持起立状态，保证重叠部分最小。

图 7-21 文本字符在路径上的不同方向

7. 3. 4 修饰椭圆上的文本

椭圆和圆的许多性质在图形处理当中有着特殊性，所以 FreeHand 9 把它当作另一类路

径对象来对待，用一种组合路径的方法来处理它。因此，当在它上边放置文本时，FreeHand

处理的方法和其他路径也略有不同，它可以将文本分为上下 2 行排列。和在其他路径上捆

绑文本的实现方法不同，椭圆由于其路径的特殊性，操作起来稍微复杂些。

要在椭圆上捆绑和修饰文本，可以按以下步骤实现：

（1）在 FreeHand 9 中录入文本。

（2）使用 Ellipse工具绘制一个椭圆或者圆。

（3）按住 Shift键并使用 Pointer工具分别单击椭圆和文本，使它们同时选中。

（4）选择 Text 菜单中的 Attach to path 命令，文本会自动地绕椭圆排列，超出部分的文
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本显示不出来，并在椭圆的底部出现一个有小黑圈的链接控制柄，如图 7-22 所示。

图 7-22 在椭圆上捆绑文本

（5）要将文本分布在椭圆的顶部和底部两行显示，可以移动鼠标光标到文本中要分开

的位置单击，然后按下 Enter键即可。按 Enter键之前的字符被放在椭圆的上方，Enter 键之

后的文本被挂在下面，如图 7-23 所示。

图 7-23 椭圆上的文本分两行显示

（6）用户可以单独对椭圆上下两部分文本进行编辑处理。具体方法是启用 Text on a

path面板，如图 7-24 左图所示。在该面板中打开 Top（上部文本）和 Bottom（下部文本）下拉

列表框，从中选择不同的选项可以分别设置上下 2 行文本的垂直对齐方式。在 FreeHand 9

中，椭圆上下两部分文本的对齐方式都是以椭圆的中心点位置为参照的。

（7）要进一步调整文本的对齐方式，可以使用 Inset选项组中提供的 2 个数字框来调整

上下两部分文本在椭圆上的位置：Left 和 Right 主要指示了文本相对于原来位置的旋转角

度。用户可以直接在 2 个数字框中键入想要设置的角度，或者拖动嵌合了文本的椭圆上的

调整柄（图 7-25 所示）来沿圆周拖动进行调整。用户在进行各项调整时只需直接改换选项，

不必像以前版本那样必须按 Enter键确认。
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图 7-24 设置文本的垂直对齐方式

图 7-25 调整文本在圆周上的位置

7. 4 图文混排特效

图文混排技术是现今比较流行的一种编排方式，许多图文处理软件都支持图文混编，

FreeHand 也不例外。在 FreeHand 9 中，用户可以很方便地创建一些特殊的图文混排效果来

满足图像设计的需要。该功能主要是通过 Run Around Selection 命令来实现的，用户还可以

进一步地设置图形与文本之间的环绕距离等性质。

7. 4. 1 Run Around Selection 命令的使用

在 FreeHand 9 中，Run Around Selection 命令主要用来实现在文本框内部插入一个图形

对象，并使该文本框中的所有文本围绕着图形对象的轮廓线的边缘进行排列，而不会侵入图

形内部的要求。FreeHand 9 也支持在图形内部置入文本，它的实质就是我们以前讨论过的
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改变原文本框的外形，使用任意形状的文本框来修饰文本。

用户必须注意，无论是在图形外环绕文本还是在图形内部放置文本时，都必须遵守一个

共同的规则：所使用的图形对象都必须是一个封闭路径的单一对象。

在图形内和图形周围环绕文本的操作步骤如下：

（1）使用 Text工具录入一个段落文本。

（2）使用基本绘图工具绘制一个封闭路径的几何形状。

（3）使用 Pointer工具在图形对象上单击并拖动到文本框中想要放置的位置。

（4）选择 Text菜单中的 Run around Selection命令，打开的 Run Around Selection对话框

如图 7-26 所示。该对话框中提供了图形在文本中的两种放置方式：单击左边的按钮，不设

置文本环绕图形；单击右边的按钮，则可以使用一些选项设置将文本环绕在图形周围。

图 7-26 Run Around Selection对话框的两种显示方式

（5）在右边的对话框中为图形与文本的环绕方式提供了以下几个选项：

 Left（左方）：设置图形左边与文本之间的距离。

 Right（右方）：设置图形右边与文本之间的距离。

 Top（上方）：设置图形顶端与文本之间的距离。

 Bottom（下方）：设置图形底端与文本之间的距离。

（6）完成设置后，单击 OK按钮即可，如图 7-27 所示。

图 7-27 在图形外环绕文本
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7. 4. 2 图文混排中的对齐和间距

虽然 Run Around Selection 命令用起来很方便，但要制作出赏心悦目的效果来就不那么

容易了。以下是一些常用的技巧。

 使文本两边对齐：保证图形对象两边的文本与图形对象的距离相等。如果用户将文
本左对齐，FreeHand通常会让文本到图形左边的距离大些。用户可以在 Left数值框中输入

一个负值来进行修正，但有时这样会导致文本加在图形的上面。

 升高 Ragged Width（参差高度）值：如果用户非要将文本左对齐不可，就应改变 Text

Character面板对应的 Edit Alignment对话框中 Ragged width选项的值，将其值增大到 90%左

右，这样会使文本显得松散一些，避免出现太大的间距，如图 7-28 所示。

图 7-28 Edit Alignment对话框

 增加字符间距：FreeHand的默认字符间距和单词间距会使单词之间存在较大的空

隙，如果用户把 Spacing Text面板的 Letter栏中的 Max值增加到大约 150%，效果会好一些，

如图 7-29 所示。

图 7-29 Spacing Text面板
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7. 4. 3 把文本转换成路径

如果用户想创建一些标志或者其他特殊的字符轮廓线，那么需要了解 Text 菜单中的

Convert to path命令。该命令最主要的功能就是把选定的文本转换为可编辑的路径，它可以

把所有能够在 FreeHand 9 中出现的字符转换为自由形状的路径，使用这种方法用户能够得

到形状丰富的路径对象，从而为绘图添色。

将文本转换成路径的具体操作如下：

（1）选定要转换成路径的文本。

（2）选择 Text菜单中的 Convert to path命令。

（3）当用户需要修改复合路径时，首先要使用 Pointer工具并按下 Alt键来选定该路径，

这时 4 个角控制点会出现，并出现路径中的点和线段。此时就可以像处理标准路径一样编

辑这些点了。图 7-30 显示文本转换为路径并进行了简单编辑的效果。

图 7-30 将文本转换为路径后的效果

用户需要注意的是，当将某一段文本转换成路径后，就不能再对它们应用一些字符级编

辑格式了，例如不能够再改变它们的字体、字形、间距等，所以在选择转换为路径命令前，应

首先设置好需要转换的文本的格式等。

7. 5 字效练习

本练习由 3 个字效组成，第 1 个介绍了如何使用 Shadow工具创建阴影字效，第 2 个介

绍了如何使用 Blend工具创建金属字效，第 3 个介绍了使用 Bend 工具和 Roughen 工具创建

火焰字效。

1.使用 Shadow工具创建阴影字效。

（1）新建一个文档，在工具栏选择 Text工具参照图 7-31 所示输入文本，在 Text面板设
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置字体为 Arial Black，设置字体大小为 72。

图 7-31 输入文本

（2）在文本上单击鼠标右键，从弹出的快捷菜单中选择 Convert To Paths命令将文本转

换为曲线，然后在 Fill面板设置字体为无填充方式，取消填充后在 Stroker 面板设置字体轮

廓的宽度为 1，效果如图 7-32 所示。

图 7-32 设置字体轮廓和填充

（3）使用 Pointer 工具选择文本，在 Xtra 工具栏上双击 Shadow按钮打开 Shadow对话

框，在该对话框中设置 Type 为 Zoom，Scale 为 100，单击 OK按钮关闭该对话框，然后在文本

上单击并向右下方拖动，使文本产生阴影后放开鼠标，效果如图 7-33 所示。

（4）选择 Rectangle工具在字体外围绘制一个合适大小的矩形，然后选择 Shadow工具

在矩形上单击并向右下方拖动，为矩形添加阴影效果，图 7-34 为第 1 个字效完成后效果。

2.使用 Blend工具创建金属字效。

（1）新建一个文档，选择 Freehand工具，参照图 7-35 所示在页面上随意绘制 4 条曲线，

然后在 Stroker面板设置曲线的宽度为 4。

（2）从上到下依次设置第 1 条曲线的颜色为（C：100，M：0，Y：0，K：0），第 2 条曲线的颜

色为白色，第 3 条曲线的颜色为（C：37，M：0，Y：0，K：0），第 4 条曲线的颜色为（C：100，M：

100，Y：0，K：0），然后全选 4 条曲线在 Operation 面板单击 Blend 按钮，对 4 条曲线进行混合

操作，效果如图 7-36 所示。

（3）在工具栏选择 Text工具参照图 7-37 所示输入文本，在 Text 面板设置字体为 Arial

Black，字体大小为 72。
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图 7-33 为字体添加阴影效果

图 7-34 第 1 个字效完成后的效果

图 7-35 绘制曲线
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图 7-36 混合曲线

图 7-37 输入文本

（4）在文本上单击鼠标右键，从弹出的快捷菜单中选择 Convert To Paths命令将文本转

换为曲线，然后再次单击鼠标右键，从弹出的快捷菜单中选择 Ungroup 命令取消其群组，在

Operation面板单击 Union按钮，将它们焊接到一起，在 Fill 面板设置字体为“无填充”方式，

在 Stroker面板设置字体轮廓的宽度为 1，然后参照图 7-38 所示调整字体大小。

（5）对字体轮廓进行复制，将副本填充为黑色放在一侧，然后单击混合后的曲线，选择

EditCut命令将其剪切，再单击字体轮廓选择 EditPaste Inside 命令将混合后的曲线粘贴

到轮廓中，该操作完成后在 Stroker面板设置字体为“无轮廓”方式，并将黑色字体放在其后

作为阴影，第 2 个字效如图 7-39 所示。

3.使用 Bend工具和 Roughen工具创建火焰字效。

（1）新建一个文档，在工具栏中选择 Text工具参照图 7-40所示输入文本，在 Text面板设置

字体为Arial Black，设置字体大小为 72，在文本上单击鼠标右键，从弹出的快捷菜单中选择 Con-

vert To Paths命令将文本转换为曲线，然后在 Fill面板设置字体为直线渐变填充，设置 1处的颜

色为（C：95，M：20，Y：0，K：0），2处的颜色为（C：100，M：100，Y：0，K：0），渐变角度为270°，效果如图7-40
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图 7-38 调整文本

图 7-39 第 2 个字效完成后的效果

所示。

（2）对文字进行复制，并缩小副本的大小，然后在 Fill面板设置 1 处的颜色为红色，2 处

的颜色为（C：0，M：15，Y：100，K：0），3 处的颜色为白色，渐变角度为 270°，效果如图 7-41 所

示。

（3）再次对文字进行复制，并将副本放大，对副本应用径向渐变填充，设置 1 处的颜色

为黄色，2 处的颜色为（C：0，M：15，Y：100，K：0），3 处的颜色为红色，然后全选所有文字在其

上单击鼠标右键从弹出的快捷菜单中选择 Ungroup命令取消群组，并分别将字母中心对齐，

效果如图 7-42 所示。

（4）使用 Pointer工具按下 Shift键依次选取最大的字母，在 Xtra 工具栏中选择 Bend 工

具在其上单击并向外拖动使其边缘产生弯曲，再选择 Roughen 工具在其上单击并向外拖动

使其边缘在弯曲的基础上变得更粗糙，效果如图 7-43 所示。

（5）选择 Rectangle工具绘制一个矩形作为背景，对其应用直线渐变填充，设置 1 处和 2
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图 7-40 输入文本

图 7-41 复制文字

处的颜色为（C：100，M：100，Y：0，K：0），3 处的颜色为红色，4 处的颜色为（C：95，M：20，Y：0，

K：0），渐变角度为 270°，第 3 个字效完成后的效果如图 7-44 所示。
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图 7-42 再次复制文字

图 7-43 使最大的字母变粗糙

第八章
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图 7-44 第 3 个字效完成后的效果

颜色管理

颜色是图形的重要组成部分，要得到好的图形效果，色彩的使用

十分重要，特别是在广告、海报和Web页面中，视觉效果有时比文本

内容更能吸引读者。FreeHand 9 提供了丰富的颜色库（预先定义的

21 种颜色库）和许多使用方便的颜色管理工具。用户也可以使用不

同的颜色模型方便地实现图形和文本的颜色填充和笔画着色。

本章主要介绍使用 FreeHand 9 的 Color（颜色列表）和 Mixer（颜

色调制器）这 2 个浮动面板来进行颜色调配和较简单的单色填充，

以及如何创建自定义颜色库。在下一章，我们将学习高级颜色管理、

复杂填充和特殊效果等内容。

本章主要内容包括：

 颜色的基础知识；
 使用 Color Mixer面板；

 使用 Color面板；

 使用 CYMK、RGB和 HLS颜色模型；

 建立自定义的颜色库；
 图形的单色填充。
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8. 1 颜色的基础知识

计算机的颜色处理有一些常用的表示方法，本节将对几个经常

用到的概念进行介绍。

8. 1. 1 位深

在计算机的图形显示中，显示器中的点（像素）由显示卡分配一

个数据来指定颜色。分配的数据的长度存储在显存中，大小用二进

制来计量。如果计算机为每个点分配一位，可以表示 2 种颜色（黑色和白色）；如果分配 8

位，可以表示 2 的 8 次方共 256 种颜色。现在的 VGA和 SVGA显示器都可以表示 24 位真

彩色或更高，下面简要介绍几种典型的位色方案。

 2 色（1 位）：为每个像素分配 1 位的存储空间，只可以表示 2 种颜色：黑色和白色，显

示器处理的速度最快，刷新的频率也最高，需要的显存最少，但 SVGA显示器不支持 2 色。

 16 色（4 位）：每个点分配 4 位存储空间，可以显示 16 种颜色，是一种标准模式的灰

度显示，可以显示黑白色之间的过渡色。

 256 色（8 位）：8 位的存储空间足以显示 256 种颜色，能够显示人眼所能识别的大部

分颜色，但系统要求不高，许多应用程序都可以在这种彩色显示模式下较好运行。

 增强色（16 位）：可以显示 2 的 16 次方共约 65000 多种颜色，所能显示的颜色大大超

过人眼能够辨认的颜色。

 24 位真彩色：这是图形工作站和发烧友级的追求，图像更精细、更细腻。

在Windows 95 /NT的桌面上右击，选择快捷菜单的“属性”命令，打开“显示属性”对话

框，选择“设置”选项卡，在“颜色”列表框中可以显示提供的选项，如图 8-1 所示。

8. 1. 2 增色和减色

自然界物体的颜色是吸收一些太阳光的颜色并反射一些颜色形成的，吸收其他色光的

过程称为减色，红色的物体反射红色而吸收掉其他的颜色，同理，通过打印机来再现颜色是

将几种明亮的颜色，青色、品红、黄色中掺入黑色来吸收一定的光来实现的，用这 4 种颜色来

调配各种颜色，FreeHand 9 中的 CMYK颜色模式就是使用这 4 种颜色来调配各种颜色的，大

多数打印机也通过这 4 种颜色来合成图像。

计算机显示器通过红、绿、蓝 3 色相互叠加产生不同的颜色，计算机图形学中称这些颜

色为原色，显示器通过红绿蓝 3 色不同的光亮来生成各种颜色，用 3 种原色生成新颜色的方

法称为加色，大多数彩色显示器都使用加色方式，FreeHand 9 也提供了基于加色模型的

RGB调色板。
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图 8-1 显示器的颜色设置

8. 1. 3 混色和点色

一般情况下，在 Color、Mixer面板中混合的颜色都称为混色，因为无论用户使用 RGB或

HLS生成什么颜色，FreeHand 印刷时都分解成 4 种基本墨色，以使用普通墨盒的颜料。由

颜料厂商事先生产好的颜料颜色，称为点色，而不论这种颜色是否是 4 种基本颜色：青色、品

红、黄色、黑色或者绿色、淡蓝、褐色。FreeHand 9 为用户设置了专门的墨色，用户可用专用

油墨来打印。

8. 2 使用 Mixer面板

FreeHand 9 中提供了基于不同原理的颜色模型，颜色模型即是预先生成的具备颜色名

称、色样、色度及组成百分比的颜色库，Mixer面板提供了基于加色原理的 RGB颜色模型，基

于原理的 CMYK颜色模型和通过调整颜色色度，亮度和饱和度来生成颜色的 HLS颜色模

型，下面将逐一对各种颜色模型的使用进行专门介绍。

8. 2. 1 Mixer 面板介绍

Mixer面板的上方有 5 个按钮（如图 8-2 所示）：CYMK按钮（A）、RGB按钮（B）、HLS按

钮（C）、Windows 系统颜色按钮（D）和加色按钮（E）。当按下 A 或 B 按钮后，就打开了

CYMK或 RGB颜色模型，下面会出现各种颜色的数值框和滚动条。用户可以通过键入数值
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或拖动滑块来改变各种颜色的百分比。Mixer面板的底部是色样预览框 H和 I：H是调节参

数前的颜色，I是调节之后的颜色。

图 8-2 Color面板

8. 2. 2 CMYK 颜色模型

在 Mixer面板上按下 4 色按钮用于印刷领域的颜色，就可以使用 CMYK 颜色模型，

CMYK代表绿、品红、黄、黑（F 和 G），普通喷墨打印机就采用这 4 种油墨来组合图形，该模

型提供了 4 个数值框和滑块，每个颜色的可变范围为 0 ～ 100，用户可以直接在数值框中填

入这种颜色的数值，或用滑块来调节各种颜色的数值分别表示加入这种油墨的单位，最大为

100 个单位，数值越大，表示使用这种颜色越多，为 0 则不包含这种颜色。

8. 2. 3 RGB颜色模型

红色（Red）、绿色（Green）、蓝色（Blue）是彩色显示器的 3 种原色，通过 3 种原色的组

合，可以合成任何颜色。FreeHand 9 提供的 RGB颜色模型提供了这 3 种颜色的组合方法，

使用户可以方便地使用原色来合成颜色。

RGB颜色模型有 3 个数值框和 3 个滑动条，如图 8-3 所示。从上到下可以调节各种颜

色的强度，每种颜色强度范围为 0 ～ 255，数值越大这种色光越强，例如，将红色光强度设为

255，绿色和蓝色都设为 0，可得到红色，将 3 种光的强度都调到最大，就得到白色，各种色光

强度调到最小，便没有色光，即为黑色。

8. 2. 4 HLS颜色模型

RGB模型和 CMYK模型都是通过混合来生成新颜色的，而 HLS模型则基于调整色度、

亮度和饱和度来生成不同的颜色。

HLS控制面板如图 8-4 所示。在面板左边有 3 个数值框，分别是对颜色的色度、亮度、

饱和度的调节框。

 色度：该项是按角度计算的，红色位于 0 度，绿色位于 120 度，蓝色位于 240 度，洋红

—841—

FreeHand 9 应用指南



图 8-3 RGB颜色模型

图 8-4 HLS颜色模型

色位于 300 度，黄色位于 60 度，色轮是基于 RGB模式的全亮度饼图。

 亮度：表示颜色明暗程度，亮度值为 0 表示全黑，最大亮度加上最大饱和度可以得到

最鲜艳的色调。

 饱和度：饱和度描述颜色的纯度，0 饱和度相当于灰色，饱和度越大颜色纯度越大，
白色、黑色和其他灰色的饱和度都为 0。

8. 2. 5 Windows系统颜色

Windows作为世界上第一大软件生产商 Microsoft 的旗舰产品，它的标准自然是软件行

业的一个标准，在许多软件产品中都包括了 Windows系统的基本颜色，如 Microsoft Word 等

软件中的颜色填充中都使用了 Windows系统的基本颜色，FreeHand 也提供了 Windows系统

颜色，单击 Mixer面板上带飘扬 Windows图标的按钮，可以打开 Basic Colors对话框，用户可

以选定一种系统颜色加入到各种颜色模型中去，也可以进行混合编辑。

8. 3 使用 Colors面板

FreeHand的颜色控件大部分集中在 Colors面板上，用户可以方便地使用 FreeHand 提供

的颜色或自己创建的颜色为选定的对象进行颜色填充，或是使用 Options 选项创建新颜色，

建立自己的颜色库。
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8. 3. 1 Colors面板介绍

单击WindowsPanelsColor List命令，或按快捷键 Ctrl + 9 可以打开 Colors面板，如图

8-5 所示。

图 8-5 Colors面板

Colors面板上方有 3 个模式按钮、1 个加色框和 1 个加色按钮，下面是颜色列表框，3 个

模式按钮可以对选定的对象进行不同方式的填充和着色：

 填充对象：使用 Pointer工具选定要填充的对象，在 Colors面板中单击第一个按钮，该

对象原来的填充颜色会自动地在颜色列表中显示。拖动颜色列表窗口右侧的滚动条上下移

动，选择要应用到对象上的颜色，然后在颜色名称上单击即可（单击色样无效）。也可以单

击颜色列表中要使用的颜色色样，然后将之拖动到要填充的对象上，放下鼠标键就可以应用

填充。

 笔画着色：单击第二个按钮，在需要的颜色色样上单击并拖动到对象的轮廓线上，或
者使用 Pointer工具选定对象，单击第二个按钮后，在需要的颜色名称上单击，就可以将该颜

色应用于选定对象的轮廓线上而不改变对象的填充颜色。

 同时填充对象和笔画着色：单击第三个按钮，使用前述的两种方法就可以在改变对
象颜色的同时改变轮廓线的颜色。这种方法将为对象及其轮廓线提供同一种颜色填充方

式。

8. 3. 2 添加新颜色

在 FreeHand 9 中，常常需要将调配好的颜色添加到 Colors面板中，有 3 种方法可以添加

新颜色：

 直接从 Mixer色样框中或其他色样框中拖动一种色样到 Colors List 列表框中，如果

列表框不够长，可能会将色样拖到另一种色样上，从而覆盖前一种颜色。如果不想产生覆

盖，应将列表框拉长，将色样拖到空白处，就不会产生覆盖。

 在 Mixer中调配好一种需要的颜色，单击 Colors面板中的 Options选项按钮中的 New

命令，就可以将调配好的颜色添加到颜色列表框中。
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 拖动一种新颜色到 Colors面板右上方的加色框上（即带向下箭头图标的小方框），就

可以直接将颜色添加到列表框中。

8. 3. 3 颜色选项 Options

Colors 面板上的 Options选项按钮提供了许多功能强大的管理颜色的功能，使用 Options

选项可以方便地编辑（创建、复制、删除和重置）颜色，对颜色列表框进行管理，转换颜色模

型，生成点色和混色，导入和导出颜色库和使用颜色库等，Options菜单如图 8-6 所示。

图 8-6 Option菜单

1. 编辑颜色

菜单的前 4 项命令和分隔符下的 Hide names命令都是针对颜色列表框管理的命令：

 New（新建）：New命令用来创建新颜色。

 Duplicate（复制颜色）：如果在颜色列表中选定一种颜色名称，就可以使用该命令来

制作一个副本了；新得到的颜色和原来的颜色类型完全相同，并被命名为 Copy of. . .，在列

表中紧跟在原来颜色的后边排列。

 Remove（删除颜色）：要删除某种颜色，必须在 FreeHand绘图页面的空白区域上单击

以确保不选定任何对象，启用 Colors面板，在该面板上的颜色列表选择要删除的颜色名称，

然后从 Options菜单中选择 Remove命令。

 Replace（替换颜色）：该命令能够将当前列表框或颜色库中的颜色用一种新颜色替

换。选择 Options菜单中的 Replace命令时，可以打开 Replace Color 对话框。该对话框可以

让用户选择是否用颜色库中的颜色替换。

 Hide /Show names（隐藏 /显示名称）：用以显示或者隐藏颜色列表窗口中各颜色的名

称。当选择隐藏名称时，只会显示各颜色的色样；这时 Options 菜单会变为 Show names 命
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令，单击这个命令，就可以显示颜色名称了。

2. 生成点色和混色

Option菜单中的 Make Spot（生成点色）命令可以将混色转换成点色；如果这种颜色本身

是点色，也可以用 Make process命令生成混色。如果用户有某种颜色的油墨，在打印时就会

考虑使用这种油墨，而不使用青色、品红、黄色和黑色这 4 种颜色来混合。这时如果使用的

是点色，FreeHand会自动使用这种颜色的油墨来打印。当然，也可以使用混色，当考虑使用

普通墨盒时，应该将颜色的组成设为混色。这样，FreeHand在打印时就会区别对待。

3. 模型转换

Options菜单中的 Make RGB和 Make CMYK命令可以将 RGB和 CMYK这两个颜色模

型生成的颜色相互转化，这是由用户的需求决定的。例如，要把一种由 CMYK颜色模型生

成的颜色放入自定义的颜色库中，而这个颜色库中的所有颜色都要求是 RGB颜色时，应使

用 Make RGB命令将其转化为 RGB颜色；反之，也可以将 RGB颜色转换为 CMYK颜色。

4. 导入和导出颜色库

使用颜色库来组织和使用颜色非常方便和有效，FreeHand 提供了丰富的颜色库，用户

几乎可以找到所有需要的颜色；用户也可以将自己常用或喜欢的颜色组织起来，放在一个或

多个颜色库中。下面介绍如何使用 Option菜单的 Import（导入）和 Export（导出）命令来导入

和导出颜色库。

要导入使用系统或自定义的颜色库，可以选择 Option 菜单中的 Import命令，打开 Select

Color Library对话框选择要打开的颜色库，如图 8-7 所示。选择一个颜色库，单击“打开”按

钮，这个颜色库就会被导入，用户可以根据上一节介绍的使用颜色库的方法来使用了。

图 8-7 导入颜色库

Option菜单的 Export命令提供了创建自定义颜色库的功能，这个命令可以将颜色列表

中除 4种基本颜色以外的颜色导出到一个颜色库中。用户可以按照如下步骤来创建颜色库：

（1）从颜色库或 Mixer面板选择或调配好自己需要的颜色，将其添加到 Colors List颜色

列表框中；

（2）从 Options菜单中选择 Export（导出）命令，系统会弹出如图 8-8 所示的 Export Col-

ors对话框；

（3）在这个对话框中选择需要导出的颜色。如果需要选择多种颜色，应使用 Shift键或
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图 8-8 导出颜色对话框

Ctrl键；

（4）单击 OK按钮，会弹出如图 8-9 所示的 Create color library（创建颜色库）对话框，按

照系统提示依次填入 Library name（颜色库名称）、File name（文件名称）、显示的行列数（默

认）和注释信息；

图 8-9 创建颜色库

（5）单击 Save按钮，将颜色库存入系统；

（6）单击 Colors 面板的 Options 按钮，可以看见刚才创建的颜色库 EXAMPLE COLOR

LIBRARY显示在 Options菜单中，如图 8-10 所示；

（7）单击颜色库名称打开颜色库，选择自己需要的颜色，单击 OK按钮，所选的颜色会

出现在 Colors面板的颜色列表中，单击 About按钮，创建时输入在 Note中的信息就会显示出

来，如图 8-11 所示。
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图 8-10 自定义的颜色库名称列在 Option菜单中

图 8-11 使用自定义的颜色库

8. 4 使用 Xtras菜单的 Colors子菜单管理颜色

Colors子菜单中也包括了许多颜色管理与编辑的命令，使用 Colors 子菜单可以进行颜

色的精细调节和常用的颜色处理（如变亮、变暗、降低或增加饱和度等），还可以对颜色重命

名，排列颜色列表，导入 RGB颜色模型等等。
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8. 4. 1 颜色管理和控制

Colors子菜单中的命令可以进行颜色控制与管理，它们中有的是针对系统的所有颜色

模型的，有的是针对选定对象的。这些命令的主要功能简介如下：

 Color Control（颜色控制）：选择该命令可以打开 Color Control 对话框，如图 8-12 所

示。用户可以看到，该对话框提供了 3 个颜色模型按钮，可以将选定的对象的填充颜色方便

地切换到 CMYK模型、RGB模型和 HLS模型，然后拖动相应的滑块，以增加或者减少某种

颜色所占的百分比，从而调和成新的颜色。

图 8-12 Color Control对话框

图 8-12 左图所示的是 CMYK 颜色模型下的调整选项，各颜色可调整的取值范围在

- 100 到 100 之间，值越大，颜色越深；值越小，颜色越浅。当 4 种颜色的值都达到最小值

- 100 时，为白色；达到最大值 100 时，为黑色。完成调整后，单击 OK按钮可以将生成的颜

色应用于选定的对象。

图 8-12 中图显示的是 RGB模型下的调整选项，每种颜色的可调整范围也在 - 100 到

100 之间。与 CMYK颜色模型下的调整各颜色不同的是，RGB模型中 3 种原色达到最大值

100 时显示为白色；而达到最小值 - 100 时显示为黑色。用户也可以启用 Preview按钮实时

预览生成的颜色。

图 8-12 右图显示的是 HLS颜色模型下的调整选项，包括 3 个可调整选项 H（色度）、L

（亮度）和 H（饱和度）。H框的取值范围在 - 360 度到 360 度之间，L框和 S框的取值都在

- 100 到 100 之间。

 Sort Color List By Name：该命令按照名称来排列 Colors List 列表中除 None（透明）、

White（白色）、Black（黑色）和 Registration4 种颜色以外的其他各种颜色。这种方法适合于

颜色列表中颜色较多时，能够进行快速定位。

 Name ALL Colors：该命令能够检测出所有文档中没有命名的颜色。无论它们是应用

于对象的填充、对象的轮廓线还是文本中，都能够将它们检查出来并放置到 Colors面板的颜

色列表中，然后以它们对应于系统的默认 CMYK颜色模型的值为它们重新命名。但是不能

够对导入到 FreeHand 9 中的位图的颜色进行重命名。

 Randomize Named Colors：该命令能够将所有位于 Colors面板颜色列表中的颜色以随

机名称来重新命名，但不能够为列表中尚未起名的颜色来随机命名。
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8. 4. 2 颜色调整

Colors子菜单中还包含了一些用于对颜色的亮度、饱和度进行细微调整的命令，它们

是：

 Darken Colors（调暗）：使选定对象的颜色变暗。这种调整方法相对于 Colors Control

对话框来说操作简便，效果也较为直观，但精度不高。每次使用该命令都会使选定对象的颜

色以系统默认的值进行细微的调整。这些调整有时会细微到看不出来，用户必须多次执行

才能够较为明显地显示出调整后的效果。

 Lighten Colors（调亮）：该命令和 Darken Colors 命令产生的效果正好相反，它主要用

于使选定对象的颜色增加亮度。

 Desaturate Colors（降低饱和度）：该命令对选定对象的填充颜色的饱和度进行细微的

调节，以系统的默认值减小饱和度。

 Saturate Colors（加大饱和度）：该命令对选定对象的填充颜色的饱和度进行递增方式

的调节。

8. 4. 3 导入 RGB颜色模型

Colors子菜单的最后一个命令能够直接导入 RGB颜色模型，这个 RGB颜色模型中的所

有颜色可以直接被 FreeHand 9 使用，这个命令使用户可以导入自己的颜色库或者第三方厂

商提供的颜色库。

可以按如下步骤导入 RGB颜色模型：

（1）选择 XtrasColorsImport RGB Color Table命令，打开如图 8-13 所示的对话框。

图 8-13 导入 RGB颜色表

（2）在“打开”对话框中选择要导入的 RGB颜色模型，单击打开按钮，就可以使这个颜

色库中的所有颜色出现在 Colors List面板的颜色列表中。

（3）如果要清除列表中不使用的颜色，可以选择 XtrasDeleteUnused Named Colors

命令，将清除颜色列表中除了 4 种系统基本颜色以外的所有颜色。
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8. 5 单色填充

前面介绍了许多颜色管理和控制的方法，下面我们将学习如何通过使用 Fill 面板的

None和 Basic填充方式进行简单的单色填充，并对这一章的知识进行简单应用。我们将在

下一章介绍使用 Fill面板进行复杂和特殊的图形填充。

8. 5. 1 使用颜色的基本方法

要进行图形的填充或笔画着色，首先应通过 Color面板选择一种颜色，或是直接在图形

上获取颜色，即使用鼠标拖动颜色和使用吸管工具获取颜色。

在 Mixer面板上选择一种颜色模型，拖动滑块或输入数值编辑出需要的颜色，调好的颜

色可以在色样框中预览。单击色样预览框中或 Colors List 颜色列表框中的色样，按住鼠标

左键不放，拖动鼠标，可以看见鼠标指针拾取了该色样，移动这种颜色到另一种色样框或需

要填充的对象上，如图 8-14 所示。

图 8-14 拖动颜色

拖动操作是 FreeHand中的一个非常方便的功能，它使得 FreeHand 9 中的颜色管理变得

简单、易用。拖动颜色通常有以下几种模式：

 填充路径：从任一面板上拖动一个色样放到闭合路径的中间，用该颜色来填充路径。
 填充字符：把一色样拖到文本字符上以填充字符，如果没有选择字符，则该颜色填充

文本块中的所有字符，如果用 Text工具选取了一个或多个字符，只能填充选中的字符。

 填充文本块：拖动一个色样并放到一个文本块内（而不是直接放到一个字符上）就可
以改变文本块内部的颜色。如果文本块是活动的，用户必须在解除选择该文本块后才能看

见所做的改变。

 添加填充颜色：拖动一个色样到 Colors List面板上颜色列表的空白处，就可以将该颜

色添加到颜色列表中。如果颜色列表的可见部分是满的，必须把颜色拖动到 New Color 图
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标上才能添加颜色，如图 8-15 所示。

图 8-15 拖动一种颜色到对象轮廓上来改变颜色
单击 Xtras tools面板上的吸管工具，鼠标光标变成一个小吸管，移到需要的色样上单

击，吸管的尖端便吸取了色样的颜色，拖动这种色样到 Mixer 中进行编辑，或者用吸管吸取

一种颜色拖放到另一对象，即可直接进行填充。

8. 5. 2 对图形进行简单填充

用 Pointer工具选取一个或多个对象，在 Fill面板上将出现选定对象的 Fill属性，如果未

对对象进行任何填充，Fill面板的填充属性为 None。如果该对象是封闭区域，拖动任一色样

框中的色样到该对象上，将改变这个对象的 Fill 属性为 Basic。选定一个或多个封闭对象，

将 Fill面板的填充属性设为 Basic，拖动一种颜色到色样框中，便改变了基本填充的颜色。

在这里有一个技巧：当对一个对象进行了渐变或图案等高级填充后（将在下一章介绍），直

接拖动色样到该对象上并不能将其改变为单色填充，如果要强制改变为单色填充，应该按住

Shift键后再拖放颜色，如图 8-16 右图所示。注意，放开鼠标左键后才能松开 Shift键。

图 8-16 强制转变为单色填充
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8. 5. 3 去除填充

当用户对一个对象进行基本或高级填充后，要想去掉对象的填充属性，使对象的填充属

性为 None，可以用下面 3 种方法来进行：

 选中该对象，在 Fill面板上将填充属性设置为 None。

 选中该对象，在 Colors面板上的颜色列表中选择 None。

 从 Colors列表框中拖动 None色样到想去除颜色填充的对象上。去除填充前后的效

果对比如图 8-17 所示。

图 8-17 将茶杯侧面去除填充的效果比较
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第九章

高级填充与特效工具

本章将学习利用 FreeHand 9 的 Fill 面板进行复杂的颜色填充。

FreeHand 9 提供了大量的颜色填充方式，用户可以使用各种颜色工

具创建不同风格、创意新颖的图形。本章还将介绍不同方式下各种

Xtras特效工具的使用方法，并结合实例对具体的工具进行说明。

本章的主要内容包括：

 使用渐变填充；
 使用图案填充；
 使用底纹填充；
 Xtras特效工具。

9. 1 渐变填充

渐变填充是在同一对象内从一种颜色变换到另一种颜色生成的

一种特殊的填充效果。从一种颜色渐变到另一种颜色，通常可以获

得特殊的效果，譬如将一种颜色和白色渐变混合填充到物体的表面

上，可以得到反光和不同明暗度的效果；用黑色和白色渐变后应用到

阴影上，可以较好地反映光线照射角度。要在 FreeHand 9 中应用渐

变填充，必须先启用 Fill浮动面板，打开该面板中的填充类型下拉列

表框，从中选择 Gradient 选项，就可以打开渐变填充页面，如图 9-1

所示。

FreeHand 9 提供了 Graduated 和 Radial 两种渐变方式选项，

Graduated选项能够对所选定的对象进行从上到下或者从一边到另

一边的固定的渐变填充，称之为直线（线性）渐变填充；Radial选项则

可以对选定对象使用另外一种渐变填充方式，它类似于向外辐射的

同心圆的渐变填充，以某一个选定的点为中心使一种颜色向另外一

种颜色过渡，称之为径向渐变（沿一个同心圆的半径来渐变）。
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图 9-1 启用 Fill面板的 Gradient填充方式

9. 1. 1 直线渐变填充

常用的一种渐变方式是直线渐变填充，它能够创建沿一条直线使两种颜色逐渐过渡的

效果。大多数绘图软件都提供直线渐变填充方式：都把直线渐变填充作为基本的填充方式。

相对其他填充和图形变换方式，直线渐变填充生成简便，占有系统资源较低，视觉效果较好。

所以，在实际绘图中有大量应用，所以，应熟练掌握直线渐变填充的使用方法。

用户可以为该渐变指定不同的起始和终止颜色，也可以调整渐变的方向；或者进一步使

颜色沿直线方式渐进或者依对数方式渐变。从 Fill 面板上选择 Gradient（渐变）填充方式，

FreeHand 9 系统默认时是直线渐变填充，如图 9-2 所示。

图 9-2 直线渐变填充

直线渐变填充面板提供了许多选项：

 填充方式选择按钮：用这两个按钮可以选择直线渐变填充（Graduated Fill）和径向渐

变填充（Radial Fill）方式。选择左边的 Graduated 按钮，颜色渐变方向为直线方向；选择 Ra-
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dial按钮，颜色渐变方向为圆锥方向。

 色梯：色梯用于放置色样框，默认时的 2 个色样框用于指定渐变的起始色和终止色。

FreeHand 9 允许用户进行多色渐变填充。只需将颜色拖动到色梯上，调整各个色样框到适

当的位置，改变各种颜色的渐变次序和浓淡，直到调配出自己满意的渐变颜色为止。

 角度：该选项控制渐变的方向。用户可以在 Angle 选项框中输入一个值，或者直接

拖动转轮上的把手。选项框中的数值和转轮是动态关联的。如果在选项框中输入 90°，把

手将旋转到水平的位置。默认值是 270°，方向垂直向下。

 Taper（渐变速度）：下拉列表用于控制起始色和终止色变化的速度。选择 Linear 选

项时颜色变化的速度是均匀的，可创建一个线性的渐变（如图 9-3 所示）。当需要某一种颜

色占大部分时，选择 Logarithmic选项。Logarithmic选项用于创建一个对数渐变，颜色渐变的

速度遵循对数函数，即颜色开始变化快，然后逐渐减慢，其结果是后一种颜色占了大部分

（如图 9-3 右图所示）。

图 9-3 线性渐变和对数渐变

 Overprint（叠印）：Overprint复选框将叠印所选路径的填充。

9. 1. 2 径向渐变填充

FreeHand 9 中另外一种渐变填充是径向渐变。径向渐变的起始色和终止色是以一种类

似于圆锥向外辐射的填充效果，所以这种渐变也叫圆锥渐变。径向渐变填充与直线渐变填

充相同的是都是从一种颜色渐变到另一种颜色；不同的是直线渐变填充的变化方向是从一

端到另一端，径向渐变填充的变化方向是从中心向外辐射。直线渐变填充在距渐变起点相

同距离上的点的颜色相同，而径向渐变填充以定位中心为圆心的所有同心圆上的点的颜色

相同。

要创建简单的径向渐变，可以从 Fill面板上选取右边的 Radial按钮，则 Fill面板显示如

图 9-4 左图所示。

和直线渐变填充一样，FreeHand 9 也允许设置径向渐变的一些属性。用户可以改变径

向渐变的起始和终止颜色，也可以改变径向填充的中心点位置以生成不同的填充效果。具

体地说，该面板提供了以下设置径向渐变填充的选项：

 色样：显示系统的渐变开始颜色和终止颜色。要改变开始颜色（辐射中心的颜色），
启用 Colors面板，并从颜色列表中选择想要的色样，然后将该颜色拖动到色梯底端的色样框
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图 9-4 径向填充面板和填充效果

上即可；或者使用同样的方法拖动色样到色梯顶端就可以指定径向渐变外沿的颜色。

 定位中心（Locate Center）：为了定位径向填充的中心点，拖动定位窗口中的小方块到

其他位置，就能够确定被填充对象的中心颜色位置。图 9-4 中图显示了使用系统默认设置

的径向填充效果；右图显示了改变填充中心点后的效果。

9. 1. 3 多色填充

虽然前面讲述的渐变填充都只包括 2 种颜色，但 FreeHand 9. 0 允许用户使用多种渐变

颜色。使用多色渐变的方法非常简单，只需将其他色样拖到 Fill 面板上的色梯上即可。可

以是从 Color Mixer面板的色样预览框或其他任何色样框，甚至从色梯两端的色样框直接拖

动颜色到色梯上形成多色渐变填充，如图 9-5 所示。

图 9-5 多色渐变填充的应用
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9. 2 透镜填充

透镜填充能在对象上添加一块任意形状的“透明玻璃”，通过这块“玻璃”，可以在不改

变原对象的情况下看到光线折射后的效果。任何对象都可以使用透镜填充，经过变形、扭曲

和变色表现出特殊的效果，如鱼眼填充时中心放大，边缘缩小，在视觉上给人一种好像鱼的

眼睛一样向外“凸”的感觉，故称为“鱼眼”填充。

透镜填充是 Fill面板所提供的填充类型中较为特殊的一种，因为严格说来，它并不是一

种填充方法，而应该属于变换颜色所产生的特殊效果。FreeHand 9 能够在选定对象的局部

添加一块不同类型、不同颜色的透镜，从而使透镜下边的对象的颜色呈现出不同的效果。

在 FreeHand 9 中可以使用 2 种方式来添加透镜效果：

 选择Window ToolbarsXtras Tools命令，然后启用 Fisheye Lens（鱼眼）按钮，可以

给选定的对象添加常用的鱼眼透镜效果，见图 9-6。

图 9-6 一个圆添加鱼眼效果前后的比较

 在 Fill面板上启用 Lens选项，添加透明透镜、放大透镜、变亮透镜和变暗透镜等等透

镜效果。

本节主要介绍用第二种方式，即在 Fill面板上启用 Lens选项来使用各种类型的透镜。

9. 2. 1 Transparency透镜

Transparency（透明）透镜的作用就好像在对象上加上一块透明的有色或无色的“平板玻

璃”。在 Fill面板上选择 Lens 选项后，FreeHand 9 默认时在选定对象上添加的就是 Trans-

parency透镜。这种类型的透镜能够产生在整个选定对象上或者只在该对象的一部分上添

加玻璃的效果，该玻璃的颜色和透明度可以通过图 9-7 所示的面板进行调整。

从图中可以看到，Transparency透镜可以进行以下几个方面的调整：

 选择透镜的颜色：该面板顶部的色样框与取色按钮的主要功能就是用来设置透镜的
颜色。用户可以从 Colors面板的颜色列表中拖动一种颜色到色样框中，也可以单击右边的

选色按钮从打开的颜色列表中选择一种颜色。
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图 9-7 Transparency透镜的调整面板

 调整透明度：色样框下边的 Opacity（不透明度）标尺以及左边的数字框可以设置透

镜的透明度。用户可以拖动标尺上的滑块来调节，也可以直接在左边的数字框中键入数字，

该值为色样框中选定颜色的百分比。值为 0 时，无论选取什么颜色的透镜，都会以无色透镜

来显示；值为 100 时，则会显示为选定的颜色。一般来说，该值在 40% ～ 60%之间时，显示

蒙胧效果较好。

 启用 Centerpoint 复选框：透镜填充不仅可以使用透镜填充路径下的图形作为源对

象，还可以自由地使用图形的任意部分作为源对象。这时应启用 Centerpoint复选框，一个三

叶形图标会出现在透镜的中心。移动该图标或者输入中心点的横纵坐标可将透镜填充路径

下的源对象定位在视图的任意位置。

 启用 Objects Only复选框：如果透镜填充的源对象包括用户文档的背景图案，Free-

Hand 9 在透镜填充后会为它添加颜色，如图 9-8 所示，如果只希望源对象中的物体受影响而

不改变背景，可以启用这个复选框，如图 9-8 右图所示。

图 9-8 选中 Objects Only选项前后的比较

 启用 Snapshot复选框：启用 Snapshot复选框，不管源对象如何变化，都可以保证透镜

填充路径不变。用户可以移动、隐藏和删除源对象，而透镜中始终显示原对象的视图。这个

选项实际上是将源对象的图案内容复制到透镜中，所以即便源对象作了改变后，透镜中的图

案都不会改变。

Centerpoint、Objects Only和 Snapshot 选项不仅适用于透明透镜，也适用于 Lens 面板中
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的其他透镜。用这 3 个选项来确定透镜作用的中心点、是否改变透镜中的背景和是否随原

对象改变。

9. 2. 2 Magnify透镜

要将某个图形的部分和全部放大显示，需要有一个“放大镜”。可以用这个放大镜来观

察图案的重要部分，对细微部分进行仔细观察以便进行精细编辑。或者将图形的主题部分

放大突出显示。Lens下拉列表框中提供的第二种透镜是 Magnify（放大）透镜，它的主要功

能就是将透镜下的图形进行放大。Magnify透镜的设置面板如图 9-9 所示，它主要为用户提

供了以下的设置选项：

 放大倍数：拖动滑块向左可以减小放大的倍数，向右可以增大放大的倍数；用户也可
以直接在标尺左边的数字框中键入数值，该数值的范围在 1 到 20 之间。

 Centerpoint：同透明透镜设置面板的 Centerpoint 选项一样。启用该选项时，可以设

置放大镜的中心点的位置，并同时显示透视点的中心位置，在透镜中拖动中心点位置可以在

不改变透镜位置的前提下观察图形其他部分的放大效果。

和 Transparency透镜一样，可以把整个图形当作透镜，以产生整体放大效果；也可以在

图形上添加其他图形作为外挂透镜。图 9-9 显示了添加 Magnify透镜的效果。

图 9-9 为图形添加 Magnify透镜

9. 2. 3 Inver t 透镜

“反显”实际上是对原来的颜色作了一个“反”运算，从而产生了原色的互补色。Invert

透镜使透镜下的所有颜色都呈现为 CMYK 颜色的互补色。互补色是“色轮”上位置相对的

两种颜色。

要为图形对象添加反显透视效果，可以启用 Fill 面板中的 Lens 选项，然后从透镜类型

下拉列表框中选择 Invert选项，就可以打开如图 9-10 所示的 Invert透镜设置面板。
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该面板的设置选项很简单，除了能够设置透视的中心点位置外，就只有前 2 种透镜类型

所共有的 Objects Only选项和 Snapshot 选项。Invert 透镜最主要的功能是将互补的两种颜

色相互转换，如白色会转换为黑色、黄色和蓝色相对等，效果如图 9-10 所示。左上两图是

CMYK颜色模型的 4 种颜色作“反转”变换前后的比较。左下两图是常用的 8 种颜色“反

转”变换前后的比较。CMYK 4 种颜色变换未启用 Object Only复选框，白色的背景和 C、Y、

M和 K4 个字母也分别被“反转”成黑色；在对左下图的 8 种颜色变换时启用了 Object Only

复选框，白色的背景和 C、Y、CMK等几个字母没有被“反转”成黑色。

图 9-10 Invert透镜及应用举例

9. 2. 4 Lighten 透镜和 Darken 透镜

FreeHand 9 中 Lighten（变亮）透镜和 Darken（变暗）透镜的功能和作用都是相同的。

Lighten透镜用以增加图形对象的亮度；Darken透镜正好相反，使用它能够减小亮度，使图形

对象或者它的选定部分的颜色变暗。

当需要增加某一部分图案的亮度，或者在图形中混入更多的白色，可以使用 Lighten 透

镜。添加该透镜可以使透镜下的图形部分增加亮度。该透镜的设置面板如图 9-11 的左图

所示，FreeHand 9 允许用户设置亮度值为 0 ～ 100 之间的透镜类型。Lighten 透镜为透镜下

面的对象添加亮度，在对位图应用增亮效果时特别有效。

Lighten透镜也允许设置放置透镜的中心点等其他选项，当亮度设置为 0 时，透镜将不

改变选定对象的颜色，当亮度值最大为 100 时，透镜及其下边的图形部分全部变为白色。该

透镜的效果见图 9-11 的右图所示。

在 Fill面板中选择透镜类型下拉列表框中的 Darken 选项可以打开如图 9-12 左图所示

的 Darken透镜的设置面板。该面板的选项设置也很简单，除了一个变暗比例标尺和数字框

之外，就是所有透镜都可以设置的 Centerpoint和 Objects Only、Snapshot等 3 个选项。
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图 9-11 变亮透镜面板设置和效果

暗度数值的范围在 0 到 100 之间，取 0 时，变暗程度最小，透镜及其下边的对象都不发

生改变；当取 100 时，变暗程度最大，透镜及其下边的对象都显示为黑色。该透镜的效果如

图 9-12 的右图所示。

图 9-12 Darken透镜面板及其效果

9. 2. 6 Monochrome透镜

想要对象的部分颜色显示为与一种透镜的颜色相互叠加后生成的新颜色，从而产生一

种特殊的填充效果，需要用 Monochrome（单色）透镜。
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选择 Fill面板中的透镜类型下拉列表框中的Monochrome选项，该面板显示为图 9-13 左

图所示的样子。添加某种颜色的 Monochrome透镜后，透镜所遮盖的对象或者对象的部分颜

色显示为与透镜的颜色相互叠加后生成的新颜色，从而产生一种特殊的填充效果。

和其他透镜的使用方法一样，要添加 Monochrome 透镜也必须先使用 Pointer 工具选定

对象，然后使用绘图工具绘制一个基本几何图形作为透镜并添加到图形上即可。在该面板

中，用户可以为透镜选择不同的颜色，也可以指定透视的中心点位置等。该透镜的效果见图

9-13 的右图所示。

图 9-13 Monochrome透镜及其效果

9. 3 图案填充

图案填充是我们在图形绘制中经常用到的填充方法。图形填充可以理解为在画布上

“印”上各种图案和花纹。可以用规则的图案填充形成整齐的纹理和线条；也可以在图形对

象上加上别致的图案。当然，图案的颜色、风格应和谐统一，与整个图案的氛围较好融合。

反之，则可能因图案填充使图形显得杂乱无章和色彩凌乱。FreeHand 9 提供了两种图案填

充的方法：用系统本身提供的大量的位图图案，或者创建自定义的图案来填充。大部分图案

都提供了编辑功能，用户可以改变它们的线条的样式、粗细、颜色，也可以使它们以不同的倾

斜角度来填充选定的图形对象。

9. 3. 1 使用系统提供的图案进行填充

要使用系统提供的图案进行填充，选择 Fill 面板中的填充类型下拉列表框中提供的

Pattern（图案）选项。显示出图 9-14 所示的 Pattern面板，使用该面板中的选项可以选定一种
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填充图案，或者更改图案为对象然后再填充对象。

要对选定的图形对象应用图案填充，先用 Pointer 工具选定对象，然后在 Pattern 填充面

板中选定一种图案。该面板为进行图案填充或者编辑选定的图案提供了以下组件，各组件

分别对应于图 9-14 中所标志的字母位置：

图 9-14 Pattern面板

 图案线条颜色色样框（A）：设定填充图案线条的颜色。要改变系统默认的线条颜色

（黑色），从 Colors面板的颜色列表中拖动一种色样到该色样框中，也可以单击右边的颜色

名称按钮（B），打开颜色挑选器从中选择一种颜色。

 图案编辑窗口（C）：该窗口中提供了选定图案的放大形状，一个个黑色的小方格共

同组成了图案中线条的形状。在黑色的方格上单击能够减少黑色的点，在白色的方格上单

击能够增加黑色的点。添加或者减小操作都会反应在选定的对象的填充上。

 图案预览窗口（D）：在这个窗口中可以预览选定的图案的填充形状，在图案编辑窗

口中编辑的图案都可以直接在此窗口中预览。

 Clear（清除填充）按钮（E）：单击该按钮可以清除图案编辑窗口中所有的点，这时相

当于对图案全部以白色填充。清除原来的图案，重新编辑。

 Invert（反转）按钮（F）：将图案中所有的颜色反转，即黑色的像素点变成白色，而将

白色像素点变成黑色。形成与原来完全相反的填充效果。

 图案列表窗口（G）：用以显示 FreeHand 9 系统所提供的填充图案。每次能够显示 6

个图案，共有 64 种；拖动滑块可以浏览所有的图案，单击可以选定要应用于对象的填充图

案，如图 9-15 所示。

9. 3. 2 使用自定义图案填充

FreeHand所提供的填充图案毕竟有限，不能满足所有用户的需求。当用户想用自己创

建的图案填充图形时，可以使用 Titled面板来进行。启用 Fill面板中填充类型列表框的 Ti-

tled选项，打开图 9-16 所示的 Titled面板，该面板提供了一些调整创建自定义平铺图案的控
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图 9-15 图案填充应用实例

件。FreeHand 9 中的自定义的图案填充可以使用简单的几何图形，也可以嵌套图案填充，即

将一个图形用图案填充后，再用作其他图案的填充元素。

图 9-16 Titled面板

创建平铺图案并填充其他图形的操作步骤如下：

（1）在 FreeHand的绘图区绘制一个几何图形，或者将选定的多个图形使用 Group 命令

组合成一个对象。

（2）选定该对象并进行编辑，改变其颜色、调整形状大小和改变对象样式，调整到满意

的效果为止，将用这个图形来作为填充元素。

（3）选择 Edit 菜单中的 Cut或者 Copy命令将该图形输送到Windows剪贴板中。

（4）启用 Titled面板，在该面板中可以执行以下选项：

 Paste in（贴入）：选中要进行图案填充的图形对象，单击该按钮将剪贴板中的内容粘

贴到平铺图案预览窗口。
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 Copy out（拷贝出）：单击该按钮，可以将平铺图案预览窗口的内容拷贝到剪贴板中，

以便让用户将其粘贴到绘图中进行编辑。

 Angle（角度）：键入一个值或者拖动手柄来确定填充图案的方向，改变填充图案的方

向，直至填充效果满意为止。

 Scale（缩放百分比）：这 2 个数值框中的值可以确定填充图案的缩放百分比：在 x框

中键入数值来水平缩放图案；在 y框中键入数值来垂直缩放图案。输入小于 100 的值可缩

小图案，输入大于 100 的值可放大图案。

 Offset（偏移）：在 x和 y数值框中键入数值，可以填充对象内部水平或垂直移动平铺

图案。负值将图案向左或向下移动，正值将图案向右或向上移动。

（5）在用户进行设置的同时，FreeHand会自动地将设置的效果显示于要填充的选定对

象上。图 9-17 显示了使用一个渐变填充的圆创建平铺图案并填充到其他图形上的过程。

图 9-17 创建自定义平铺图案填充应用举例

9. 4 PostScript填充和底纹填充

PostScript是一种早期的打印机的语言，这种语言包括填充和基本图形绘制等许多复杂

的命令。虽然使用 PostScript语言编写出来的图案，在用户普通的显示器上无法显示，而且

现在较少使用 PostScript来绘图和打印，但 FreeHand 9 仍保留了 PostScript绘制图形的方式。

PostScript面板可以对图形进行这种填充。PostScript 底纹是使用 PostScript语言设计出的一

种特殊底纹填充类型。在屏幕上用字母“PS”代表 PostScript 填充，而不显示实际的底纹。

在 Fill面板中的填充类型下拉列表框中选用了 PostScript 选项，就会显示 PostScript 面

板，如图 9-18 所示。该面板包含以下选项：

 色样框：用以更改底纹的线条颜色。可以从 Colors面板中的颜色列表中拖动一种颜

色到该框上，也可以单击右边的按钮从打开的颜色列表中选择一种颜色。

 PostScript code窗口：用来记录编制 PostScript底纹的程序代码，如果你会用这种古老
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而复杂的语言，可以直接在这个窗口输入填充代码。

如果在使用该选项前选定了要填充的对象，无论用户是否在代码窗口中键入了 Post-

Script代码，在屏幕上都会显示以无数的字母 PS来代替，如图 9-18 右图所示。

图 9-18 PostScript面板及其填充

FreeHand 9 的 Textured（底纹）填充面板提供了许多非常接近现实生活的表面形状和颜

色的底纹。如 Burlap（布纹）、Coarse gravel（石块）、Coquille（贝壳）、Denim（斜纹布）、Fine

gravel（漂亮的石头）、Heavy mezzo（重音符）、Light Mezzo（轻音符）、Medium mezzo（中音符）、

Sand（沙子）等许多漂亮的底纹。这些底纹都是用 PostScript 语言绘制的，但 FreeHand 系列

版本没有提供将 PostScript语言转换为个人计算机可用的语言代码的解释程序，这些底纹只

能够在预览窗口中进行预览，实际的填充效果用一连串的“C”来代替，如图 9-19 所示。

图 9-19 Textured面板及填充
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9. 5 Xtras工具

Xtras是 FreeHand 9 中功能十分强大的特殊效果工具。要实现 Xtras 的功能，可以使用

Xtras菜单，也可以使用 Xtras Tools 面板，或者 Xtras Operations面板中的工具。

Xtras菜单以命令的方式提供了一些有关 Xtras的基本操作，例如，可以进行 Xtras 管理，

使用 Xtras基本命令等；不足之处在于，每次使用一个命令，就需要进行一次选择，操作比较

繁琐；同时，该菜单中缺少了一些能够产生特殊效果的 Xtras命令。而 Xtras Tools 面板包含

了 FreeHand 9 中大部分的 Xtras 命令，并且提供了许多添加特殊效果的工具。该面板把各

Xtras 命令以按钮的方式显示，可以像使用工具箱中工具一样来使用它们，如果双击某些按

钮还可以打开精确控制对话框，对生成的效果进行细微的调节。Xtras Operations 面板提供

了大量的 Xtras操作工具，使用起来很方便，但不能够进行全局管理。

9. 5. 1 Xtras Manager 概述

Xtras Manager命令提供了对 FreeHand 9 中所有的 Xtras 进行管理的功能，它能够添加

或者移除某一个 Xtras，或者将全部的 Xtras 显示或者隐藏起来。选择 Xtras 菜单中的 Xtras

Manger命令，将打开 Xtras Manager对话框，如图 9-20 所示。在该对话框中以文件目录树的

形式列出了能够在 FreeHand 9 中使用的全部 Xtras 的名称，既包括了 Xtras 菜单中的 Xtras

命令，也包含了 Xtras Operations 面板和 Xtra Tools 面板中所有的操作按钮。为了方便用户

使用 Xtras Manager对话框来更好地管理 FreeHand 9 中的各种 Xtras，下面介绍该对话框的各

种标注及作用：

 选中标记（A）：FreeHand以一个彩色的“√”来表示所启用的 Xtras，再次单击就会移

除该 Xtras。

 移除标记（B）：以彩色的“X”来表示。它和选中标记是相对的，单击选中标记，就会

出现移除标记。所有移除掉的 Xtras都不会显示在任何一个包含该选项的菜单和面板上。

文件夹移除标记（C）：以彩色的横条来表示某一个 Xtras 文件夹中存在被移除掉的

Xtras。

 展开标记（D）：这是Windows下通用的文件夹标志，表明该文件夹下包含的选项全

部展开。

 折叠标记（E）：表明文件夹下的选项未展开。

该对话框提供的另外一项操作就是 Options按钮，单击它可以打开图 9-20 中的弹出式

菜单，该菜单包含 2 个命令：All on 是系统默认方式下的选择，将所有的 Xtras 全部显示出

来；如果选择 All off命令则会将它们全部隐藏起来。

—471—

FreeHand 9 应用指南



图 9-20 Xtras Manger 对话框和 Options弹出式菜单

9. 5. 2 使用 Xtra Tools为图形添加特殊效果

Xtras Tools 是 FreeHand 9 中一个功能特殊的面板，它包含了 12 个变换工具，其中除了

前面介绍过的用来绘制圆弧的 Arc 工具和绘制螺旋线的 Spril 工具外，其他的 10 个工具都

能够产生一些特殊图形的效果。启用 Xtras Tools 面板的方法很简单，选择 Window→Tool-

bars→Xtras Tools命令即可，如图 9-21 所示。

图 9-21 Xtras Tools 面板

1. Smudge工具

Xtras Tools面板中的 Smudge 工具能够使所选对象的边沿变得柔和，并呈现混溶的效

果。要使用涂抹效果，必须首先在 FreeHand 9 中，使用 Pointer工具选定一个图形对象（该工

具对文本对象无效），然后从面板上单击 Smudge 工具按钮，移动鼠标光标到绘图窗口，单击

定位一个起点并拖动它就可以指定涂抹的范围。在用户进行拖动的同时会出现一条线和一

个与原来图形对象外观完全相同的副本，默认状态下使所选择的对象沿着这条线复制 25 次

并沿拖动路线均匀分布复制结果，拖动的距离越大，2 个复制品之间的距离越长，如图 9-22

所示。

在 FreeHand 9 默认状态下，系统将所选对象的边框和内部都涂抹成白色，这样会产生

柔和的涂抹效果，用户也可以为填充和笔划指定不同的颜色。双击该工具按钮，就可以打开

如图 9-23 所示的 Smudge对话框。该对话框只有一个 Smudge To Colors控件，它包括 2 个选

项，Fill色样框主要用来指定填充的颜色，Stroke 色样框可以用来指定选定对象的笔划的颜
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图 9-22 涂抹图形对象

色。要指定涂抹后填充的颜色，启用 Colors面板并从中选择一种颜色拖动到 Fill框中，如果

拖动的距离较短，填充颜色混和不会产生明显的差别，如图 9-23 中图所示；要产生较强的涂

抹效果，则应拖动较长的距离使每个复制品中填充颜色范围变大，如图 9-23 右图所示。

图 9-23 Smudge 对话框及实例

当使用 Smudge命令涂抹对象时，如果拖动的距离过长会占用很大的内存空间，不仅系

统的处理速度会变慢，屏幕的刷新频率也会降低。要想增强涂抹效果，可以在同一对象上多

次拖动，系统会自动地将每次拖动的效果叠加起来。

2. Fisheye Lens工具

Fisheye Lens工具的主要作用就是在选定对象的表面添加一个变形透镜，这种透镜能够

使该对象或者它的一部分看起来突出或者下陷，从而产生一种特殊的视觉效果。FreeHand

9 还允许改变透镜的形态以确定选定对象是突起的还是下陷的，以及畸变的程度。要为对

象添加鱼眼透镜效果，使用 Pointer 工具选定对象，然后在 Xtras Tools 面板上单击 Fisheye

Lens按钮，移动鼠标光标到想要变换的区域单击并拖动，在拖动的同时 FreeHand 会显示一

个椭圆作为要变形的区域，放下鼠标键时即可以系统的默认设置为该对象添加鱼眼透镜效

果；多次进行拖动就可以将该对象一点一点变“胖”，如图 9-24 所示。

图 9-24 添加鱼眼透镜效果

要改变该透镜的类型和效果的强度，双击 Fisheye Lens按钮，可以打开如图 9-25 所示的

Fisheye Lens对话框。该对话框由一个预监窗口和一个 Perspective标尺组成，当向左拖动标

尺上的滑块时，数值减小，最小值为 100，应用透镜后对象会从四周向中心位置挤压，如图 9-

25 左下图所示；向右拖动滑块时，数值增大，最大值为 100，会产生从中心向外扩张的效果，

如图 9-25 右下图所示；当取中间值 0 时，对象的外观不会发生任何变化。
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图 9-25 Fisheye Lens 对话框及效果

3. 3D Rotation工具

3D Rotation工具是 FreeHand 9 中功能最强劲的工具之一，但同时也是最复杂的工具之

一，它的主要作用就是能够在三维空间旋转一个二维物体。

使用 3D Rotation工具旋转对象，首先使用 Pointer工具选定旋转对象。单击 Xtras Tools

面板上的 3D Rotation按钮，移动鼠标光标到对象上单击定位一个起点，FreeHand 将以该起

点为旋转中心点。继续拖动鼠标时，在图形周围会出现一条从旋转中心点出发的直线，并以

一个矩形框来表示对象所有的平面，拖动时可以看到该矩形框向左、右、上、下 4 个方向转

动，图 9-26 显示了使用系统默认设置对选定的对象进行三维旋转的过程。

图 9-26 对选定对象进行三维旋转

双击 3D Rotation按钮，会打开用于对三维旋转进行精确控制的 3D Rotation 对话框，如

图 9-27 所示。该对话框有 2 种显示模式，如果使用的是 Easy（容易）模式，该对话框显示为

图 9-27 左图所示的样子，它包含的组件较少；如果选用了 Expert（专家）模式则包含较多的

选项，如图 9-27 右图所示。

Rotate from（旋转起始位置）列表框用于指定旋转开始的位置，选择不同的旋转中心点

位置，旋转后的效果是全然不同的。Mouse click选项是以用户开始旋转拖动的点作为中心

点。Center of selection选项是计算出所选对象的中心点，将其作为旋转中心。Center of grav-

ity选项是按所选对象的位置以及选择的空间来计算旋转对象中心。Origin选项是使用选择

对象的左下角为旋转中心。

Distance（距离）数字框主要用来设置旋转的距离。距离越长旋转效果越弱，距离越短
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图 9-27 3D Rotation对话框的 2 种显示

效果就越强烈。该距离的最小值是 100 磅，默认设置是 504 磅，最大值为 2000 磅。如果切

换到 Expert模式下，还可以设置对象的位置，同时也能够在用户进行旋转的同时跟踪鼠标

移动，随时记录当前的角度和角度。

4. Mirror工具

Mirror工具能够将选定对象经过镜像后把原件和副本一同显示出来，如果进行第二次

镜像，它还能够进一步地把第一次镜像的原件和副本同时进行镜像。

图 9-28 左图显示的是把图形苹果经过第一次镜像时产生的效果，系统默认状态下是进

行水平镜像，在拖动过程中会出现一条垂直的直线作为镜像的轴线，镜像后的对象会对称地

分布于轴线的两侧；右图则显示了把左图经过再一次镜像后的效果，在屏幕上出现了 4 个苹

果。依次类推，如果进行第三次操作，就会产生 8 个苹果、16 个苹果等；进行多次操作，就可

以创建出平铺背景图案的效果。

图 9-28 对对象进行镜像

同样的，FreeHand 9 允许对 Mirror工具进行精确的设置。双击该按钮，就可以打开 Mir-

ror对话框，如图 9-29 所示。

 镜像方式列表框：它包括了 4 种可选择的镜像方式，除了第四种方式打开的对话框

（图 9-29 右图所示）有所不同外，其他都大致相同。这 4 种镜像方式简介如下：

 Vertical（水平镜像）：启用该选项时可以将选定对象沿一条垂直的轴线进行镜像，这

是系统默认状态选择的镜像方式。

 Horizontal（垂直镜像）：启用该选项时可以将选定的对象沿一条水平方向的轴线进行

镜像。

 Horizontal Vertical（垂直和水平镜像）：启用该选项可以同时将选定的对象沿水平和
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图 9-29 Mirror 对话框

垂直 2 个轴线进行镜像，它可以同时产生该对象的 3 个副本。

 Multiple（复合镜像）：这是 4 种镜像方式中最为复杂的一种，能够产生多种镜像效

果，还可以在下面的列表框中进一步指定复合镜像的方式，如 Rotate（旋转）和 Reflect（反

射）等。采用这种方式时，FreeHand允许同时产生最多 50 个原对象的副本。

启用 Close Paths复选框时，FreeHand将把所有生成的对象的副本沿一个圆周来排列。

图 9-30 显示了使用复合镜像效果的 2 个实例。左图是选择了 Reflect选项时的效果，右

图则是选择 Rotate选项时的效果。

图 9-30 Multiple镜像实例

5. Graphic Hose工具

Graphic Hose工具能够把系统提供的各种图案当作填充对象来创建带有平铺图案的图

形。要使用该工具，选定对象后单击 Xtras Tools面板上的 Graphic hose 按钮，移动鼠标光标

到绘图窗口中单击定位一个起点并拖动，就可以随着光标的移动依次画出一个个黑色圆、红

色三角形、蓝色正方形和黄色五角星。使用该工具能够很快地创建出一些特殊的图案来作

为绘图或者文本的背景来。图 9-31 显示了系统默认时使用该工具所绘制的图案。

该按钮上也有一个参数选择标记，双击它可以打开如图 9-32 所示的 Hose 对话框。该

对话框提供了一些有关图案填充的精确控件，包括以下选项：

 图案类型列表框：单击列表框右边向下的黑色箭头，可以从 FreeHand 9 所提供的图

案类型中选择一种，也可以将用户自己的图案加入到该列表中去。图案文件名称是以 Free-

Hand 9 的默认文件格式. fh9 保存的。

 图案预览窗口：显示选定图案文件中选定图案的预览图。
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图 9-31 使用 Graphic Hose工具绘制 4 色图案

图 9-32 Hose对话框及实例

 Paste in按钮：在绘图窗口中创建一个图形后，使用 Cut命令将该图形放到剪贴板中，

然后再单击该按钮就可以将该图形作为一种图案加入到图案列表中或者应用于其他对象的

填充。

 Delete按钮：将选定的图案从列表中删除。

 Copy out按钮：将选定的图案放入剪贴板中以备其他图形所用。

 Contents：显示选定图案文件中所包含的图案名称。

无论选择了哪一种系统提供的图案，都可以直接拖动鼠标添加到绘图窗口中去。如果

在该对话框顶部选择了 Options选项，打开的对话框显示为图 9-33 所示的样子，该对话框提

供了用以编辑选定图案的选项，它们是：

 Order下拉列表框：该列表框中提供了设置图案放置形状的选项。Loop 选项将所选

图案以圆环来排列；Back and forth选项将该图案以紧密相叠的前后顺序为放置；Random（随

机）选项将所选图案以随机顺序来排列。
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图 9-33 Options对话框及实例

 Spacing列表框：主要用来指定拖动时放置图案的间距，它也包含了几个选项，Grid

选项将根据指定的网格数来设定间距；Variable选项将间距值设置为按指定数值不断变化；

Random选项则使用随机指定的间距值。

 Scale选项：包括了两种放置图案时的缩放方式。选择 Uniform时，各图案在总体上

按 Angle指定的数值来缩放；选择 Random时，则随机地设置图案大小。

 Rotate选项：主要用来指定图案总体上的旋转方式。包括 Incremental、Random、Uni-

form等。

 Angle控制柄：拖动控制柄或者直接在左边的框中键入需要的角度值。该值用来指

定图案旋转时的角度。

6. Bend工具

使用 Xtras Tools面板上的 Bend（弯曲）工具能够从鼠标单击处向内或向外弯曲选定的

图形对象。使用 Bend工具时，先用 Pointer工具选择一个图形对象，单击 Xtras Tools面板上

的 Bend按钮，然后移动鼠标光标到该对象上单击并拖动即可。在进行对象的弯曲时，弯曲

的中心位于鼠标单击点处，向上拖动可以创建一个尖头的效果，使路径向内弯曲，如图 9-34

左图所示；向下拖动创建隆起的效果，使路径向外弯曲，如图 9-34 右图所示。

图 9-34 使用 Bend工具使用图形弯曲
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双击 Xtras Tools面板上的 Bend工具按钮可以打开如图 9-35 所示的 Bend 对话框。该

对话框只有一个 Amount选项，主要用来设置变形量。向右拖动滑块可以加大变形量，数值

越大变形效果越明显，FreeHand 9 允许设置的最大值为 10。向左拖动会减少该数值，数值

越小变形效果越不明显，最小值为 1。完成设置后，单击 OK按钮就可以使用 Bend工具对选

定对象进行不同的变形了。图 9-35 左上图显示的是该值最小为 1 时的变形效果，右上图则

是最大值 10 时的变形效果。如果需要进一步地增加变形的效果，可以多次重复上述操作。

图 9-35 Bend对话框及实例

7. Roughen工具

Roughen（粗糙）工具能够在所选对象的路径上增加一些点并且在初始路径位置上随机

分布这些点，从而使图形的表面看上去粗糙不平。图 9-36 显示了在系统默认状态下使用

Roughen工具对一个网球的变形结果。

图 9-36 应用 Roughen工具

双击 Roughen 工具按钮可以打开对该工具进行精确控制的 Roughen 对话框，如图 9-37

上图所示。其中 Amount数字框用以设置在选定图形的轮廓线上添加的点的数目（每英寸

增加的点数）。可以直接在左边的数字框中键入数值，也可以拖动滑块来设定。FreeHand 9

允许最多添加 100 个点，最少添加一个点；数值越大，图形表面越粗糙。使用 Rough 选项会

使用角点来创建锯齿边界，效果如图 9-37 左下图所示。使用 Smooth 选项会使用曲线点创

建平滑的但变形的边界，效果如图 9-37 右下图所示。
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图 9-37 Rough选项和 Smooth选项产生的不同效果

8. Shadow工具

使用 Xtras Tools 面板中的 Shadow工具能够为图形对象添加阴影效果。用户也能够通

过打开的 Shadow对话框来进一步设置阴影的属性。图 9-38 显示了双击后打开的 Shadow

对话框。

Shadow对话框中的 Type 是 FreeHand 提供的阴影类型列表。选择 Hard edge 选项时，

可以在对象的边缘添加一种较为单一的阴影，其效果不太明显；选择 Soft edge 选项时，能够

在对象边缘添加一种较为柔和的阴影效果；启用 Zoom选项时，添加的阴影效果最为明显，

它有些类似于 Smudge命令所产生的效果，能够产生很强的立体感。

Fill 色样框用于显示当前使用的阴影的颜色，也可以从 Colors 面板中拖动一种颜色到

该色样框中来改变阴影的颜色。默认状态下，FreeHand将阴影的颜色设置为白色。Scale 选

项用于设置阴影边缘相对于原对象的大小，它以原对象的百分比来表示。

Offset（偏移）选项用于设置阴影与原对象的偏移距离。

在该对话框中完成设置后，单击 OK按钮，然后在原对象上单击并拖动就可以添加阴影

效果了。图 9-38 右图显示选择 Zoom选项时添加的阴影效果。

9. 5. 3 使用 Xtras Operations面板的特效工具

FreeHand 9 中的另外一些特效工具隐藏在 Xtras Operations 面板中，要想使用这些特殊

效果工具，依次选择 Window→Toolsbars→ Xtras Operations 命令启用 Xtras Operations 面板，

然后再选择不同的工具按钮即可。本节主要介绍该面板能够产生奇特效果的 Emboss 工具

和 Blend 工具。

1. Emboss工具

FreeHand 9 中提供的 Emboss工具能够在选定的图形对象的周围添加不同颜色、不同宽
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图 9-38 Shadow对话框及实例

度的镜框效果。要为图形添加浮雕化效果，首先使用 Pointer 工具选定该图形对象，启用

Xtras Operations面板后，单击 Emboss 按钮，FreeHand 会打开 Emboss 对话框，如图 9-39 所

示。

图 9-39 Emboss对话框

Emboss对话框顶部的 5 个按钮是浮雕化类型按钮，无论启用哪个按钮都能够为选定图

形添加不同的浮雕化效果。单击五个按钮中的一个，该按钮所代表的浮雕化效果名称就会

显示在 Type栏中，它们依次是 Emboss（浮雕）、Deboss（下陷）、Chisel（雕刻）、Ridge（波纹）和

Quilt（皱褶）效果。

Vary列表框主要用于指定边框颜色。当选择 Color选项时，对话框中带有 2 个色样框，

Highlight框主要用于指定边框颜色，Shadow框用以指定边框的阴影颜色。FreeHand 允许从

Colors面板中拖动色样添加到这 2 个色样框中去。如果选择了 Contrast选项，则会以原对象

的填充颜色的百分比来指定边框的颜色。

Depth参数用来设置生成的边框与原对象的轮廓线之间的距离。Angle 参数用来指定

边框以原对象为参照点的相对偏移角度。Soft Edge 复选框用来指定边框阴影是否应用柔
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和效果。

完成设置后，单击 OK按钮就可以为选定的图形对象添加不同的浮雕化效果了。图 9-

40 显示的是应用 Emboss命令产生的不同效果。

图 9-40 Emboss效果

9. 5. 4 Blend 工具

Blend工具的作用是使 2 个或着 2 个以上的自由形状路径生成混合路径效果。如果用

户想要混合正方形或者椭圆，必须先对它们分别使用 Ungroup 命令解除组合。用户在使用

Blend命令时，会受到以下限制：

 对于一个组合路径中的部分路径不能够使用 Blend命令。

 不能对复合路径或者没有分离的文本路径应用 Blend命令。

不能将一个开放路径和一个封闭路径进行混合。在混合之前最好是调整好路径的方
向，可以使用 Operations面板上的 Correct Direction工具。

 2 个路径必须具有相似的填充和笔画。

确保要进行混合的对象符合上述条件后，单击 Xtras Options 面板上的 Blend 按钮就可

以自动地将这 2 个对象实现混合，效果如图 9-41 所示。

图 9-41 混合路径

当用户选择 Blend命令时，FreeHand按源点和终点路径的颜色自动设定中间级的数量。

最大的默认级数是 25，就是将一条白色路径和一条黑色路径混合时取的值。如果其中任何
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一个路径使用灰度值填充，FreeHand 9 产生的级数就会少些。用户可以使用 Blend 面板上

的选项来编辑级数，Blend面板是一个特殊的 Object面板，如图 9-42 所示。

图 9-42 Blend面板

该面板包括 3 个选项，可以让用户控制中间级数量和各中间级相对于原路径的位置和

颜色：

 Number of Step（级数）：在该选项框中输入想让 FreeHand 创建的中间路径的数目。

中间路径可以取任何值，只要为 FreeHand分配足够的内存即可。

 First：该值决定了第一级的颜色相对于源点和终点路径的填充和笔画的差别程度。

 Last：该值的使用方法与 First相似，但它是控制最后一级的颜色和位置的。其中位

置的百分比是从源点路径开始计算的，而不是从终点路径开始计算的。

另外，FreeHand 9 也允许用户改变混合后的颜色。只要从 Colors 面板中拖动一种颜色

到混合路径的起始对象上或者终止对象上即可，但是 Blend 命令只能够混合 2 种不同的颜

色。

9. 6 别墅效果图

本练习绘制了一幅别墅的效果图，该练习主要使用 Rectangle 工具、钢笔工具绘制了别

墅的主体部分，然后对其应用简单的直线渐变填充，该练习还向读者介绍了 Free Hand 中临

摹底图的强大功能，此功能可以将所有位图转化为矢量图，在一些作品中可以轻松得到相当

逼真的图形。绘制图形的步骤如下：

（1）选择 Rectangle工具绘制一个矩形，对其应用直线渐变填充，参照图 9-43 所示在

Fill面板设置 1 处的颜色为（C：25，M：0，Y：15，K：0），2 处的颜色为（C：0，M：0，Y：15，K：0），

渐变角度为 334°。

（2）选择 Pointer工具，按下 Alt键在矩形上单击并向右拖动，对矩形进行复制，然后在

矩形上单击右键，从快捷菜单选择 Ungroup 命令取消其群组，参照图 9-44 所示对矩形副本

进行调整。
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图 9-43 绘制一个矩形

图 9-44 复制矩形

（3）选择 Rectangle工具参照图 9-45 所示绘制一个矩形与原有图形适配在一起组成房

子的主体部分，然后对其应用与原有图形颜色相同的直线渐变填充，设置渐变角度为 325°。

（4）使用 Rectangle工具参照图 9-46 所示在房子右侧绘制一个合适大小的矩形，然后

选择 Pen工具在矩形的顶边轮廓上单击添加新节点，使用 Pointer工具拖动新节点向上移动

制作一面山墙，对其应用与房子颜色相同的直线渐变填充，设置渐变角度为 270°。

（5）在工具栏选择 Polygon 工具，双击 Polygon 按钮打开 Polygon Tool 对话框，在该对话

框中的 Shape选项组内选择 Polygon单选按钮，在 Number of Sides选项组内设置多边形的边

数为 3，然后单击 OK按钮关闭该对话框，按下 Shift键在绘图区绘制一个水平的正三角形作

为房顶，并对三角形进行直线渐变填充，设置 1 处的颜色为（C：0，M：100，Y：100，K：80），2

处的颜色为（C：0，M：30，Y：100，K：50），渐变角度为 72°，如图 9-47 所示。

（6）选择 Rectangle工具在三角形房顶右侧绘制一个矩形，取消其群组后参照图 9-48
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图 9-45 组成房子主体

图 9-46 绘制山墙

所示对其进行调整制作三角形房顶的右侧面，对其应用与房顶颜色相同的直线渐变填充，设

置渐变角度为 270°。

（7）根据绘制三角形房顶侧面的方法参照图 9-49 所示绘制房顶的底面，对其应用直线

渐变填充，设置 1 处颜色为黑色，2 处的颜色为白色，渐变角度为 270°。

（8）选择 Pen工具参照图 9-50 所示首先绘制较大的房顶，然后绘制山墙上的房顶，对

它们应用与其他房顶颜色相同的直线渐变填充，设置渐变角度分别为 298°和 270°。

（9）选择 Rectangle工具在三角形房顶上绘制一个小矩形，根据山墙的绘制方法将小矩

形调整为山墙，然后选择 Pen工具参照图 9-51 所示在小山墙的右侧绘制一个三角形组成小

阁楼的主体部分，对它们应用与其他墙壁颜色相同的直线渐变填充。

（10）选择 Pen工具参照图 9-52 所示绘制小阁楼的正面房顶和侧面房顶，对它们应用
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图 9-47 绘制三角形房顶

图 9-48 绘制三角形房顶的侧面

与其他房顶颜色相同的直线渐变填充。

（11）选择 Rectangle工具参照图 9-53 绘制一个矩形制作烟囱的正面，然后再绘制一个

矩形并进行调整制作烟囱的侧面，对它们应用与墙壁颜色相同的直线渐变填充。

（12）参照上述方法在房顶上绘制另外 2 个烟囱，然后使用 Rectangle 工具在房子的墙

壁上绘制 2 个矩形作为墙壁上的装饰条，分别对它们应用直线渐变填充，设置 1 处的颜色为

（C：40，M：0，Y：40，K：0），2处的颜色为（C：0，M：0，Y：15，K：0），渐变角度为 270°，如图 9-54 所

示。

（13）选择 Rectangle工具，参照图 9-55 所示，绘制 2 个大小不同的矩形，全选 2 个矩形，

在 Xtra Operations面板单击 Punch按钮使 2 个矩形相互剪切，生成矩形框，然后在其上绘制

2 个十字交叉的矩形，全选矩形框和十字矩形，在 Xtra Operations 面板连续单击 Union 按钮
—981—

第九章 高级填充与特效工具



图 9-49 绘制房顶底面

图 9-50 绘制房顶

将矩形框和十字矩形焊接在一起制作窗框，如图 9-55 所示。

（14）对制作好的窗框应用直线渐变填充，设置 1 处的颜色为（C：0，M：100，Y：50，K：

55），2 处的颜色为（C：0，M：35，Y：100，K：0），渐变角度为 96°，如图 9-56 所示。

（15）选择 Rectangle工具绘制一个与窗框大小相当的矩形放在窗框的后面作为玻璃，

对其应用直线渐变填充，设置 1 处的颜色为（C：100，M：55，Y：0，K：0），2 处的颜色为（C：0，

M：35，Y：100，K：0），渐变角度为 270°，如图 9-57 所示。

（16）选择 Rectangle工具绘制一个矩形，对其应用与窗框颜色相同的直线渐变填充，设

置渐变角度为 270°，然后对其进行复制，参照图 9-58 所示调整副本的大小将它们适配到原
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图 9-51 绘制房顶上的小阁楼

图 9-52 绘制小阁楼的房顶

矩形中组成一扇门。

（17）对窗户进行复制，并调整它们的大小与门一同适配到房子上，然后选择 Rectangle

工具绘制背景，对背景应用直线渐变填充，参照图 9-59 所示，在 Fill面板设置 1 处的颜色为

（C：55，M：20，Y：0，K：0），2 处和 3 处的颜色为白色，4 处的颜色为（C：40，M：0，Y：100，K：

0），5 处的颜色为（C：0，M：60，Y：100，K：45），渐变角度为 270°。

（18）在主工具栏上单击 Import按钮，打开 Import Document对话框，在其中选择一幅植

物位图导入图形中，导入后参照图 9-60 所示，在 Layers面板单击 Background层，将位图放在

背景图层，呈现灰色，然后按下 Tab键以取消对位图的选择，这时在 Layers面板中单击 Froe-

ground层。

（19）在工具栏选择 Autotrace 工具，双击打开 Trace Tool 对话框，在该对话框的 Color

mode 选项组中设置 16 是 RGB模式，在 Resolution列表框中选择 Nomal，在 Trace Layers列表
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图 9-53 绘制烟囱

图 9-54 绘制装饰条
框中选择 Background，完成设置后单击 OK按钮关闭该对话框，然后使用 Autotrace工具圈选

位图，稍后会在位图上方出现由位图转化成的矢量图，如图 9-61 右图所示。

（20）把位图转换为矢量图后将黑色背景删除，只剩下植物，如图 9-62 左图所示，由于

植物的颜色灰暗，在其上单击鼠标右键从快捷菜单中选择 XtrasColorsColor Control 命

令，打开 Color Control对话框，在该对话框中单击 CMYK按钮，设置颜色为（C：100，M：0，Y：

100，K：0），调整后的效果如图 9-62 右图所示。

（21）参照上述方法再次导入一幅位图，用同样的方法将其转换为矢量图，并将黑色背

景删除，效果如图 9-63 所示。

（22）参照图 9-22 所示对植物进行复制，并调整植物的大小，然后将它们适配到背景中

完成本练习。

—291—

FreeHand 9 应用指南



图 9-55 制作窗框

图 9-56 填充窗框

—391—

第九章 高级填充与特效工具



图 9-57 绘制玻璃

图 9-58 绘制一扇门

第十章

打 印 输 出

—791—



图 9-59 绘制背景

图 9-60 导入位图

在 FreeHand 9 中进行打印工作是非常方便的，它的默认设置能

够满足大部分的打印需求，进行文本打印、图文混合格式的文档打

印、精美的图形打印等操作都简化到了只需直接单击 Print按钮即可

完成。如果用户要打印的文档较为复杂或者要进行一些特殊的打印

操作，可以先对一些有关打印的属性进行设置。

本章中的主要内容包括：

 打印机的选择与安装；
 打印机的属性设置；
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图 9-61 将位图转化为矢量图

图 9-62 调整颜色

 打印输出图形。

10. 1 打印机的选择与安装

要添加打印机到计算机中去，必须按照打印需求选择和安装打

印机。严格地说，这种操作并不属于 FreeHand 9 所独有的，而是每

一种基于Windows平台的应用程序进行打印前都必须具备的共同操

作。

10. 1. 1 打印机简介

目前市场上各种类型、品牌的打印机很多，性能、质量各有千秋。
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图 9-63 再次导入位图

图 9-64 最后的效果

打印机主要分为：针式打印机、喷墨打印机、激光打印机、热蜡打印

机、热升华打印机、热转印打印机和高速行式打印机，而每一种打印

机又有单色和彩色打印机之分。目前主要使用的是喷墨打印机和激

光打印机，针式打印机已基本上处于淘汰状态。

分辨率是衡量一台打印机性能优劣的主要指标，分辨率用 DPI

表示，即每英寸打印点数，现在的打印机中，一般分辨率在 300DPI

以上的，都可以打印比较清晰的照片（使用专用相纸打印），而要打印 FreeHand 9 所绘制的

各种图形，这样的分辨率已经差不多了，但如果有更高分辨率的打印机当然更好。

就价格而言，如果作为公司广告宣传之用，就应选用高分辨率的激光打印机。选用这种

打印机更能展现高质量的打印效果，因为较之其他几种类型的打印机，激光打印机有打印品
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质细腻、打印效果逼真、噪声低、速度快、平均成本低等诸多优点。作为一名 FreeHand 9 的

爱好者，配置一台彩色喷墨打印机也算不错了，当然如果经济宽裕，有一台彩色激光打印机

更好。

10. 1. 2 打印机的安装

要打印输出在 FreeHand 9 中所绘制的图形，必须先安装打印机。如果事先没有安装打

印机，从 File菜单中选择 Print命令时，会弹出提示安装打印机的对话框。下面就来介绍打

印机的一般安装步骤：

（1）首先按照用户手册中的说明，把打印机与计算机正确连接。然后接通打印机电源，

使其处于待机状态。

（2）启动计算机，进入Windows操作系统。

（3）双击“我的电脑”图标，在打开的我的电脑窗口中双击“打印机”图标，打开“打印

机”窗口，如图 10-1 所示。

图 10-1 “打印机”窗口

（4）在窗口内双击“添加打印机”图标，打开“添加打印机向导”对话框。单击“下一

步”按钮，开始逐步进行打印机的安装设置。

（5）用户选择本地打印机的连接方式后，Windows会构造相关的打印机驱动程序库，在

“添加打印机向导”对话框中列出常见的打印机厂商及其生产的打印机型号，如图 10-2所示。

用户可以在其中选择自己所购买打印机的厂商及打印机型号，若列表中没有其型号，可

以参阅打印机用户手册，在其中找出兼容的型号。在通常情况下，购买打印机时，若随机提

供了安装程序盘，建议使用其中的驱动程序，根据经验，随机安装盘中的驱动程序更适应于

打印机，这时就要在对话框中选择“从软盘安装”。
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图 10-2 选择打印机型号对话框

（6）在用户选择了驱动程序后，还要完成选择打印机端口，确认打印机名称和设置打印测试

页 3步，就完成了打印机的安装，安装的打印机图标就会出现在“打印机”窗口中，如图10-3所示。

图 10-3 添加打印机后的打印窗口

10. 2 打印机的属性设置

安装完打印机以后，还必须对打印机的相关属性进行必要的设置，以便打印出更逼真的

效果。如果设置不当，打印出来的效果就不会令人满意，有时甚至会出现错误。下面将以佳

能 BJC - 2000SP为例，来学习如何对打印机的属性进行设置。

右击打印机图标，在弹出的菜单中选择“属性”命令，这时就会弹出打印机的属性对话框，如
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图 10-4所示。用户可以根据打印的实际需要随时改变打印机的属性设置，除了在Windows中可

以进行打印属性设置外，也可以直接在 FreeHand 9中进行，执行 File→Print命令，打开 Print对话

框，单击对话框中的 Properties按钮，也会打开图 10-4所示的打印机属性设置对话框。

图 10-4 打印机属性设置对话框

一般情况下，任何打印机的属性设置都包括颜色管理、页面设置、维护设置等方面，下面就以

设置佳能 2000打印机的各种属性为例进行说明，其他类型打印机的属性设置方法与之雷同。

10. 2. 1 常规属性

常规属性的设置是在“常规”选项卡中进行的，如图 10-4 所示。常规属性主要设置的是

页分隔项，在它的下拉列表框中包括无、简单、全部等几个选项，用户也可以单击“浏览”按

钮选择其他的分隔方式。默认情况下选择的“简单”选项，设置完成后就可以进行打印测

试。

10. 2. 2 主要属性

主要属性的设置是在“常规”选项卡中进行的，如图 10-5 所示。主要属性用于是进行打

印模式的设置。就佳能 2000 打印机而言，它的打印模式包括标准、高级照片、桌面印刷、经

济型等 7 种类型。在打印一些由 Word 等软件所制作的文本或简单的图形时，使用标准打

印模式就行了。如果要求的打印质量非常高，就可以选择高级照片模式。用户最好不要使

用经济型打印模式，那样打印的效果会非常差。打印 FreeHand 9 的图形时，使用照片或图

像打印模式就可以了。在“主要”属性中还可以选择所使用的墨盒种类，对于彩色喷墨打印

机而言，一般包括彩色、黑色、照片 3 个墨盒。需要打印文本时，选择黑色墨盒就行了。要打
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印彩图时，至少要选择彩色墨盒，最好是照片墨盒，那样效果会更好。

主要属性设置中还包括介质类型的选择。“介质类型”下拉列表中提供的有普通纸、幻

灯片、打印胶片、高光胶片、纤维纸、高分辨率纸、光面照相纸等选项。在打印文本时，使用普

通纸即可；打印一般图片时，可以使用高分辨率纸；照片的打印通常使用照相纸。顾名思义，

幻灯片介质是用来打印幻灯片的。

图 10-5 “主要”选项卡

10. 2. 3 页设置属性

“页设置”选项卡如图 10-6 所示，主要用来进行打印页面的设置。首先，用户可以选择

页数尺寸，提供的选项包括 A4、A5、B5 和信封。在方向设置中，可以选择打印的方向是纵向

还是横向。接着可以设定打印的类型，通常包括普通、比例打印、页面设置打印、招贴广告打

印、横幅打印纸打印。通常情况下使用普通尺寸打印类型，使用比例打印时，可以按照设定

的比例打印需要打印的内容。如果选择页面设置打印类型，可以按照指定的页数打印选择

的内容。招贴广告打印类型和横幅打印纸类型是分别针对招贴广告和横幅打印纸的选项类

型。

10. 2. 4 颜色管理属性

“颜色管理”选项卡如图 10-7 所示，主要用来进行与打印机关联的颜色配置文件的设

置。默认情况下，使用自动选项，系统会自动从相关的颜色配置文件中选择最佳的颜色配置

文件。用户也可以使用手动选项，自己添加颜色配置文件表，从颜色配置文件表中选择最合

适的颜色配置文件。
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图 10-6 “页设置”选项卡

图 10-7 “颜色管理”属性选项卡

10. 2. 5 详细资料属性

“详细资料”选项卡如图 10-8 所示，主要用来进行一些与打印机硬件有关的设置。如果

用户想把打印机连接到其他的输出端口上，可以从打印输出端口列表中选择其他通讯端口，

如 COM1、COM2 等，还可以单击“添加端口”按钮来添加列表中不包括的输出端口。如果打

印机生产商升级了打印机的驱动程序，可以单击“新驱动程序”按钮来更改当前所使用的驱

动程序。
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图 10-8 详细资料属性对话框

另外，打印机属性设置对话框中的“印记 /背景”选项卡主要用来进行打印时的水印、标

签、背景等设置，“维护”选项卡用来进行清洗打印头等一些必要的打印机维护设置。这 2

个选项卡的内容较为简单，这里就不再详细说明。

10. 3 打印输出

在进行了以上的打印机安装、设置操作后，就可以将 FreeHand 9 中绘制的图形打印出

来了。根据不同的打印机以及不同的打印要求，本节将分别介绍 PostScript 兼容打印机和

PostScript非兼容打印机的打印输出。

10. 3. 1 选择打印机

如果用户安装了多台打印机，在 FreeHand 9 中打印作品之前就需要选择一台适用的打

印机。执行 File→Printer Setup命令，打开 Printer Setup对话框，在列表框中用户可以选择将

要使用的打印机，如图 10-9 所示。

从图 10-9 所示的 Target printer（目标打印机）列表框中可以看出，用户安装了 2 台打印

机：AGFA - StudioSet200v49. 3v52. 3 和 Cannon BJC - 2000SP。AGFA - StudioSet200v49.

3v52. 3 打印机与 PostScript 兼容，需要支持 PostScript 打印输出时，单击 AGFA - Studio-

Set200v49. 3v52. 3 选项，然后单击 OK按钮就行了。在 Printer Setup对话框中除了可以选择

将要使用的打印机外，还可以对打印机的属性进行设置。选择打印机选项，单击 Setup 按钮

即会打开打印机属性对话框。
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图 10-9 Printer Setup对话框

支持 PostScript和不支持 PostScript的打印机在打印设置时的复杂程度不同，下面就在

简单页面设置和复杂页面设置 2 节中分别介绍这 2 种打印机的页面设置。

除了使用 Printer Setup对话框选择打印机外，用户还可以通过 Print对话框顶部的 Print-

er下拉列表框来选择使用的打印机。

10. 3. 2 简单页面设置

对于 FreeHand 9 的业余爱好者和普通用户来说，对打印没有特别高的要求，只需使用

与 PostScript不兼容的打印机打印输出的所绘制图形就行了。与 PostScript不兼容的打印机

打印输出的效果没有与 PostScript兼容的打印机打印输出的效果精细，但用肉眼基本上看不

出它们之间的区别。同时使用这种打印机，打印的页面设置也比使用与 PostScript兼容打印

机的页面设置简单得多，因此对于一般的初学者，使用这种打印方式是非常适宜的。

在 Printer Setup对话框中选择 Canon BJC - 2000SP（Canon BJC - 2000SP不与 PostScript

兼容）打印机，然后执行 File→Printer命令，在打开的 Print 对话框中将显示出该种打印机的

各种属性，如图 10-10 所示。

Print Range选项组中可以选择所需打印的内容，不管使用什么样的打印机，这个选项组

中的内容总是相同的。选择 All 选项，会打印绘图文档中的所有页面；选择 Current page 选

项，只会打印当前页面。如果需要打印绘图页面中的几页，例如只想打印第 1 到第 8 页的图

形，那么就应该选择 Pages选项，当选择了这一项以后，Pages 单选按钮后面的文本框变为可

用，在文本框中输入一个 m To n 形式的值，就可以打印从第 m页到第 n 页的插图了。如果

在进入打印设置前已经选择了一些对象，这时只要启用 Select objects复选框，就会只打印在

绘图页面中选中的对象，而其他图形、对象不会被打印。

在 Output选项组中主要定义打印的数目。Copies 参数用于确定打印的分数。Compos-

ite（复合板）和 Separations（分色板）是 2 种打印方式，由于现在使用的是不与 PostScript兼容

的打印机，所以 Separations单选按钮处于不可选状态，只能用 Composite 方式打印。如果选

择 Print to file（打印到磁盘）复选框，绘图将以 PostScript 语言格式打印到磁盘，而不是直接

输出到介质上。如果选择了 Convert Text复选框，插图会被转换为文本。

单击 Preview按钮会打开打印预览设置对话框，如图 10-11 所示。在 Print Preview对话
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图 10-10 Print对话框

框中，最突出是打印预览页面，鼠标指针放在预览页面上时，会变成手形。单击并拖动鼠标，

会发现预览页面会随鼠标指针一起移动。如果用户想要恢复原来的设置，可以把鼠标指针

移出页面之外，当指针变成一个向左弯曲的小箭头时单击即可。

图 10-11 Print Preview对话框

预览页面左下方的下拉列表框用来选择预览的页面，它右边的下拉列表中提供了 Key-

line、Preview和 X - box 3 种查看模式。启用 Automatic Orientation 复选框后，可以使得所有

的修改操作生效。

单击 Print对话框中的 Color Management 按钮，会打开用于进行颜色调配的 Color Man-

agement Preferences对话框，如图 10-12 所示。
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图 10-12 Color Management Preferences对话框

Scale%（打印比例）选项组用来调整图形打印输出的比例，在下拉列表中有 Fit on paper

（按使用的纸张大小放缩插图）、Variable（X和 Y轴分别放缩插图）和 Uniform（X和 Y轴同

比例放缩插图）3 个选项。如果选择了 Fit on paper 选项，系统会按所选择的纸张大小和插

图大小来自动调节打印图形的放缩比例，如果插图比纸张大，FreeHand 9 会自动计算出缩小

量，以便使插图正好在单纸张上打印出来，反之，如果插图比纸张小，FreeHand 9 则会自动计

算出放大量，以便产生最佳的输出效果。选择 Uniform选项后，下拉列表框下边会出现一个

文本框，里边的默认数值为 100，即按原插图大小打印，用户可以在文本框中重新输入数值，

从而在打印时放大或缩小插图，可以缩小到 10%或放大至 1000%，不过这时图形是按 X轴

和 Y轴同比例进行缩放的。如果选择 Variable选项，在下拉列表的下面就会出现 2 个文本

输入框，分别为 X和 Y轴的缩放比例，其默认值也都是 100，如果只改变 X或 Y的其中一个

的值，打开打印预览会发现打印插图被拉伸了或是被压缩了，如图 10-13 所示。

图 10-13 变化后的打印插图

Print对话框中的 Tile（平铺）选项组用于决定用何种方式输出大幅图形，FreeHand 9 提

供了 2 种方式，一种是通过在 Scale%（打印比例）选项组中调整打印的比例，从而使整张插

图能够被完全打印出来。一种是采用平铺打印的方式。平铺打印是指打印机在打印大幅作

品时，受到打印纸张的大小限制，必须进行分解打印，打印到多页纸张上，然后再应用粘贴技

术将它拼在一起。平铺打印包括 Manual（手动）和 Automatic（自动）2 种方式，如果选择

Manual方式，FreeHand 9 将把所打印的页面的左下脚和标尺原点对齐，打印一页后，可以在

调整标尺原点后，再打印下一拼块。如果选择 Automatic（自动）方式，Freeehand 9 将自动平

铺打印整张插图，它会根据打印整张插图所需的页数打印出相应的页数，从页的左下角开始
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平铺，各平铺页间的重叠由 Overlap参数指定。

上面介绍了如何使用与 PostScript不兼容的打印机打印输出 FreeHand 9 的绘图。从中

可以看出，使用这种打印方式的页面设置并不复杂，同时能打印出比较好的打印效果。不过

这种打印方式也存在着缺陷，比如不能进行补漏白处理等。对于一般的 FreeHand 9 用户来

说，这些是无关大局的，但对于专业的美工师就不同了。在下一节中，就将介绍如何使用支

持 PostScript的打印机，对打印页面进行高级设置。

10. 3. 3 复杂页面设置

本节介绍如何使用与 PostScript 兼容的打印机打印输出作品，以达到专业化的品质标

准。在介绍这种打印输出方法之前，先来看看几个有关的概念：

 漏白：指插图中 2 个不同色版的颜色由于搭接的两个色版不能完全对准，从而使 2

种颜色之间可能出现间歇，这种间歇就称为漏白，要消除漏白，必须进行补漏白处理。

 补漏白：专业印刷的一道工序，通过这道工序可以延展对象来弥补不同色版对位不
准造成的漏白，FreeHand 9 的 Spread Size（渗印尺寸）直接提供了补漏白工序，使得这道工序

不必交与印刷上就能完成。

 挂网频率：表示在直线上度量的每英寸中的半色调栅格数，以个 /寸或 LPI 度量，而

半色调栅格呈若干个点，用来表示灰度值，调配颜色以及色彩。

 叠印：指在打印图形过程中，如果某一处有一种底色和一种前景色，则在打印时先打
印底色，而后再打印前景色，如果不采用叠印方式，则在打印时会弃掉覆盖在前景色下面的

底色或对象。

 点色（专色）印刷：一种专业的印刷方法，使用这种方法印刷时先把油墨调配成所需
的颜色，然后再印到纸张上，插图上每一种点色需要一个分色版，当插图中仅含有一种或两

种颜色（黑色除外）时，通常采用点色印刷方法，这种印刷方法成本低，技术简单，能准确印

出特定颜色，并且色彩的一致性极佳。

 四色调调配印刷：一种专业印刷方法，这种方法将青、深红、黄和黑色印墨按一定的
百分比混合在一起，形成近似于彩虹的视觉效果。和点色印刷方法相比，四色调配印刷法技

术上要求更高，费用也比较昂贵，但能印出更多的颜色。

使用与 PostScript兼容的打印机，用户会发现 Print 对话框中的一些属性已经发生了一

些改变，Print Setting、Separations和 Use PPD都变为可用的了，同时 Convert Text变为不可用，

原来的 Preview按钮变成了 Setup按钮了，公共属性与原来相比没有发生什么变化。下面就

来进行与 PostScript相关的属性设置。

1. 设置 PPD文件

选择了与 PostScript兼容的打印机后，用户还必须选择与该打印机相匹配的 PostScript

Printer Definition（PPD）文件，PPD文件中含有有关选定打印机的专门信息，一般来说，这些

信息将指示 FreeHand 9 如何打印出浓淡和灰度值，可以在 Print对话框中选定 PPD复选框，

并从显示的 PPD列表中选择一个正确 PPD文件，同时还可以从联机服务中获取更多的 PPD
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文件，也可以通过这些服务获得 PostScript打印驱动程序的更新版本。

设置 PPD文件的具体操作为：

（1）在 Print对话框的 Printer列表中选择一台与 PostScript兼容的打印机。

（2）单击 Use PPD复选框右面的按钮，打开 Select PPD对话框，如图 10-14 所示。在对

话框中选择适当的 PPD文件，单击“打开”按钮，这时所选择的 PPD文件就已经生效了。

图 10-14 Select PPD对话框

（3）如果需要更改打印机所使用的 PPD文件，只需单击 Use PPD复选框右边的按钮，

就会再一次打开图 10-14 所示的对话框，重新选择一个 PPD文件。这样就更改了所使用的

PPD文件。

当完成这些设置后，就可以进行相关的页面设置了，由于 Print 对话框中许多属性与前

面的介绍相同，这里就不再赘述。

2. 打印页设置

这要着重将介绍的是 Print Setup对话框，在 Print对话框中单击 Setup按钮，这时将弹出

Print Setup对话框，如图 10-15 所示。Print Setup 对话框中有左右 2 部分，左边部分包括

Print Setting、Use PPD、UserPrep File、预览窗口等几个项目，而右边部分包括 Separations、Ima-

ging、Paper Setup3 个选项卡。下面将详细介绍一下这些属性。

如果用户更改了 Print Setup对话框中的默认设置项，FreeHand 9 会在 Print Setting列表

框前加上一个小加号，以标记这些改变。如果希望将所作的改变作为新的设置保存下来，单

击一下加号标志，会打开 Save Print Setting Definition 对话框，如图 10-16 所示。在对话框的

文本框中填入一个文件名，然后单击“保存”按钮，就能把改变的设置保存下来，打开 Print

Setting列表框右边的下拉列表，会发现保存的设置已经在下拉列表中了。如果以后还想用

这个设置来打印插图，则直接在下拉列表中选择该选项就可以了。

3. Separations选项卡

Separations选项卡使用户能够在文档中打印多种不同的颜色。用户可以在 Composite

（复合版）、Separations（分色版）这 2 个单选项中选择一个，从而决定某种版是打印还是不打

印。在 Halftone Screen（半色调挂网）列表框中可以改变挂网频率。Transfer Function（转换

功能）列表框用于进行各种转换选择，共包括 Unadjusted 、Normalize、Posterize 3 个选项，控制

打印的灰度和色彩的明暗。使用 Unadjusted 选项，将屏蔽掉当前 PPD文件中的指令，直接
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图 10-15 Print Setup对话框

图 10-16 Save Print Setting Definition对话框

采用打印机使用的默认挂网设置；使用 Normalize 选项将使用 PPD文件的专用指令，使得用

低分辨率的激光打印机输出的挂网和用高档的图像排版机输出的挂网精确地匹配；使用

Posterize选项，会将色彩重新影射成 100%、67%、33%、0 等 4 个挂网值中的一个。在 Sepa-

rations选项卡的底部是 Spread Size（渗透尺寸）下拉列表框，使用它可以对文件中的所有对

象进行补漏白处理。

在 Separations中部有一个分色版列表框，这个打印分色版共分 4 栏，其中标记 P标明其

对应的颜色是否要打印，“V”标记用于标明在打印对话框中的 Separations 选项选定后响应

的那个栏中的分色版将被打印出来，无“V”标记表示该颜色将不打印；标记 O用来决定是否

进行叠印，当该栏中某颜色前有“V”标记时，该颜色将排斥掉覆盖在它下面的任何颜色，当

“V”标记出现在某颜色前时，该颜色叠印到它所覆盖的颜色之上。第三栏用 Angle 标识，用

于指定挂网角度，相应的分色版中的半色调挂网将以该角度进行打印。

4. Imaging选项卡

Imaging选项卡用于在作品中增加一些附加的打印效果，如图 10-17 所示。Labels &
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Marks（标签和标记）选项组用于在打印绘图时打印一些附加标记。启用 Separation names 复

选框可以在每一打印页上打印出分隔名；启用 File name and date 复选框可将文件名和当前

文件最后存储的日期打印到图形紧靠剪裁线外的左上角处；启用 Crop marks 复选框可在打

印插图中打印各种印刷裁剪标记（裁剪标记是用来确定成品页面的边界以及所印刷的作品

相对于成品页面边界位置的，这些标记将用于标识插图的 4 个角）。启用 Registration marks

复选框可打印出 5 个配准标记，一个位于插图顶端中间，一个位于底边中间，左右两侧中间

各一个，第 5 个位于页面的右下角，配准标记用于堆砌各种颜色的分色版，若打印的是黑白

版或复合版，则没必要用配准标记，但对于分色版，配准标记是绝对必要的，因为在印刷过程

中配准标记是确保不同调配色或点色能精准配准的唯一可靠的手段。

图 10-17 Imaging选项卡

Imaging Options选项组包括 Emulsion down、Emulsion up、Positive image、Negative image4

个选项。如果选择了 Emulsion down 或 Emulsion up 选项，会打印出图形的翻转片（镜像）效

果。如果要将图形打印到胶片上，应选择 Emulsion down 选项。要打印到纸张上时，应选择

Emulsion up选项。选择 Negative image选项可以使图形产生黑白反转效果，打印到纸张上

时，应选择 Positive image 选项，要打印到胶片上时，应选择 Negative image选项。

Output Option选项组主要用于进行输出设置。如果用户需要打印隐藏页，可以启用 In-

clude invisible layers选项。如果用户需要将一条较长的路径分割开，可以启用 Split Complex

Paths复选框。用户还能够决定 FreeHand使用何种编码方式以及用户的 OPI注释是否和分

色版一起打印。启用 Convert RGB to process 复选框后，FreeHand 会将 RGB 颜色转换为

CMYK颜色。

5. Paper Setup选项卡

Paper Setup选项卡主要进行纸张的方位设置，如图 10-18 所示。通过该选项卡能够使

用 PPD文件中的 Paper选项，也可以选择纸张是按长度方向还是按宽度方向进行取向，用户

还可以启用 Automatic复选框自动确定纸张的取向。默认情况下，页面的长边平行于纸张的

长边，但如果这种设置不符合要求，可以选择带 Transverse 后缀的选项，FreeHand 9 将把页
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面相对于纸张的卷轴方向旋转 90 度，这时页面的短边平行于纸张的长边。若使用的选项带

有 Extra后缀，会将页面的横向和竖向尺寸各增大 1 英寸，给剪裁标记、页边标注等页边标记

留出打印空间。Paper面板底部的 Tall和Wide单选按钮用于控制页面在纸张中的取向。

图 10-18 Paper Setup面板
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第十一章

创建和美化网页图像

在进入网络时代的今天，随着 Internet 技术的突飞猛进，各行各

业都正在加入到 Internet 中来。怎样把个人或公司的信息加入到

Web上是许多人广泛关注的问题，如何使展示的内容更具吸引力成

为另一个重要问题。FreeHand 9 为美化 Web 网页面带来了历史性

的突破，它将给Web的浏览者一个全新的感受。

本章中的主要内容包括：

 Internet和Web概述；

 在Web网页中插入 FreeHand 9 作品；

 在Web网页中插入 FreeHand 9 的矢量图形；

 在 FreeHand 9 中直接生成Web网页。

11. 1 Internet和 Web概述

Internet是通过计算机将不同地区、不同部门、不同国家连接起

来实现互相通信的全球网络，以实现信息和数据资源共享。而 Web

是当前 Internet 上最受欢迎、最为流行的一种服务，一般使用 HTML

（Hyper Text Markup Language）超文本标识语言来描述Web网页。

11. 1. 1 Internet 简介

Internet的中译名为“因特网”，它是目前全球最大的计算机互连

网络，它最初是由美国国防部高级研究计划署资助建成的 ARPANET

（1969 年）。

今天 Internet作为全球性的计算机网络系统，它借助于现代通

信和计算机技术，将世界上各种各样的网络连接起来，以实现全球范

围内的信息交流和资源共享。Internet 可以连接各种各样的计算机
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和网络，也就是说，无论是 PC机还是工作站或是局域网，无论采用 Windows NT还是 UNIX

或是 Netware操作系统，并且也无论处于世界上的什么地方，只要遵循共同的网络通讯协议

TCP /IP，就可以接入 Internet中，从而可以利用 Internet 所提供的全面信息服务。Internet 不

仅实现了全球资源的共享，还实现了资源共享形式的多样化，现在 Internet 上发布的信息可

以是文字、声音、电影、录像、图片、三维图像以及WAIS数据库等，这就为诸如 FreeHand 9 这

样的绘图软件提供了广泛的展示才华的空间。

在我国 Internet虽然起步比较晚，但这几年的发展是比较迅速的，从一般的网上冲浪到

网上购物，从一般的网上信息检索到各种电子商务模式，无不说明 Internet 在中国的迅速发

展。在我国 Internet的发展基本经历了 2 个阶段，第一阶段为 1987 ～ 1993 年，我国的一些科

研部门开始有关 Internet的科学研究和技术合作，通过拨号（X. 25 协议）实现电子邮件转化

系统的连接，并在小范围内为国内单位提供 Internet 电子邮件服务（即：E - mail 功能）。第

二阶段从 1994 年开始至今，实现和 Internet的 TCP /IP连接，从而开通了 Internet的全功能服

务，目前流行的各种网上活动都是这一阶段的产物，包括网上交易、电子商务、网上聊天等。

11. 1. 2 Web 简介

Web的全称是World Wide Web（简称万维网），它是各种信息（文本、图片、声音和动画）

组成的网络。Web则起源于欧洲瑞士日内瓦的欧洲核物理研究中心（CERN），在 CERN工

作中的科学家，如同世界上的其他地方一样，各自在不同的部门操纵着不同的计算机系统。

由于各自使用不同的系统，造成信息交流困难，信息资源浪费和工作重复。1989 年，在

CERN工作的英国学者 Tim Berners - Lee建议：在 CERN建立一个超文本连接方式组成的信

息连接系统Web，以使 CERN的科学家们能方便地实现信息的统一阅读。Web 的宗旨是统

一阅读，旨在使 CERN的科学家们不必考虑相互间计算机系统的差别就能快捷、方便地进行

信息交流，从而形成了现在风靡全球的 Web世界。

Web之所以能够在很短的时间内在 Internet 网上向全球广泛流行，主要是因为它具有

信息资源丰富、分布式、动态性、分散性、多平台性、交互性、超文本性和超媒体性等特点，这

些特点使得许多以前不可能办到的事情现在变得简单易行。Web 就像一本无所不有的百

科全书，特别是在Web中加入声音、图像、视频、三维动画等多媒体信息后，使得这些信息更

加生动、更加直观有趣，从而吸引了越来越多的用户。通过 Internet 网，Web 用户可以按照

协议的规定，实现不同地区、不同地域的信息连接，可以将全世界的 Web 服务器连接在一

起，从而组成了一个跨越国界的信息系统。在 Internet网上Web的内容更新是相当迅速的，

使得用户在每小时都能看到不同的信息。

在Web中，每一显示单位称为一个网页或称为 Web网页，Web网页是组成Web的基本

元素，正是由于存在成千上万的 Web 网页才形成了形形色色的 Web 世界。而 Web 网页能

否吸引观众的一基本要求是生动，要做到生动就必须插入一些多媒体文件。下面就将介绍

一下如何使用 FreeHand 9 来美化Web网页。
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11. 2 在 Web网页中插入 FreeHand 9 作品

步入Web 世界的用户会发现，几乎所有的 Web 网页都包括图片、声音、动画等多媒体

文件，使得冲浪的感觉惟妙惟肖，不包括多媒体内容的 Web网页越来越少，因为纯文字的东

西很难打动人。

制作Web网页所使用的多媒体文件的软件非常多，就制作图片而言包括 FreeHand 9、

Photoshop等。下面首先介绍一下 FreeHand 9 能在网页上输出的文件类型。

11. 2. 1 FreeHand 9 的文件导出

大多数计算机图形软件仅局限于处理矢量或光栅图形中的某一种图形，而 FreeHand 9

则无论对哪一种图形均可进行处理或导出，直接用 FreeHand 9 绘制的对象即是矢量图像，

同时 FreeHand 9 还能导入、过滤以及导出各种光栅格式的图形，甚至可在各种格式之间进

行转换。矢量图形的一大特点就是无论放大或是缩小图形，都不会改变图像的分辨率，在放

大或缩小矢量图形时，计算机将把图形中所有轮廓重新在更大或更小的显示区域中绘制出

来。光栅图像是按位绘制的图形，光栅图形用微小像素构成的光栅表示，在放大或缩小光栅

图形时会改变它的清晰度，从图 11-1 和图 11-2 可以看出矢量图形和光栅图形的基本区别。

下面首先介绍一下 FreeHand 9 中适于引入Web网页的基于光栅图像的文件格式。

图 11-1 矢量图形的缩放

图 11-2 光栅图形的缩放
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FreeHand 9 能够创建所有用于Web的标准光栅图像格式，包括 GIF、JPEG和新的 PNG

等格式。

1. GIF格式

这种格式在Web 上历史悠久，是一种使用效果良好的传统标准，GIF 格式是由 Com-

puserve专门针对网上 BBS系统而开发的一种图形标准。它是第一个服务于 Web 的图像标

准，至今仍然被广泛的采用。GIF 图像的问世是使 Web 得以迅猛发展的最重要原因之一，

正是由于这种格式是Web上应用的最早的图像格式，所以现在大多数网络浏览器都直接支

持这种格式。要使创作的图像作品展示给尽可能多的观众，那么 GIF 格式是一种很适合的

选择。GIF格式具有处理从 1 到 8 位色深的索引光栅图像的能力，这种图像可使用 2 到 256

种颜色，图 11-3 就是一幅 GIF图像。

图 11-3 一幅 GIF图形

从 FreeHand 9 中导出 GIF文件的步骤如下：

（1）从 File 菜单中选择 Export 命令，会弹出 Export Document 对话框，如图 11-4 所示。

在对话框中对 FreeHand 9 的一些导出属性进行设置。

图 11-4 Export Document对话框

（2）从“保存类型”下拉列表框中选择 GIF（. Gif）项，表示将以 GIF 的文件格式导出

FreeHand 9 所绘制的图像。
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（3）在“文件名”文本框中给即将保存的文件命名。然后单击 Setup 按钮，弹出图 11-5

所示的 Bitmap Export Defaults窗口。在这个窗口中可以对 GIF的一些导出属性进行设置。

图 11-5 Bitmap Export Defaults对话框

（4）在 Resolution下拉列表框中选择 72dpi，这是常用的屏幕分辨率。同时在 Anti -

aliasing下拉列表框中选择 4，这样可以获得最为光滑的导出效果。

（5）如果想使图像透明，启用 Include alpha channel和 Alpha includes background复选框

将在背景会浮现出来的地方创建某种单一的颜色来产生透明效果。

（6）单击 More按钮，出现图 11-6 所示的“GIF”选项对话框，在该对话框中可以对 GIF

的混色、影像等属性进行设置。

图 11-6 “GIF选项”对话框

（7）如果要使图像逐渐清晰地进行显示而不是从上而下导出，选择“交错”复选项，如

果想让背景色通过图像的某些部分浮现出来，选择“透明背景”复选框。同时还可以在“混

色”列表中选择 None、High、Miximum、Moderate等几个混色类型，在“色盘”列表中选择所使

用的色盘。

（8）完成设置以后导出 GIF图像，单击“GIF选项”和 Bitmap Export Default对话框中的

OK按钮，然后在 Export Document对话框中单击“保存”按钮。这样 FreeHand 9 图形就导出

为 GIF文件并存储在硬盘中。

以 GIF格式导出图像以后就可以直接在 Web网页中引用它了，后面将具体介绍如何在

Web网页中使用 FreeHand 9 的导出文件。

—712—

第十一章 创建和美化网页图像



2. JPEG文件格式

JPEG文件格式是由 Jiont Photographic Experts Group 开发的用于摄影图像的可变压缩

规范，在压缩过程中，它可能要调节一些设置以便获得更好的图像质量或更高的压缩比。

JPEG格式允许用 8 位以上的色深处理真正的彩色光栅图像，这种格式能够用 16 或 24 位的

色深获得上千种或上百万种颜色。24 位的 JPEG文件可压缩得比 8 位 GIF 文件还要小，因

此，网面设计者可用这种格式获得更好的画面质量而不会造成性能下降。JPEG有一种“渐

进”的处理特征，其工作原理类似于 GIF的隔行扫描，它唯一不能提供的就是透明处理。

JPEG采用一种“有丢失”的压缩方法，因此在对文件进行压缩时一些信息要丢失，压缩

比越高，丢失细节越多，反之压缩比越低，获得的图像画面质量越好。大多 Web 浏览器支持

JPEG，Netscape Navigator等浏览器允许在页面上直接使用 JPEG 文件。其他不直接支持

JPEG格式的浏览器通常会把图像交给某个软件以便进行浏览，图 11-7 就是一幅 JPEG图

形。

图 11-7 一幅 JPEG图形

从 FreeHand 9 导出 JPEG文件的一般步骤如下：

（1）选择 File菜单的 Export命令，打开 Export Document对话框。

（2）从“保存类型”下拉列表框中选择 JPEG（. Jpg）文件格式，在“文件名”文本框中

给即将保存的文件命名。然后单击 Setup按钮，弹出图 11-5 所示的 Bitmap Export Defaults对

话框。在这个对话框中对 JPEG文件的一些导出属性进行设置。

（3）在图 11-5 所示的对话框中，从 Resolution 后面的下拉列表框中选择常用的屏幕分

辨率 72dpi，将 Anti - aliasing的值设为 4，值为 4 时能获得最光滑的导出效果。由于 JPEG格

式不能进行透明处理，所以不能选择 Alpha includes background复选框。
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（4）单击More按钮，弹出图 11-8 所示的“JPEG选项”对话框。在“图像质量”后面的文

本框中输入想得到图像质量的百分数，百分数越高，图像画面的质量会越好，同时文件也会

越大；反之，这个数值越小，图像画面质量越差而文件越小。

图 11-8 “JPEG选项”对话框

（5）完成设置以后导出 JPEG图像，单击“JPEG选项”和 Bitmap Export Default对话框中

的 OK按钮，然后在 Export Document对话框中单击“保存”按钮。这样 FreeHand 9 图形就导

出为 JPEG文件并存储在硬盘中。

3. PNG文件格式

PNG（Portable Network Graphics）格式是一种新的图形文件格式，PNG文件格式是 World

Wide Web Consortium和 Compuserve为提供一种代替 GIF的免费格式而开发的，这种格式是

专为在 Internet上发送图形文件而设计的，一旦这种格式获得广泛应用，必将迅速地成为

Web上居统治地位的光栅图像文件格式。在所有的光栅格式中，PNG格式效果最佳。PNG

格式既能压缩索引色（8 位或更少）图像也能压缩真彩色（8 位以上）图像，PNG格式采用一

种无丢失压缩规范，能将图像压缩成比用 GIF 格式小 30%的文件，它所具有的渐进显示性

能使浏览器第一次装入图像的速度比采用隔行扫描方式的 GIF 更快。PNG不仅支持透明

处理也支持全字符通道混合，用 PNG格式还能进行内部伽马校正，PC机上的图像通常比

Macintosh机上的图像要更暗一些，所谓伽马校正就是弥补这种差别的一种方法。

从 FreeHand 9 中导出 PNG文件的一般步骤如下：

（1）选择 File菜单中的 Exort命令，打开 Export Document对话框。

（2）从“保存类型”下拉列表框中选择 PNG（. Png）文件格式，在“文件名”文本框中

给即将保存的文件命名。然后单击 Setup按钮，弹出图 11-5 所示的 Bitmap Export Defaults对

话框。在这个对话框中可以对 PNG文件的一些导出属性进行设置。

（3）在图 11-5 所示的对话框中，从 Resolution 下拉列表框中选择常用的屏幕分辨率

72dpi，将 Anti-aliasing的值设为 4。若要使 PNG图像进行透明处理，选择 Include alpha chan-

nel 和 Alpha includes background复选框。

（4）单击 More按钮，弹出一个图 11-9 所示的“PNG选项”对话框。在这个对话框中可

以对 PNG图像的色深进行设置，通常 8 位元和 16 位元的色深就足够了，而 24 位元或 32 位

元通常可获得极佳的画面质量，但文件将相对较大，所以通常不必选择这 2 项。如果使图像

逐渐清晰地逐次显示而不是从上到下一次显示出来，可选择“交错式 PNG”复选框。

（5）完成设置以后导出 PNG图像，单击“PNG选项”和 Bitmap Export Default 对话框中

的 OK按钮，然后在 Export Document对话框中单击“保存”按钮。这样 FreeHand 9 图形就导
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图 11-9 PNG选项对话框

出为 PNG文件并存储在硬盘中。

11. 2. 2 在Web 网页中插入 FreeHand 9 图像

在以 GIF、JPEG、PNG3 种文件格式导出了 FreeHand 9 所绘制的图形后，就可以把图形

插入到Web网页中来美化Web网页了。在 Web 网页中插入图像文件的方式有 2 种，既可

以使用 HTML语言在Web中直接插入，也可以使用一些网页制作软件在 Web 网页中插入

图像，下面就这 2 种方式来介绍如何在Web网页中插入 FreeHand 9 图形。

1. 利用 HTML语言在Web中插入 FreeHand 9 图形

HTML（Hype Text Markup Language）超文本标识语言是用来描述Web超文本文件的，它

是一种非常简单的语言。HTML适用于多种操作平台，它的文档都可以独立于平台，对多个

平台兼容，只要有一个相应平台下的浏览器就可以实现任何平台网络文档的阅读。HTML

语言的一大特点就是在原来文本文件的基础上，加入了一系列的标识符号描述格式形成网

络文档，放入Web服务器中，用户使用 Web 浏览器检索文件时，通过 HTML就把这些标识

符号解释成相应的文字、图像、声音、视频等多媒体信息。因此创建 HTML文件非常方便，

只需一个字符编辑器就行了，并且每个 HTML文件都不太大，可以快速地在网上传输。

用 FreeHand 9 绘制完一幅图形，如图 11-10 所示，并以 GIF 文件格式（也可以是 JPEG、

PNG等格式）导出，其文件名为 FreeHand9. GIF。下面的文档就是在Web文件中加入以 GIF

格式导出 FreeHand 9 图形的 HTML文档：

< html >

< head >

< meta http - equiv = "Content - Language" content = "en - us" >

< meta http - equiv = "Content - Type" content = "text /html；charset = gb2312" >

< meta name = "GENERATOR" content = "Microsoft FrontPage 4. 0" >

< meta name = "ProgId" content = "FrontPage. Editor. Document" >

< title >这是我利用 FreeHand 9 所做的第一个网页 < / title >

< /head >

< body >
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图 11-10 FreeHand 9 图形

< p >

< /p >

< p align = "center" > < font size = "6" face = "方正舒体" > < b >这是我利用 < /b >

< /font > < font face = "Amaze" size = "7" color = "#FF0000" > FreeHand 9 < /font >

< font size = "6" face = "方正舒体" > < b >所做的第一个网页 < /b > < /font > < /p >

< p > < /p >

< p >

< img border = "0" src = "FreeHand. gif" width = "343" height = "409" > < /p >

< /body >

< /html >

在文本框中编辑完 HTML文档后，以 FreeHand 9. htm文件名存储在硬盘上，然后就能

在浏览器中阅读所编辑的Web网页了，如图 11-11 所示。

2. 利用Web网页制作软件在Web网页中插入 FreeHand 9 图形

随着Web的迅速发展，用来制作 Web 网页的软件也越来越多了，比如 FrontPage、Dre-

amweaver等等。下面就以 FrontPage为例来讲述一下如何在Web中插入 FreeHand 9 图形。

用 FreeHand 9 绘制一幅图形，如图 11-12 所示，然后以 GIF 文件格式导出这个图形，使

用 FrontPage在Web网页中插入该图形的方法如下：

（1）启动 FrontPage，如图 11-13 所示。

（2）在工作界面中输入一些文字，例如：“Hello，我是 FreeHand 9！”，然后对文字的格式

进行编辑产生一些特殊效果。

（3）从 FrontPage的插入菜单中选择“图片”命令，再从“图片”子菜单中选择“来自文

件”命令（如图 11-14 所示）。这时将弹出图 11-15 所示的对话框，选择从 FreeHand 9 导出的

图形文件，然后单击“确定”按钮，这时就能把图形插入到 Web网页中了。

（4）图形插入到Web网页中后，保存网页到硬盘中，然后使用 Web浏览器预览 Web 网

页，如图 11-16 所示。
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图 11-11 使用 FreeHand 9 所绘制的图形生成的Web网页预览

图 11-12 使用 FreeHand 9 所绘制的图形

11. 3 在 Web网页中插入 FreeHand 9 的矢量图形

前面讲述了如何在Web网页中插入 FreeHand 9 的光栅图形，在这一节中将介绍如何把

FreeHand 9 的矢量图形插入到网页中。但到目前为止，Web网页还只能处理光栅图形，但是

如果把 Macromedia Web站点提供的插件工具插入到浏览器中，就可以在 Web 网上浏览矢

量图形。Macromedia 的 Flash 软件包将把矢量图形的所有优点带给 Web，使用该软件包能

对图像灵活地设置大小，并能方便地对图像进行编辑。基于矢量的 Flash 图形同时适用于

传统的静态图像和新的动态图像，静态图像涉及到在 FreeHand 9 中创造的各种作品，而动

态图像是一系列在 FreeHand 9 中创建的路径和对象。这些图像连接在一起显示，就可创建

出一幕运动的画面。
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图 11-13 FrontPage界面

图 11-14 “图片”菜单

图 11-15 选择文件对话框
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图 11-16 利用 FrontPage生成的Web网页预览

11. 3. 1 创建基于矢量的 Flash 图形

在 FreeHand 9 中完成了一些基本设置以后，就可以创建 Flash 图形了。Flash 图形不支

持放入的 EPS元素，但是如果原始的 EPS是可编辑的，可在导入 EPS之前，可以选择 File
Preferences命令对可编辑的 EPS进行转换。只要 EPS是作为可编辑文件存储的，用这种方

法就可将 EPS转换成原来的 FreeHand 9 格式。但如果 EPS是不可编辑的，就必须返回到用

来创建 EPS的原始文件，并将可编辑的元素直接复制和粘贴到 Flash图像上。

创建了 Flash图形后，还可以以 Flash 格式创建动画文件，这些动画由一系列不同的对

象组成，利用混合功能可以很方便地生成动画。要制作 Flash动画，其一般步骤如下：

（1）选择 EditSelectAll命令。执行这一操作的前提是假设要把文档中的所有路径

都转换为动画的一部分，如果希望文档中的某些对象不被包括在动画中，则必须删除它们。

选中所有对象以后单击鼠标右键，从弹出的菜单中选择 Group命令，即把图形中所有的对象

作为一个整体来处理。

（2）选择 XtrasAnimateRelease to Layers命令，这时将弹出一个图 11-17 所示的 Re-

lease to Layers对话框，这个对话框能对分层的属性进行设置，设置完成后单击 OK按钮。

（3）FreeHand 9 将为所有的对象创建新层，并将每一个对象分配在自己的层上。

（4）当一切都完成以后，从 File菜单中选择 Export命令，导出所生成的动画，这时就可

以在 Flash2 中播放或作为 HTML页面的一部分打开它。

11. 3. 2 在Web 网页中导入创建的图形

图形创建完成后，就可以把它引入到 Web 网页中了。要将网页的 URL地址加至图形
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图 11-17 Release To Layers对话框

当中，选择WindowXtrasURL Editor命令，打开 URL Editor，如图 11-18 所示，在 URL Op-

tions弹出菜单中选择 New命令以便将一个新的 URL加到列表中，当键入完 URL后。要将

新的 URL用于某个对象，只需选择某个对象，然后在列表中选择要用的 URL即可，也可将

URL从列表中拖至对象上。URL不能用于对象组，仅能用于单个对象。

图 11-18 URL Editor窗口

11. 4 在 FreeHand 9 中直接生成 Web网页

前面的章节已经就如何生成漂亮的 FreeHand 9 画面进行了深入的论述，而Web网页也

就是一组画面，只是由于网络传输的需要而采用了不同的语言形式（HTML语言），所以学好

了前面的知识就为这一节的学习打下了坚实的基础。运用前面所学的知识在 FreeHand 9

中绘制一幅优美的画面，再加入必要的文字信息来讲述所要表达的内容，在生成了满意的画

面后就可以进行 HTML导出了。

从 File菜单中选择 Public as HTML命令，这时将弹出图 11-19 所示的对话框，在这个对

话框中对图像的 HTML导出进行一些必要的设置，然后单击 Save As HTML按钮就可以存储

生成的 HTML文档了。

如果对 HTML导出格式并不满意，还可以在 HTML Output对话框对 HTML的导出格式

进行设置。在 HTML Output对话框的 HTML后面有一个下拉菜单，这个菜单中有一些已经

设定好的 HTML导出格式，可以直接从中选择。如果要更改导出格式，单击下拉列表后面

的 Setup按钮，这时将弹出图 11-20 所示的 HTML Setup 对话框，这个对话框主要是用来对
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图 11-19 HTML Ouput对话框

HTML导出进行设置的。Document文本框用来填写 HTML文档的导出路径，可以直接在文

本框中键入导出路径，也可以单击文本框后面的 Browse按钮来选择导出路径。在 Layout列

表中可以选择 Positioning With Layers 和 Positioning With Tables2 种方式。而在 Encoding下

拉列表中可以选择译码种类。在 Export Defaults 框架中可以选择图像和效果的导出格式，

包括 Vector art和 Images2 个属性。Vector art 有 SWF、JPEG、GIF 等几种格式，而 Images 有

JPEG、PNG、GIF 等几种格式。当所有的设置都完成后，单击 HTML后面的加号，将弹出图

11-21 所示的 New HTML Setting对话框，在 Name for new HTML文本框中输入新设置的名

称，然后单击 OK按钮，确认输入的名字，再单击 HTML Setup 对话框中的 OK按钮，确认所

有的更改设置。

图 11-20 HTML Setup对话框

图 11-21 New HTML Setting对话框

在 HTML Ouput对话框中除了可以调节导出格式外，还可以对导出内容进行设置。在

完成对 HTML导出格式的设置后，就可以调节与页面导出的相关选项了，Page 选项组可以
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选择页面导出范围，选择 All单选按钮，导出所有的页面；选择并填写 From. . . To单选按钮，

导出指定的页面的内容。选择 Show Output Warning复选框可以在生成 HTML文档时显示

警告信息，而启用 View in Browser or HTML Ed复选框可以预览生成的Web网页。

11. 5 动画字效

本练习绘制的是由多个字母逐渐蹦出组成 FreeHand 9. 0，然后逐渐破碎的一段动画，该

动画的制作原理主要利用了图层的叠加，制作方法也比较简单，但是需要注意的是字母出现

的轨迹要保持垂直或水平。

制作动画字效的操作步骤如下：

（1）新建一个文档，在工具栏选择 Text工具，参照图 11-22 所示输入文本，在文本上单

击鼠标右键，从弹出的快捷菜单中选择 Convert To Paths命令将文本转换为曲线，然后在 Fill

面板设置字体为无轮廓，对其应用直线渐变填充，设置 1 处的颜色为黑色，2 处和 5 处的颜

色为（C：100，M：100，Y：0，K：0），3 处和 6 处的颜色为白色，4 处的颜色为（C：100，M：35，Y：

0，K：0），渐变角度为 270°。

图 11-22 输入文本

（2）选择 Rectangle工具在文本外围绘制一个矩形，再选择 Pointer工具全选所有图形，

然后根据需要将它们复制 21 份，并将最后一份中的文本删除，将矩形填充为白色，如图 11-

23 所示。

（3）取消所有文本的群组，参照图 11-24 所示调整动画的前 11 帧中每个文本中字母的

位置，创建字母逐渐蹦出组成 FreeHand 9. 0 的每一帧动画。

（4）对第 13 至 16 帧中文本的高光进行调整，即在 Fill面板调整其渐变色块的位置，依

次来创建文本填充变换的动画效果，如图 11-25 所示。

（5）在 Xtra工具栏选择 Roughen工具，在第 17 至 21 帧的文本上单击并向外拖动使它

们的边缘逐渐变粗糙，创建文本逐渐破碎的效果，然后在主工具栏单击 Layers按钮打开 Lay-
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图 11-23 复制文本

图 11-24 调整字母出现的顺序

图 11-25 调整文本高光的位置
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ers面板，在该面板单击 Options按钮，从下拉菜单中选择 New命令，根据需要连续建立 21 个

新图层，如图 11-26 所示；

图 11-26 建立新图层

（6）对每一个图层的图形进行群组，再使用 Pointer工具全选 22 个图层的图形，利用 A-

lign工具使它们中心对齐，然后选择 FileExport 命令，打开 Export Documont 对话框，通过

该对话框将图形导出为动画，完成该练习，如图 11-27 所示。

图 11-27 导出为动画
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11. 6 网页设计

本练习展示了一个网页的设计制作过程，在绘制过程中运用 Emboss 工具和 Graphic

Hose工具分别制作了网页中的按钮和底纹效果，除此之外还介绍了如何使用 Shadow工具

为图形添加阴影。

制作网页的操作步骤如下：

（1）进入 FreeHand 9. 0，新建一个文档。在工具栏选择矩形工具在绘图页面绘制一个

矩形，对其应用直线渐变填充制作天空背景，在 Fill面板设置 1 处的颜色为（C：40，M：35，Y：

0，K：0），2 处的颜色为白色，渐变角度为 270°，效果如图 11-28 所示。

图 11-28 绘制背景

（2）对练习 2 中的树叶进行复制将其粘贴到当前文件中，然后对树叶进行复制并分别

调整它们的大小，调整后在 Xtra工具栏双击 Graphic Hose按钮打开 Hose 对话框，选中 Hose

单选按钮，从下拉列表内选择 New 命令，打开 Hose 面板，在其中任意输入一个名字，单击

Save按钮保存，然后依次选取树叶，在其上单击鼠标右键，从弹出的快捷菜单中选择 Copy

命令进行复制，在 Hose对话框单击 Paste in按钮将不同大小的树叶依次粘贴到对话框中，如

图 11-29 所示。

（3）在 Hose对话框选中 Options单选按钮，参照图 11-30 所示，在 Hose对话框中进行设

置，然后关闭该对话框，选择 Graphic Hose工具在矩形背景中随意单击鼠标并拖动绘制许多

树叶。

（4）对矩形背景进行复制放在树叶之上，对其应用透镜填充，设置矩形颜色为（C：0，

M：48，Y：0，K：0），Opacity为 30，完成后效果的如图 11-31 所示。

（5）对其中的一片树叶进行复制，然后在 Operation 面板双击 Emboss 按钮打开 Emboss
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图 11-29 将树叶粘贴到 Hose对话框中

图 11-30 绘制树叶

对话框，在 Emboss对话框中单击第 3 个按钮，设置 Type 为 Chisel，Vary为 Color，Shadow颜

色为（C：0，M：65，Y：100，K：0），Depth为 1，其他设置不变，单击 OK按钮为选择的树叶添加

Chisel浮雕效果，如图 11-32 所示。

（6）使用 Pointer 工具单击树叶，在 Xtra 工具栏中双击 Shadow按钮打开 Shadow对话

框，在该对话框中设置 Type为 Soft Edge，Fill 为 Color，阴影颜色为（C：0，M：100，Y：100，K：

60），设置 Soft Edge为 50，Scale为 100，单击 OK按钮关闭该对话框，然后在树叶上单击并

向右下方拖动，使树叶产生阴影后放开鼠标，效果如图 11-33 所示。

（7）通过变换控制柄调整树叶的大小后，将其适配到背景中，然后选择 Text 工具参照

图 11-34 所示输入文本，对第一行和第二行文本应用直线渐变填充，设置 1 处的颜色为（C：

0，M：0，Y：100，K：0），2 处的颜色为白色，渐变角度为 270°，对第三行文本应用基本填充，颜
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图 11-31 复制矩形背景

图 11-32 为树叶添加 Chisel浮雕效果

色为（C：0，M：100，Y：100，K：0）。

（8）选择 Ellipse工具绘制一个椭圆，对其应用径向渐变填充，设置 1 处的颜色为（C：

100，M：100，Y：0，K：0），2 处的颜色为白色，并参照图 11-35 所示的 Fill面板中调整渐变中心

的位置。
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图 11-33 为树叶添加阴影

图 11-34 输入文本

（9）选择椭圆，在 Operation面板双击 Emboss按钮打开 Emboss对话框，在 Emboss对话

框中单击第 3 个按钮，设置 Type 为 Chisel，Vary为 Color，Shadow颜色为（C：100，M：100，Y：

0，K：0），Depth为 20，其他设置不变，单击 OK按钮为选择的椭圆添加 Chisel浮雕效果，作为

网页中的按钮，如图 11-36 所示。

（10）对椭圆形按钮进行复制，然后选择 Pointer 工具全选按钮，在主工具栏单击 Align

按钮，弹出 Align对话框，在 Align 对话框中设置水平方向和垂直方向的对齐方式分别为

Distribute center 和 Align left，设置完成后在对话框下方单击 Apply按钮，使它们向左对齐，

如图 11-37 所示。

（11）选择 Ellipse工具按下 Shift键绘制一个椭圆，对其应用径向渐变填充，设置 1 处的

颜色为（C：45，M：100，Y：100，K：0），2 处的颜色为（C：0，M：100，Y：100，K：0），并参照图 11-
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图 11-35 绘制椭圆

图 11-36 制作椭圆按钮

图 11-37 对齐按钮
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38 所示的 Fill面板中调整渐变中心的位置。

图 11-38 绘制正圆
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（12）选择填充后的正圆，在 Operation 面板双击 Emboss 按钮打开 Emboss 对话框，在

Emboss对话框中单击第 3 个按钮，设置 Type为 Chisel，Vary为 Color，Shadow颜色为（C；45，

M：100，Y：100，K：0），Depth为 20，其他设置不变，单击 OK按钮为选择的正圆添加 Chisel浮

雕效果，作为网页中的按钮，如图 11-39 所示。

图 11-39 制作正圆按钮

（13）调整椭圆按钮和正圆按钮的大小，参照图 11-40 所示，将它们适配到网页中，然后

使用 Text工具输入文本，并将文本的颜色填充为（C：20，M：100，Y：0，K：0），完成本练习。

图 11-40 最后效果
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